<Click Here>

CAMERA OPERATION MANUAL
Explanation of digital camera functions and operating instructions.

DIGITAL CAMERA - PC CONNECTION OPERATION MANUAL
Explanation of how to download images between your digital camera and PC.
Thank you for purchasing an Olympus digital camera. Before you start to use your
new camera, please read these instructions carefully to enjoy optimum performance
and a longer service life. Keep this manual in a safe place for future reference.

- We recommend that you take test shots to get accustomed to your camera before
taking important photographs.
- Screen and camera illustrations shown in this manual were produced during the
developmental stages and may differ from those of the actual product.
For customers in North and South America

For customers in USA

Declaration of Conformity

Model Number: C-8080 Wide Zoom
RM-2 (Remote control)

Trade Name: OLYMPUS

Responsible Party: Olympus America Inc.

Address: 2 Corporate Center Drive, Melville, New York 11747-3157 U.S.A.

Telephone Number: 1-631-844-5000

Tested To Comply With FCC Standards
FOR HOME OR OFFICE USE

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference.
(2) This device must accept any interference received, including interference that may cause undesired operation.

For customers in Canada

For customers in Europe

“CE” mark indicates that this product complies with the European requirements for safety, health, environment and customer protection. “CE” mark cameras are intended for sales in Europe.

Trademarks

• IBM is a registered trademark of International Business Machines Corporation.
• Microsoft and Windows are registered trademarks of Microsoft Corporation.
• Macintosh is a trademark of Apple Computer Inc.
• All other company and product names are registered trademarks and/or trademarks of their respective owners.
• The standards for camera file systems referred to in this manual are the “Design Rule for Camera File System/DCF” standards stipulated by the Japan Electronics and Information Technology Industries Association (JEITA).
Composition of the manual

<table>
<thead>
<tr>
<th>Contents</th>
<th>P.4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Names of parts</td>
<td>P.9</td>
</tr>
<tr>
<td><strong>Introduction of the camera’s functions</strong></td>
<td></td>
</tr>
<tr>
<td>Getting started</td>
<td>P.16</td>
</tr>
<tr>
<td>Using the buttons and menus</td>
<td>P.29</td>
</tr>
<tr>
<td><strong>Basic Photography</strong></td>
<td></td>
</tr>
<tr>
<td>Shooting basics</td>
<td>P.46</td>
</tr>
<tr>
<td><strong>Advanced Photography</strong></td>
<td></td>
</tr>
<tr>
<td>Flash</td>
<td>P.59</td>
</tr>
<tr>
<td>Advanced shooting</td>
<td>P.70</td>
</tr>
<tr>
<td>Adjusting the image quality and exposure</td>
<td>P.102</td>
</tr>
<tr>
<td><strong>For playing back and editing pictures</strong></td>
<td></td>
</tr>
<tr>
<td>Playback</td>
<td>P.121</td>
</tr>
</tbody>
</table>
| **Settings that make the camera easier to operate.** | |}
| Customizing the camera                        | P.145 |
| Camera Settings                               | P.166 |
| **Printing pictures**                         |     |
| Print setting (DPOF)                          | P.176 |
| Direct printing (PictBridge)                  | P.186 |
| **Troubleshooting and other information**     |     |
| Miscellaneous                                 | P.200 |
| Specifications                                | P.221 |
| Glossary of terms                             | P.223 |
| Index                                         | P.226 |
Contents

Composition of the manual ............................................................. 3
Names of parts .............................................................................. 9
  Camera ....................................................................................... 9
  Viewfinder and monitor indications ........................................... 11
  Memory gauge ......................................................................... 14
  Battery check .......................................................................... 14
How to use this manual ............................................................... 15

1 Getting started ........................................................................ 16
  Attaching the strap ................................................................. 16
  Charging the battery ............................................................... 17
  Loading the battery ............................................................... 18
    Other ways to power the camera ........................................... 19
  Inserting a card ........................................................................ 21
    Card basics ........................................................................... 21
  Removing the card ................................................................... 22
  Switching cards ...................................................................... 23
  Turning the power on/off ........................................................ 25
    If the card is not recognized (card check) ......................... 26
  Adjusting the viewfinder ....................................................... 27
  Attaching the lens hood ......................................................... 27
  Holding the camera ............................................................... 28
  Changing the angle of the monitor ........................................... 28

2 Using the buttons and menus ..................................................... 29
  Direct buttons and menus ....................................................... 29
  Direct buttons ........................................................................ 31
    Direct button basics .......................................................... 31
    Functions that can be set using the direct buttons .............. 33
  Using the menus ...................................................................... 37
  Menu basics ........................................................................... 38
  Shortcut menus ....................................................................... 40
  Mode menus ........................................................................... 42

3 Shooting basics ...................................................................... 46
  Shooting mode ....................................................................... 46
  Taking still pictures ............................................................... 50
  If correct focus cannot be obtained ...................................... 53
    Determine the position of the subject after focusing (Focus Lock) . 53
    Subjects that are difficult to auto focus on ....................... 54
  Recording movies ................................................................... 55
  Zoom ....................................................................................... 57
Contents

Using the optical zoom ............................................. 57
Using the digital zoom ............................................. 58

4 Flash ................................................................. 59
Flash shooting ....................................................... 59
Using the slow synchronization flash  SLOW ................. 63
Flash intensity control ............................................. 64
External flash (optional) ............................................ 65
   Using an Olympus external flash ......................... 65
   Using a commercially available external flash .......... 67
   Compatible external flashes ................................ 68
   Using the slave flash mode ............................... 69

5 Advanced shooting ............................................... 70
Aperture priority shooting  A .................................... 70
Shutter priority shooting  S .................................... 71
Manual shooting  M .............................................. 72
Using My Mode ...................................................... 73
Focusing applications ............................................ 74
   AF MODE - Changing the focus range ................. 74
   FULLTIME AF - A reliable time-saving way to focus 75
   P-AF – Changing the auto focus mode ................ 76
   Changing the position of the AF target mark ......... 77
   AF illuminator .................................................. 78
   Manual focus .................................................... 79
Metering ............................................................... 81
   Spot metering / Center-weighted metering ............ 81
      – Selecting the metering area ......................... 81
   Changing the position of the metering target mark .. 82
   Multi-metering .................................................. 83
      – Metering the exposure at more than one point  MULTI .... 83
AE Lock - Locking the exposure  AEL ........................ 85
Macro mode shooting ............................................. 87
Super macro shooting ........................................... 88
Self-timer shooting .............................................. 89
Remote control shooting ....................................... 90
   Changing the time until remote control is activated 91
Sequential shooting  HI AF BKT ................................. 92
   High speed, sequential and AF sequential shooting HI AF  ............................................. 92
   Auto bracketing  BKT ........................................ 93
Panorama shooting ............................................... 95
Guideline shooting ............................................... 97
Shooting in black & white or sepia-tone ............................................. 98
FRAME ASSIST
  – Displaying vertical and horizontal lines to aid composition .......... 99
Recording sound with still pictures ................................................. 100
Recording sound with movies ......................................................... 101

6 Adjusting the image quality and exposure  102

Record mode ◄............................................................................... 102
RAW Data .................................................................................. 103
3:2 Resolution ............................................................................. 103
Selecting a record mode .............................................................. 105
ISO – Set-up appropriate sensitivity ............................................. 107
Exposure compensation ✂ ............................................................ 108
White balance WB ....................................................................... 109
  Auto white balance .................................................................. 109
  Preset1 white balance ............................................................. 110
  Preset2 white balance ............................................................. 110
  Custom white balance ............................................................. 111
  One-touch white balance ☐ .................................................... 111
  White balance compensation WB+ ............................................. 112
  Saving a custom white balance ............................................... 113
SHARPNESS ◊ ............................................................................. 114
CONTRAST .............................................................................. 115
HUE RGB .................................................................................. 116
SATURATION RGB .................................................................... 117
SCENE MODES ....................................................................... 117
NOISE REDUCTION NR ............................................................ 118
Histogram – Displaying the luminance distribution of still pictures ☑ .... 119

7 Playback  121

Viewing still pictures ▶ ................................................................. 121
  QUICK VIEW ......................................................................... 122
  Picture rotation ....................................................................... 123
Close-up playback ...................................................................... 124
Index display ............................................................................. 125
  Selecting the number of pictures ............................................. 126
Slideshow ▶ ............................................................................. 127
Viewing movies ▶ ................................................................. 128
Editing movies .......................................................................... 130
  Creating an index .................................................................... 131
  Editing a movie ................................................................. 132
Playback on TV ......................................................................... 134
INFO – Displaying shooting information INFO ................................ 135
<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displaying guidelines [7]</td>
<td>136</td>
</tr>
<tr>
<td>Recording sound [ Players]</td>
<td>137</td>
</tr>
<tr>
<td>Editing still pictures.</td>
<td>138</td>
</tr>
<tr>
<td>Resizing [ ]</td>
<td>138</td>
</tr>
<tr>
<td>Trimming [ ]</td>
<td>139</td>
</tr>
<tr>
<td>RAW editing</td>
<td>140</td>
</tr>
<tr>
<td>Copying pictures</td>
<td>141</td>
</tr>
<tr>
<td>Protecting pictures [ ]</td>
<td>142</td>
</tr>
<tr>
<td>Erasing pictures</td>
<td>143</td>
</tr>
<tr>
<td>Single-frame erase [ ]</td>
<td>143</td>
</tr>
<tr>
<td>All-frame erase [ ]</td>
<td>144</td>
</tr>
</tbody>
</table>

**8 Customizing the camera**

145

| ALL RESET – Saving the camera’s settings                              | 145  |
| REC VIEW – Checking the picture immediately after shooting            | 147  |
| Setting the button operation sound **BEEP**                           | 148  |
| SHUTTER SOUND – Setting the shutter sound                             | 149  |
| DIAL – Changing the function of the control dial                     | 150  |
| EV STEP – Setting exposure adjustment increments                      | 153  |
| Custom button [ ]                                                     | 154  |
| Setting the custom button                                            | 155  |
| Using the custom button                                              | 156  |
| SHORT CUT                                                             | 157  |
| Setting the shortcut menu                                            | 158  |
| Using the shortcut menu                                              | 159  |
| MY MODE SETUP – Setting a function in My Mode [ ]                    | 160  |
| CONTROL PANEL – Using the monitor as a control panel                 | 163  |
| VOLUME – Adjusting the playback volume                                | 165  |

**9 Camera Settings**

166

| Formatting cards [ ]                                                  | 166  |
| Selecting a language for on-screen display [ ]                        | 167  |
| Setting the date and time [ ]                                        | 168  |
| Setting the warning tone [ ]                                         | 169  |
| SLEEP – Setting the time until the camera enters sleep mode          | 169  |
| FILE NAME – Assigning a file name                                     | 170  |
| BATTERY SAVE                                                         | 171  |
| – Reducing battery consumption                                       | 171  |
| PIXEL MAPPING – Checking the image processing functions               | 172  |
| Adjusting the brightness of the monitor and viewfinder [ ]           | 173  |
| Measurement units [m/ft]                                             | 173  |
| VIDEO OUT – Setting the video signal type                            | 174  |
| USB setup – Setting the connection destination                       | 175  |
## Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 Print setting (DPOF)</td>
<td>176</td>
</tr>
<tr>
<td>How to print pictures</td>
<td>176</td>
</tr>
<tr>
<td>All-frame reservation</td>
<td>178</td>
</tr>
<tr>
<td>Single-frame reservation</td>
<td>180</td>
</tr>
<tr>
<td>Trimming</td>
<td>182</td>
</tr>
<tr>
<td>Resetting print reservation data</td>
<td>184</td>
</tr>
<tr>
<td>11 Direct printing (PictBridge)</td>
<td>186</td>
</tr>
<tr>
<td>Using the direct printing function</td>
<td>186</td>
</tr>
<tr>
<td>Connecting the camera to a printer</td>
<td>187</td>
</tr>
<tr>
<td>Printing pictures</td>
<td>188</td>
</tr>
<tr>
<td>Easy printing</td>
<td>189</td>
</tr>
<tr>
<td>PRINT/MULTI PRINT</td>
<td>190</td>
</tr>
<tr>
<td>ALL PRINT</td>
<td>193</td>
</tr>
<tr>
<td>ALL INDEX mode/PRINT ORDER mode</td>
<td>195</td>
</tr>
<tr>
<td>Trim the picture</td>
<td>197</td>
</tr>
<tr>
<td>Exiting direct printing</td>
<td>198</td>
</tr>
<tr>
<td>If an error code is displayed</td>
<td>199</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>200</td>
</tr>
<tr>
<td>Error codes</td>
<td>200</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>201</td>
</tr>
<tr>
<td>List of menus</td>
<td>208</td>
</tr>
<tr>
<td>List of factory default settings</td>
<td>215</td>
</tr>
<tr>
<td>List of items by shooting mode</td>
<td>217</td>
</tr>
<tr>
<td>Camera maintenance</td>
<td>219</td>
</tr>
<tr>
<td>How to replace the battery (CR2025) of the remote control device</td>
<td>220</td>
</tr>
<tr>
<td>Specifications</td>
<td>221</td>
</tr>
<tr>
<td>Glossary of terms</td>
<td>223</td>
</tr>
<tr>
<td>Index</td>
<td>226</td>
</tr>
</tbody>
</table>
Names of parts

Camera

Shutter button P.50
AF illuminator P.78
AF sensor
Flash P.59

Microphone P.100, 137
AEL button (AEL) P.85
Lens

Self-timer/Remote control receiver P.90
Self-timer/Remote control lamp P.89, 90

Remote control receiver P.90

Erase button ( ) P.51, 143
Viewfinder P.27

Control dial P.31, 33, 150
QUICK VIEW button P.122

Arrow pad ( ) P.37, 121
OK/Menu button ( ) P.37

Card cover P.22
Monitor button ( ) P.50
Card button (CF xD) P.23
Card access lamp P.50
Connector cover P.134, 187

Monitor P.28, 50
A/V OUT jack (MONO) P.134
USB connector P.187
DC-IN jack P.19
Names of parts

- Hot shoe  P.65
- Power switch  P.25
- Mode dial  P.25, 46
- Zoom lever (W/T)  P.57, 124, 125
- Custom button ( )  P.154
- Strap eyelet *  P.16
- Diopter adjustment ring  P.27
- Speaker
- Tripod socket
- Battery compartment lock  P.18
- Battery compartment cover  P.18
- Flash pop-up button  P.59
- Strap eyelet *  P.16
- AF/Macro/MF button (AF/ /MF)  P.79, 87, 88
- Protect button ( )  P.142
- Flash mode button ( )  P.59
- Rotation button ( )  P.123
- Metering button ( )  P.81
- Print button ( )  P.178
- Exposure compensation button ( )  P.64, 108
- Information display button (INFO)  P.135
- White balance button (WB)  P.109
- Record mode button ( )  P.105

* The metal clip of the strap eyelet is not shown in detail in the illustrations in this manual.
Viewfinder and monitor indications

Shooting mode

<table>
<thead>
<tr>
<th>Item</th>
<th>Indication</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Shooting mode</td>
<td>P, A, S, M,</td>
<td>P.46</td>
</tr>
<tr>
<td>2 Shutter speed</td>
<td>15&quot; to 1/4000, BULB</td>
<td>P.71</td>
</tr>
<tr>
<td>3 Aperture value</td>
<td>F2.4 to F8.0</td>
<td>P.70</td>
</tr>
<tr>
<td>4 Exposure compensation</td>
<td>–2.0 to +2.0</td>
<td>P.108</td>
</tr>
<tr>
<td>Exposure differential</td>
<td>–3.0 to +3.0</td>
<td>P.72</td>
</tr>
<tr>
<td>5 Battery check</td>
<td></td>
<td>P.14</td>
</tr>
<tr>
<td>6 Green lamp</td>
<td></td>
<td>P.50</td>
</tr>
<tr>
<td>7 Flash stand-by</td>
<td>Lights</td>
<td>P.50, 59</td>
</tr>
<tr>
<td>Camera movement warning/</td>
<td>Blinks</td>
<td></td>
</tr>
<tr>
<td>Flash charge</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8 Macro mode</td>
<td>AF</td>
<td>P.87</td>
</tr>
<tr>
<td>Super macro mode</td>
<td>AF</td>
<td>P.88</td>
</tr>
<tr>
<td>Manual focus</td>
<td>MF</td>
<td>P.79</td>
</tr>
<tr>
<td>9 Noise reduction</td>
<td>NR</td>
<td>P.118</td>
</tr>
<tr>
<td><strong>Item</strong></td>
<td><strong>Indication</strong></td>
<td><strong>Ref. page</strong></td>
</tr>
<tr>
<td>----------</td>
<td>---------------</td>
<td>---------------</td>
</tr>
<tr>
<td>10 Flash mode</td>
<td><img src="image" alt="Flash modes" /></td>
<td>P.59</td>
</tr>
<tr>
<td>11 Flash intensity control</td>
<td><strong>–2.0 to +2.0</strong></td>
<td>P.64</td>
</tr>
<tr>
<td>12 Sequential shooting mode</td>
<td><img src="image" alt="Sequential modes" /></td>
<td>P.92</td>
</tr>
<tr>
<td>13 Self-timer</td>
<td><img src="image" alt="Self-timer" /></td>
<td>P.89, P.90</td>
</tr>
<tr>
<td>14 Sound record</td>
<td><img src="image" alt="Sound record" /></td>
<td>P.100, P.101, P.137</td>
</tr>
<tr>
<td>15 Record mode</td>
<td>RAW, TIFF, SHQ, HQ, SQ1, SQ2</td>
<td>P.102</td>
</tr>
<tr>
<td>16 Resolution</td>
<td>3264 × 2448, 2048 × 1536, 640 × 480 etc.</td>
<td>P.104</td>
</tr>
<tr>
<td>17 AF target mark</td>
<td><img src="image" alt="AF target mark" /></td>
<td>P.50, P.81, P.82</td>
</tr>
<tr>
<td>18 Number of storable still pictures Remaining recording time</td>
<td>30 04:00</td>
<td>P.104, P.55</td>
</tr>
<tr>
<td>19 AE lock AE memory</td>
<td><img src="image" alt="AE lock" />, <img src="image" alt="AE memory" /></td>
<td>P.85</td>
</tr>
<tr>
<td>20 Metering mode</td>
<td><img src="image" alt="Metering modes" /></td>
<td>P.81</td>
</tr>
<tr>
<td>21 ISO</td>
<td>ISO50, ISO100, ISO200, ISO400 etc.</td>
<td>P.107</td>
</tr>
<tr>
<td>22 White balance</td>
<td><img src="image" alt="White balance" /></td>
<td>P.109, P.111</td>
</tr>
<tr>
<td>23 White balance compensation</td>
<td>B1 to B7, R1 to R7</td>
<td>P.112</td>
</tr>
<tr>
<td>24 Scene modes</td>
<td><img src="image" alt="Scene modes" /></td>
<td>P.117</td>
</tr>
<tr>
<td>25 Hue</td>
<td><img src="image" alt="Hue" /></td>
<td>P.116</td>
</tr>
<tr>
<td>26 Memory gauge</td>
<td><img src="image" alt="Memory gauge" /></td>
<td>P.14</td>
</tr>
<tr>
<td>27 Card</td>
<td><img src="image" alt="Card" /></td>
<td>P.23</td>
</tr>
</tbody>
</table>
**Playback mode**

INFO setting allows you to select how much information to display on the screen. Screens with the information display set to ON are shown below.

“INFO – Displaying shooting information” (P.135)

<table>
<thead>
<tr>
<th>Item</th>
<th>Indication</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Battery check</td>
<td><img src="Image" alt="Battery Check" /></td>
<td>P.14</td>
</tr>
<tr>
<td>2 Card</td>
<td>![xD], [CF]</td>
<td>P.23</td>
</tr>
<tr>
<td>3 Print reservation/</td>
<td><img src="Image" alt="Print Reservation/Number" /></td>
<td>P.178</td>
</tr>
<tr>
<td>number of prints</td>
<td><img src="Image" alt="Number of Prints" /></td>
<td>P.128</td>
</tr>
<tr>
<td>Movie</td>
<td><img src="Image" alt="Movie" /></td>
<td></td>
</tr>
<tr>
<td>4 Sound record</td>
<td><img src="Image" alt="Sound Record" /></td>
<td>P.100, 101, 128</td>
</tr>
<tr>
<td>5 Protect</td>
<td><img src="Image" alt="Protect" /></td>
<td>P.142</td>
</tr>
<tr>
<td>6 Record mode</td>
<td>RAW, TIFF, SHQ, HQ, SQ1, SQ2</td>
<td>P.102</td>
</tr>
<tr>
<td>7 Resolution</td>
<td>3264 × 2448, 2048 × 1536, 640 × 480, 320 × 240 etc.</td>
<td>P.104</td>
</tr>
<tr>
<td>8 Aperture value</td>
<td>F2.4 to F8.0</td>
<td>P.70</td>
</tr>
<tr>
<td>9 Shutter speed</td>
<td>8' to 1/40000</td>
<td>P.71</td>
</tr>
<tr>
<td>10 Exposure compensation</td>
<td>–2.0 to +2.0</td>
<td>P.108</td>
</tr>
<tr>
<td>11 White balance</td>
<td>WB AUTO, <img src="Image" alt="White Balance" /></td>
<td>P.109</td>
</tr>
<tr>
<td></td>
<td><img src="Image" alt="White Balance" /></td>
<td>P.111</td>
</tr>
<tr>
<td>12 ISO</td>
<td>ISO50, ISO100, ISO200, ISO400 etc.</td>
<td>P.107</td>
</tr>
<tr>
<td>13 Date and time</td>
<td>'04. 4.17 15:30</td>
<td>P.168</td>
</tr>
<tr>
<td>14 File number</td>
<td><img src="Image" alt="File Number" /></td>
<td>P.170</td>
</tr>
<tr>
<td>Playing time/Total</td>
<td>FILE: 100 - 0030</td>
<td>P.128</td>
</tr>
<tr>
<td>recording time</td>
<td>00:00/00:36</td>
<td></td>
</tr>
</tbody>
</table>

**Note**

- The indications that appear on a movie picture that has been selected and displayed from the index display are different from those that appear when the movie picture is displayed using the movie playback function.
**Memory gauge**

The memory gauge lights up when you take a still picture. While the gauge is lit, the camera is storing the picture on the card. The memory gauge indication changes as shown below depending on the shooting status. The indication is not displayed during movie recording.

<table>
<thead>
<tr>
<th>Before shooting (Gauge is off)</th>
<th>One picture taken (Lit)</th>
<th>Two or more taken (Lit)</th>
<th>No more pictures can be taken (Fully lit)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shoot</td>
<td>Shoot</td>
<td>Shoot</td>
<td>Wait</td>
</tr>
</tbody>
</table>

- **Before shooting (Gauge is off)**
- **One picture taken (Lit)**
- **Two or more taken (Lit)**
- **No more pictures can be taken (Fully lit)**

**Battery check**

If the remaining battery power is low, the battery check indication changes as follows when the camera is turned on or while the camera is in use.

- **Lights (green) (Goes off after a while)**
- **Blinks (red)**

<table>
<thead>
<tr>
<th>Remaining power level: high</th>
<th>Remaining power level: low</th>
<th>Remaining power level: exhausted</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you intend to use the camera for a long period of time, charge the battery as soon as possible.</td>
<td>If you intend to use the camera for a long period of time, charge the battery as soon as possible.</td>
<td>Charge the battery.</td>
</tr>
</tbody>
</table>
How to use this manual

Set the mode dial to any of the marks shown here.

The buttons for the function and their location are clearly illustrated.

This shows control dial operations.

Follow the arrows to perform menu operations. For details on operating procedures, see “Menu basics” (P.38).

This represents the arrow pad. Only arrows applicable to the operation are shown.

This sample page is only for your reference. It may differ from the actual page in this manual.

Indications used in this manual

- **Note**: Important information on factors which may lead to a malfunction or operational problems. Also warns of operations that should be absolutely avoided.

- **?**: Useful information and hints that will help you get the most out of your camera.

- **!?**: Reference pages describing details or associated information.
1 Getting started

Attaching the strap

1 Pass the lens cap string through the hole in the lens cap, then pass the other end through the loop and pull tight.

2 Pull the ends of the strap out of the stopper and ring.

3 Thread the strap through the string loop (attached to the lens cap in Step 1).

4 Thread the strap through the strap eyelet, then back through the ring and stopper as indicated by the arrows.

5 When you have decided how long you want the strap to be, pull on the strap in the stopper A to make sure it is securely fastened.

6 Attach the strap to the other eyelet following Steps 3 to 5.

Note

- Be careful with the strap when you carry the camera, as it can easily catch on stray objects, causing injury or damage.
- Attach the strap correctly as shown above so that the camera does not fall off. If the strap is attached incorrectly and the camera falls off, Olympus is not responsible for any damages.
This camera uses one BLM-1 lithium ion battery. Other batteries cannot be used.
The battery is not fully charged at the time of purchase. Before using the camera, charge the battery using the BCM-2 charger. For more details, read the instructions provided with the charger.

1. Plug the power cord into the charger.

2. Plug the other end of the power cord into a household electrical outlet.

3. Remove the protection cap from the battery. Place the battery on the charger, making sure that it is correctly oriented as shown in the illustration.
   - Align the battery with the guideline on the charger (→), and insert the battery into the charger as far as it goes.

   - Meaning of the charge lamp indications:
     Lights red: Charging
     Lights green: Charging is completed
     Blinks red: Charging failure
   - The battery charges in approximately 5 hours. The charging time may differ according to the amount of power left in the battery.

- Use only the specified charger.
- The battery becomes warm during charging, but this is not a malfunction.
- If you intend to use the camera for a long period of time, you are recommended to carry a spare battery (sold separately) with you.
- Always secure the protection cap to the battery when carrying it or not being used to prevent short-circuiting of the battery terminals.
Loading the battery

This camera uses one BLM-1 lithium ion battery.

1 Make sure the camera is turned off.
   • The monitor is off.
   • The viewfinder is off.
   • The lens is retracted.

2 Slide the battery compartment lock from \( \equiv \) to \( \equiv \) and open the battery compartment cover.

   ■ Inserting a battery

3 Insert the battery, making sure that it is correctly oriented as shown in the illustration.
   • The battery lock secures the battery when correctly loaded.

   ■ Removing the battery

Press the battery lock in the direction of the arrow (\( \equiv \)).
   • The battery is ejected.
   • Keeping your hand over the battery to stop it falling out, turn the camera right way up and remove the battery.

4 Close the battery compartment cover.

5 Slide the battery compartment lock from \( \equiv \) to \( \equiv \).

   Battery level warning

The amount of power consumed varies considerably depending on the operations performed on the camera. If you use an exhausted battery, the camera may turn off without displaying the battery level warning (P.14).
Other ways to power the camera

AC adapter
The optional Olympus CAMEDIA-brand AC adapter allows you to power your digital camera from a common AC wall outlet. Be sure to use the specified AC adapter. An AC adapter is useful for time-consuming tasks such as downloading images to a PC or outputting images on a printer. Use an AC adapter designed to operate on the AC voltage in the area the camera is being used. Consult your nearest Olympus dealer or Service center for details.

Power battery holder
The optional power battery holder allows you to shoot for longer than when using the lithium ion battery. Be sure to remove the battery compartment cover pushing to the direction of the arrow when attaching the power battery holder to the camera. For more details, read the instructions provided with the power battery holder.
How to use the charger in another country

To use the charger in another country, equip the charger with an adapter plug suited to the AC outlet in the intended region of use. Please ask your travel agency about which adapter plug to use.

- If the battery power runs out while the camera is connected to a PC or printer, the image data may be lost or damaged. You are recommended to use the AC adapter when transferring images to a PC or printer. Do not connect or disconnect the AC adapter while the camera is communicating with the PC or printer.
- Do not remove or load the battery or connect or disconnect the AC adapter while the camera is turned on. Doing so could affect the camera’s internal settings or functions.
- The battery consumption may vary according to the shooting conditions, etc.
- Power is consumed continuously during the conditions described below. This discourages the power to last longer.
  - When the monitor is turned on.
  - Repeated zoom adjustments.
  - Repeated auto-focus by depressing the shutter button halfway.
  - When the FULLTIME AF mode is turned on.
  - When the camera is connected to a PC or printer.
- When using an AC adapter, power is supplied to the camera by the AC adapter even if a battery is loaded in the camera. The AC adapter does not charge the battery in the camera.
- Carefully read the instructions for the AC adapter before use.
Inserting a card

“Card” in this manual refers to the xD-Picture Card, CompactFlash and Microdrive. The camera uses the card to record pictures. The xD-Picture Card can be used simultaneously with CompactFlash or Microdrive.

Card basics

The card corresponds to normal camera film for recording the pictures you have taken. Pictures recorded and stored on the card can easily be erased, overwritten, and/or edited on a PC. The following cards can be used. Read the instructions for the card carefully before use.

**xD-Picture Card**
- 16 MB to 512 MB

![xD-Picture Card](image)

- Index area
  - You can write down the card’s contents.
- Contact area
  - Comes into contact with the camera’s signal read contacts.

**CompactFlash (CF) (optional)**
CompactFlash is a large-capacity solid state flash memory card. You can use commercially available cards.
- The camera may not function normally with some types of CompactFlash cards.

**Microdrive (optional)**
You can use Microdrive that supports CF+Type II (CompactFlash expansion standard). Microdrive is a compact hard disk drive. Be sure to read the “Precautions for using Microdrive” (P.24).

---

**Note**

- 340 MB Microdrive cannot be used.
- This camera may not recognize a non-Olympus card or a card that was formatted on another device (such as a PC). Before use, be sure to format the card on this camera. “Formatting cards” (P.166)
1 **Make sure the camera is turned off.**
   - The monitor is off.
   - The viewfinder is off.
   - The lens is retracted.

2 **Open the card cover.**

3 **Insert a card.**

   **xD-Picture Card**
   - Insert the card into the front slot, ensuring that it is not inserted diagonally.
   - Insert the card as far as it will go until it clicks.
   - If the card is inserted incorrectly oriented or it is inserted at an angle, the contact area may be damaged or the card may become jammed.
   - If the card is not inserted fully, it may not be able to record data.

   **CompactFlash/Microdrive**
   - Hold the card straight and insert it correctly into the rear slot, as shown.
   - Set the eject button in the down position.

4 **Close the card cover securely until it clicks.**

**Removing the card**

   **xD-Picture Card**
   - Push the card all the way in to unlock it, then let it return slowly. (The card will be ejected. Take hold of the card and pull it out.)

   **Note**
   Releasing your finger quickly after pushing the card all the way in may cause it to eject forcefully out of the slot.
CompactFlash/Microdrive
• Set the eject button in the upright position.
• Press the eject button gently all the way in. The card will be ejected a short way.
• Take hold of the card and pull it out.
• Return the eject button to the down position before closing the card cover.

Note
• Do not push the card in with a pen or similar hard or pointed object.
• Never open the card cover, or remove the card or the battery while the camera is turned on. Doing so could destroy the data stored on the card. Once destroyed, data cannot be restored.

Switching cards

The card currently in use is indicated in the viewfinder or on the monitor. Choose the card you want to record the picture on before taking the picture. The factory default setting is the xD-Picture Card. If only one card is inserted, that card is automatically selected. Card selection can also be made in Playback mode.

1 Press the card button repeatedly to select the card you want to use.
• The indication alternates between the two slots.

[xD] : xD-Picture Card
[CF] : CompactFlash or Microdrive
Precautions for using Microdrive

The following restrictions apply when using Microdrive. Read the instructions provided with your Microdrive. You are recommended to use an xD-Picture Card or CompactFlash card when taking important pictures.

Operating environment

Microdrive is a compact hard disk drive. As it is a rotating recording medium, it is not as resistant to vibration or impact as the solid recording medium of other cards. When using Microdrive, be careful not to subject the camera to vibration or impact. (Special care is needed during recording and playback.)

- Do not bang the camera down on the table during recording.
- Be careful not to hit the camera against anything when carrying it on your shoulder.
- Do not use the camera where the ground is likely to vibrate, such as a construction site.
- Do not use the camera in the car while driving along a bumpy road etc., where the camera will be badly shaken.

Precautions regarding Microdrive

- Do not write on the label.
- Do not remove the label.
- Do not over-wrap labels.
- It is advisable to keep Microdrive in its case for storage or transportation.
- Microdrive may become hot if used for an extended period of time. Care should be taken when handling Microdrive.
- Do not take close to where there is strong magnetism.
- Do not apply strong pressure to the cover.

Camera operations

Using Microdrive may increase the battery consumption. To reduce consumption of the battery, observe the following.

- Whenever possible, refrain from using the monitor during shooting.
- Unless there is a particular need, remove the xD-Picture Card when using Microdrive.
- If nothing happens when the buttons are pressed, remove the battery, then put it back again.
- If you use Microdrive when the battery power is low, the camera may not turn on.

If CARD ERROR is displayed

- If no pictures can be recorded or downloaded, run SCANDISK on a PC. (Error codes" (P.200)
Turning the power on/off

1 Press the catch on the lens cap in the direction of the arrow and remove the lens cap.

2 Turn the mode dial until the mode you want to use is aligned with the red line.

3 Press the power switch.
   - The mode in which the camera turns on depends on the position of the mode dial.
     
     **Shooting mode**
     The camera turns on in the shooting mode. The monitor turns on and the lens extends.
     
     **Playback mode**
     The camera turns on in the playback mode and the monitor turns on.
     
     **SET UP mode**
     The menu is displayed on the monitor.
   - You can change the mode with the camera turned on, or off.

4 Press the power switch again to turn the camera off.

**TIPS**

- **Setting the date and time**
  Pictures are saved with the date and time when they were taken.
  “Setting the date and time” (P.168)

- **Selecting a language for on-screen display**
  You can select the language in which illustrations and explanations are displayed on the monitor.
  “Selecting a language for on-screen display” (P.167)
The viewfinder or monitor turned off

- To reduce battery consumption, the lens retracts to the widest position and the camera automatically enters the sleep mode after about 3 minutes of non-operation. The camera activates again as soon as you touch the shutter button or zoom lever. You can select the length of time until the camera enters the sleep mode.
  “SLEEP – Setting the time until the camera enters sleep mode” (P.169)
- To reduce battery consumption, the camera turns off automatically and the lens retracts after about 4 hours of non-operation. To resume operation, turn the camera on again.

- If the camera is subjected to strong vibration or impact while it is turned on, it may turn off momentarily and the date and other settings return to the factory default settings.

If the card is not recognized (card check)

When the power is turned on, the camera checks the card automatically. If there is no card in the camera or a card that is not supported by this camera is inserted, the following screen is displayed.

<table>
<thead>
<tr>
<th>Monitor indication</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="NO CARD" /></td>
<td>There is no card in the camera or the card is not inserted properly. → Insert a card. If a card is already inserted, remove it and insert it again.</td>
</tr>
<tr>
<td><img src="image" alt="CARD SETUP" /></td>
<td>The card cannot record, play back or erase pictures. Replace the card with a new one or format the card. → Press to select POWER OFF, then press . Replace the card with a new one. → Format the card. Press to select FORMAT, then press to display the confirmation screen. Select YES and press . Formatting starts. If the card was successfully formatted, the camera is ready to take pictures.</td>
</tr>
</tbody>
</table>

- All data stored on the card is erased when the card is formatted.

Note
Adjusting the viewfinder

You can adjust the viewfinder to match your eyesight (visual acuity).

1 With the viewfinder off, press \( \text{f} \) to turn it on.

2 Look through the viewfinder and slowly turn the diopter adjustment ring.

3 Turn the diopter adjustment ring until the AF target mark can be seen clearly.

When light shines directly on the lens, flare or ghosting may occur. To prevent this happening, attach a lens hood.

Attaching the lens hood

When light shines directly on the lens, flare or ghosting may occur. To prevent this happening, attach a lens hood.

1 Fit the lens hood matching the lens hood indicator (\( \text{f} \)) with the indicator on the lens.

2 Turn the lens hood in the direction of the arrow as far as it goes.

Note

- The lens hood cannot be attached or detached when the lens cap is on.
- The lens cannot be retracted with the lens hood attached backwards.
Holding the camera

Hold the camera firmly with both hands while keeping your elbows at your sides to prevent the camera from moving. When taking pictures in the vertical position, hold the camera in a position as shown in the illustration. Keep your fingers, the strap and the lens cap away from the lens, flash and AF sensor.

Horizontal grip  Vertical grip  Top view

• Clear pictures cannot be obtained if the camera moves as the shutter button is pressed. Hold the camera correctly, and press the shutter button gently.
• For the best results, hold camera at right position so that flash is positioned higher than the lens.

Changing the angle of the monitor

You can change the angle of the monitor. This is useful for taking low-angle shots where the viewfinder or monitor is hard to see.

1 Take hold of the monitor as shown in the illustration and pull it out.

2 To take low-angle shots, position the monitor in the up position as shown.
   • The monitor can be positioned in the down position at an angle of 45 degrees and in the up position at an angle of 22, 45 or 90 degrees.
   • To take high-angle shots, position the monitor in the down position.

Note

- Do not hold this part of the lens.
This camera is equipped with direct buttons for quick operation and setting of various shooting and playback-related functions. The setting screens are displayed on the monitor when the direct buttons are pressed. Menus are also provided for selecting the various shooting and playback settings.

Functions that can be set using the direct buttons can also be set using the menus.

**Ex 1: To select a metering mode**

<table>
<thead>
<tr>
<th>Using the direct button</th>
<th>Using the menus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Press (a).</td>
<td>Press (a) to display the menu, then select MODE MENU – CAMERA tab – ESP/().</td>
</tr>
</tbody>
</table>

- The setting screen is displayed on the monitor.
- Turn the control dial while holding down (a) to select a metering mode.
- Press (a) to select a metering mode.
Ex 2: To select a flash mode

Using the direct button

Press  \( \downarrow \).

- The setting screen is displayed on the monitor.
- Turn the control dial while holding down  \( \downarrow \) to select a flash mode.

Using the menus

Press  \( \# \) to display the menu, then select MODE MENU – CAMERA tab – FLASH MODE.

- Use the arrow pad to select flash-related settings.

The same setting screen is displayed using the direct button or the MODE MENU.

\[ \text{TIPS} \]

Flash intensity control can be adjusted directly by turning the control dial while holding down  \( \downarrow \).
Direct buttons

The direct buttons have different functions in the shooting mode and in the playback mode. Turning the control dial while holding down the direct button allows you to select menu options or change the values for the different functions.
Certain function settings require the direct button to be pressed repeatedly.

Direct button basics

The procedure for making settings using the direct buttons and control dial is shown below. The setting screens are displayed on the monitor when pressing the direct button.

Ex: Using the ↘ (flash mode) button

1. Turn the control dial while holding down ↘ to select the flash mode.
   - The setting screen is displayed on the monitor.
   - At the moment you release your finger from the ↘ button, the flash mode setting is made.
   - If the operation guide is displayed at the bottom of the screen, you can select further options.

2. Press while holding down ↘ to display the menu.
   Release the direct button after the menu is displayed.
   - The menu for changing the current settings for the various flash options is displayed.

3. Follow the operation guide to select the item and option you want to change.
   For further details, see “Menu basics” (P.38).
Further options may be available depending on the option you selected. If the operation guide is displayed at the bottom of the screen, you can select further options.

Ex)
When the \( \) (self-timer/remote control) button is used

Turn the control dial while holding down \( \) to change the setting.

If you select \( \), the operation guide is displayed.

Pressing \( \) while holding down \( \) displays the screen for selecting the time that remote control is activated.
Functions that can be set using the direct buttons

- **Shooting mode**

This means to turn the control dial while holding down the direct button to make function settings.

1. **(exposure compensation) button**

   Changes the exposure compensation value.

2. **(flash mode) button**

   Selects a flash mode from auto, (red-eye reduction), (fill-in flash), (SLOW (slow synchronization)) and (flash off).

---

You can select the various options available in FLASH MODE, (flash intensity control), FLASH (external flash) and SLOW (slow synchronization) mode.
Direct buttons

1 + 2 Press at the same time (flash intensity control) buttons  P.64

Adjusts the amount of light emitted by the flash.

AF/AF/MF (AF/Macro/MF) button  P.79, 87, 88

Selects a focus mode from AF (auto-focus), (macro), MF (manual focus), (super macro) and MF (super macro MF).

(metering) button  P.81, 83

Selects a metering mode from ESP, spot metering ( ), multi-metering (MULTI) and center-weighted metering ( ).

(self-timer/remote control) button  P.89, 90

Activates the self-timer or remote control function.
Direct buttons

6 **WB** (white balance) button  P.109
Selects a white balance setting from AUTO, PRESET 1, PRESET 2, CUSTOM and (one-touch).

7 **i**- (record mode) button  P.105
Sets the image quality and resolution.
Still pictures : RAW, TIFF, SHQ, HQ, SQ1, SQ2
Movies : SHQ, HQ, SQ

8 **(custom)** button  P.154
Activates the function registered on the custom button.
See “Custom button” (P.154) for details of how to register a function and use the button.

9 **QUICK VIEW** button  P.122
Displays the last picture taken on the monitor.

10 **AEL** (AE Lock) button  P.85
Fixes the exposure. The lock function is alternately activated and canceled each time you press the button.
Direct buttons

● Playback mode

1. **LOCK (protect) button**  
   Protects important pictures from accidental erasure.  
   ![Diagram showing the LOCK button](image)

2. **INFO (information display) button**  
   Displays the shooting information and histogram.  
   ![Diagram showing the INFO button](image)

3. **_rotation button**  
   Rotates pictures 90 degrees clockwise or counterclockwise.  
   ![Diagram showing the rotation button](image)

4. **print button**  
   Stores print reservation data on the card.  
   ![Diagram showing the print button](image)

5. **(erase) button**  
   Erases a selected picture.  
   ![Diagram showing the erase button](image)
Using the menus

There are two types of menu: the top menu which is the first screen that appears on the monitor when you turn on the camera and press \( \text{SET} \), and the MODE MENU which categorizes settings into tabs. The functions of this camera are set from the menus. When the mode dial is set to SET UP, the MODE MENU is displayed instead of the top menu.

- Setting the mode dial to SET UP displays the MODE MENU.
- Setting the mode dial to \( \text{PASM} \) and pressing \( \text{SET} \) displays the top menu in the shooting mode.
- Setting the mode dial to \( \) and pressing \( \text{SET} \) displays the top menu in the playback mode.

Press \( \text{SET} \)

Top menu

Shortcut menus

- Take you directly to the setting screens.
- Display operational buttons at the bottom of the screen.
- The functions registered in the shortcut menus can also be accessed from the MODE MENU.
- You can change the shortcut menus in any mode other than \( \) modes. “SHORT CUT” (P.157)

MODE MENU

- Categorizes the settings into tabs.
- Displays the associated menu items when a tab is selected by pressing \( \).  
- Display operational buttons at the bottom of the screen.
Menu basics

This section explains how the menus work, using the P mode screens. Setting the mode dial to SET UP displays the screen in Step 2.

1 Press \( \square \) to display the top menu, then press \( \circ \).

2 Press \( \odot \) to select a tab, then press \( \odot \).

Top menu

CAMERA tab

PICTURE tab

CARD tab

stab
3 Press \( \) to select the item you want to set, then press \( \).

4 Press \( \) to select a setting. Press \( \) to complete setting. Press \( \) again to exit the menu.

The green frame moves to the selected item.

To return to select an item, press \( \) or \( \).

While SET UP is selected on the mode dial, turn the dial other than SET UP to exit the MODE MENU.

- Not all items can be selected depending on the status of the camera and the settings performed.
- You can take pictures by pressing the shutter button in the shooting mode with the menu open.
- If you want to save the settings even if the camera turns off, set ALL RESET to OFF. \( \) “ALL RESET – Saving the camera’s settings” (P.145)
Shortcut menus

Shooting mode

Selects a shooting mode from (single-frame shooting), (high speed sequential shooting), (sequential shooting), (AF sequential shooting) and (auto bracketing).

Selects whether to record sound when shooting a movie.

Selects the ISO value from AUTO or in the range of ISO 50 to ISO 400.

Digitally enhances the maximum optical zoom.

The functions registered in the shortcut menus can also be accessed from the MODE MENU. You can change the shortcut menus in any mode except and modes.

"SHORT CUT" (P.157)
## Playback mode (▶)

For still pictures

![Diagram of Playback mode for still pictures]

- **Runs through all saved pictures one after another.**
  
P.127

For movies

![Diagram of Playback mode for movies]

**MOVIE PLAY**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MOVIE PLAYBACK</td>
<td>Plays back movies.</td>
<td>P.128</td>
</tr>
<tr>
<td>INDEX</td>
<td>Creates an indexed view of a movie in 9 frames.</td>
<td>P.131</td>
</tr>
<tr>
<td>EDIT</td>
<td>Edits a movie.</td>
<td>P.132</td>
</tr>
</tbody>
</table>

**COPY**

- **Displays guidelines on the image.**
  
P.136

- **Copies pictures to and from cards. Lets you select whether to copy all frames or only a selected frame.**
  
P.141

- **Adds sound to a still picture already taken.**
  
P.137
Mode menus

The MODE MENU functions are divided into tabs. Press \( \text{\textcopyright} \) to select a tab and display the associated menu items.

**TABS**

CAMERA tab: regards picture taking.
PICTURE tab: regards picture appearance.
EDIT tab: regards editing picture already taken.
CARD tab: regards memory card formatting, etc.
\( \text{\textcopyright} \) tab: regards customizing functions.
SETUP tab: regards basic settings of the camera.

### Shooting mode (P A S M \( \text{\textcopyright} \) \( \text{\textcopyright} \) \( \text{\textcopyright} \) \( \text{\textcopyright} \) \( \text{\textcopyright} \) mode)

<table>
<thead>
<tr>
<th>CAMERA tab</th>
<th>PICTURE tab</th>
<th>CARD tab</th>
<th>( \text{\textcopyright} ) tab</th>
<th>SETUP tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>FLASH MODE</td>
<td>AF/( \text{\textcopyright} )/MF</td>
<td>ESP/( \text{\textcopyright} )</td>
<td>( \text{\textcopyright} )/( \text{\textcopyright} )</td>
<td>ISO</td>
</tr>
<tr>
<td>Selects flash-related settings. Sets the options available in flash mode, flash intensity control, external flash and slow synchronization.</td>
<td>Sets the options available in focus mode, AF mode, fulltime AF and P-AF.</td>
<td>Selects a metering mode from ESP, spot metering, multi-metering and center-weighted metering.</td>
<td>Selects a shooting mode from ( \text{\textcopyright} ) (single-frame shooting), ( \text{\textcopyright} \text{\textcopyright} ) (high speed sequential shooting), ( \text{\textcopyright} \text{\textcopyright} \text{\textcopyright} ) (sequential shooting), ( \text{\textcopyright} \text{\textcopyright} \text{\textcopyright} \text{\textcopyright} \text{\textcopyright} \text{\textcopyright} ) (AF sequential shooting) and BKT (auto bracketing).</td>
<td>Selects the ISO value from AUTO or in the range of ISO 50 to ISO 400.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Functioning the noise that affects pictures during long exposures.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Displays lines as a guide for composing the picture.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- P.59
- P.74, 75, 76
- P.81
- P.92
- P.89, 90
- P.107
- P.58
- P.118
- P.95, 97, 98
- P.99
- P.100
- P.73
- P.119
## Mode menus

### PICTURE tab

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>WB</td>
<td>Sets the appropriate white balance according to the light source. Also adjusts and saves the white balance.</td>
<td>109</td>
</tr>
<tr>
<td></td>
<td>Sets the image quality and resolution. Still pictures: RAW, TIFF, SHQ, HQ, SQ1, SQ2 Movies: SHQ, HQ, SQ</td>
<td>102</td>
</tr>
<tr>
<td>SCENE MODES</td>
<td>Lets you take pictures suited to the situation and the desired effect (I, L, m).</td>
<td>117</td>
</tr>
<tr>
<td>SHARPNESS</td>
<td>Adjusts the sharpness of the image.</td>
<td>114</td>
</tr>
<tr>
<td>CONTRAST</td>
<td>Adjusts the contrast of the image.</td>
<td>115</td>
</tr>
<tr>
<td>HUE</td>
<td>Adjusts the overall tint of the picture.</td>
<td>116</td>
</tr>
<tr>
<td>SATURATION</td>
<td>Adjusts the level of color depth without changing the tint.</td>
<td>117</td>
</tr>
</tbody>
</table>

### CARD tab

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>CARD SETUP</td>
<td>Formats a card.</td>
<td>166</td>
</tr>
</tbody>
</table>

### tab

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL RESET</td>
<td>Selects whether to keep the current camera settings when you turn off the power.</td>
<td>145</td>
</tr>
<tr>
<td>REC VIEW</td>
<td>Displays the picture on the monitor while recording it to a card.</td>
<td>147</td>
</tr>
<tr>
<td>BEEP</td>
<td>Sets the beep sound used for button operations and adjusts the volume.</td>
<td>148</td>
</tr>
<tr>
<td>SHUTTER SOUND</td>
<td>Sets the sound made when the shutter button is pressed and adjusts the volume.</td>
<td>149</td>
</tr>
<tr>
<td>DIAL</td>
<td>Changes the control dial, arrow pad and direct button functions.</td>
<td>150</td>
</tr>
<tr>
<td>EV STEP</td>
<td>Selects whether to set the shutter speed, aperture value and exposure compensation, etc. in 1/3 EV steps or in 1/2 EV steps.</td>
<td>153</td>
</tr>
<tr>
<td>CUSTOM BUTTON</td>
<td>Lets you assign a frequently used function to the camera's custom button.</td>
<td>154</td>
</tr>
<tr>
<td>SHORT CUT</td>
<td>Lets you assign frequently used functions as shortcut menus.</td>
<td>157</td>
</tr>
<tr>
<td>MY MODE SETUP</td>
<td>Customizes settings which are activated in the mode.</td>
<td>160</td>
</tr>
<tr>
<td>CONTROL PANEL</td>
<td>Displays the settings in the shooting mode on the monitor.</td>
<td>163</td>
</tr>
</tbody>
</table>
● Playback mode (▶)

EDIT tab
- RAW DATA EDIT: Sets the image quality, white balance, etc. of pictures taken in RAW data format and saves them as new files. P.140
- COPYING: Makes the file size smaller and saves it as a new file. P.138
- CROP: Crops part of a picture and saves it as a new file. P.139
- COPY: Copies pictures to and from cards. Lets you select whether to copy all frames or only a selected frame. P.141

* The EDIT tab is not displayed during movie playback.

CARD tab
- CARD SETUP: Erases all image data stored on the card or formats a card. P.144, 166

TAB
- ALL RESET: Selects whether to keep the current camera settings when you turn off the power. P.145
- BEEP: Sets the beep sound used for button operations and adjusts the volume. P.148
- VOLUME: Adjusts the sound volume during playback. P.165
- : Selects the number of frames in the index display. P.126

SET UP mode

CARD tab
- CARD SETUP: Formats a card. P.166

The functions assigned to the tab in both shooting and playback modes can also be set from the tab in SET UP mode.
## Mode menus

### Person tab

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL RESET</td>
<td>Selects whether to keep the current camera settings when you turn off the power.</td>
<td>P.145</td>
</tr>
<tr>
<td>REC VIEW</td>
<td>Displays the picture on the monitor while recording it to a card.</td>
<td>P.147</td>
</tr>
<tr>
<td>BEEP</td>
<td>Sets the beep sound used for button operations and adjusts the volume.</td>
<td>P.148</td>
</tr>
<tr>
<td>SHUTTER SOUND</td>
<td>Sets the sound made when the shutter button is pressed and adjusts the volume.</td>
<td>P.149</td>
</tr>
<tr>
<td>DIAL</td>
<td>Changes the control dial, arrow pad and direct button functions.</td>
<td>P.150</td>
</tr>
<tr>
<td>EV STEP</td>
<td>Selects whether to set the shutter speed, aperture value and exposure compensation in 1/3EV steps or in 1/2EV steps.</td>
<td>P.153</td>
</tr>
<tr>
<td>CUSTOM BUTTON</td>
<td>Lets you assign a frequently used function to the camera's custom button.</td>
<td>P.154</td>
</tr>
<tr>
<td>SHORT CUT</td>
<td>Lets you assign frequently used functions as shortcut menus.</td>
<td>P.157</td>
</tr>
</tbody>
</table>
| MY MODE SETUP | Customizes settings which are activated in the 
| | mode. | P.160 |
| CONTROL PANEL | Displays the settings in the shooting mode on the monitor. | P.163 |
| VOLUME | Adjusts the sound volume during playback. | P.165 |
| | Selects the number of frames in the index display. | P.126 |

### Setup tab

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Selects a language for on-screen display.</td>
<td>P.167</td>
</tr>
<tr>
<td></td>
<td>Sets the date and time.</td>
<td>P.168</td>
</tr>
<tr>
<td></td>
<td>Sets the beep sound used for warnings and adjusts the volume.</td>
<td>P.169</td>
</tr>
<tr>
<td>SLEEP</td>
<td>Sets the time from the moment the camera was last operated until it enters sleep mode.</td>
<td>P.169</td>
</tr>
<tr>
<td>FILE NAME</td>
<td>Changes how file names are assigned.</td>
<td>P.170</td>
</tr>
<tr>
<td>BATTERY SAVE</td>
<td>Turns the powersaving mode on and off.</td>
<td>P.171</td>
</tr>
<tr>
<td>PIXEL MAPPING</td>
<td>Checks the CCD and image processing functions for errors.</td>
<td>P.172</td>
</tr>
<tr>
<td></td>
<td>Adjusts the brightness of the viewfinder or monitor.</td>
<td>P.173</td>
</tr>
<tr>
<td></td>
<td>Sets the measurement unit (m/ft) used during manual focus.</td>
<td>P.173</td>
</tr>
<tr>
<td>VIDEO OUT</td>
<td>Selects NTSC or PAL according to your TV's video signal type. TV video signal types differ depending on the region.</td>
<td>P.174</td>
</tr>
<tr>
<td>AF ILLUMINATOR</td>
<td>Turns on the AF illuminator to illuminate a dark subject.</td>
<td>P.78</td>
</tr>
<tr>
<td>USB</td>
<td>Sets whether the camera is connected to a PC or a printer with the USB cable.</td>
<td>P.175</td>
</tr>
</tbody>
</table>
3 Shooting basics

Shooting mode

The shooting mode includes modes where the optimal settings for the situation are automatically selected, and modes where you can select the settings best suited to the shooting conditions and the effect you wish to achieve. You can change the mode with the camera turned on, or off.

Setting-related modes

P Program shooting

The camera automatically sets the optimum aperture value and shutter speed for the brightness of the subject. Other functions, such as flash mode and record mode, can be adjusted manually.

Program shift

Program shift allows you to change the combination of aperture value and shutter speed set by the camera without altering the exposure.

- Press to change the aperture value and the shutter speed that determines an appropriate exposure.
- Ps is displayed on the monitor in the program shift mode.
- The brightness of the subject or certain flash settings may prevent the program shift.

To cancel the program shift mode, do one of the following:
- If the combination of shutter speed and aperture value was changed by pressing , press until Ps goes out.
- If the combination of shutter speed and aperture value was changed by pressing , press until Ps goes out.
- Change the mode to A, S, M, or .
A Aperture priority shooting

Allows you to set the aperture manually. The camera sets the shutter speed automatically. By decreasing the aperture value (F number), the camera will focus within a smaller range, producing a picture with a blurred background. Increasing the value forces the camera to focus over a wider range in the forward and backward directions, resulting in a picture in which both the subject and the background are in focus.

“Aperture priority shooting” (P.70)

Aperture (F number) is decreased. Aperture (F number) is increased.

S Shutter priority shooting

Allows you to set the shutter speed manually. The camera sets the aperture automatically. Set the shutter speed according to the subject and the type of effect you want.

“Shutter priority shooting” (P.71)

Setting the shutter speed higher lets you capture fast-moving action without blur. The subject will be clear and sharp, as if it were not moving.

Setting the shutter speed lower blurs a moving subject, giving the impression of movement.
M Manual shooting

Allows you to set the aperture and shutter speed manually. To check the exposure, refer to the exposure differential displayed on the monitor. This mode gives you more creative control, allowing you to make the settings you need to get the type of picture you want, regardless of optimum exposure. Using bulb allows you to take pictures at the max of 8 min of long exposure.

“Manual shooting” (P.72)

My Mode

Allows you to save your favorite settings as your own personal mode and use these customized settings when taking pictures. Current settings can also be saved for retrieving by this mode. “MY MODE SETUP – Setting a function in My Mode” (P.160) “Using My Mode” (P.73)

Movie record

This function allows you to record movies. The camera automatically determines the aperture and shutter speed. Sound is recorded at the same time. The focus and zoom are locked. If the distance to the subject changes, focus may be compromised.

“Recording movies” (P.55)
Situation-related modes

Night Scene shooting

Suitable for shooting pictures in the evening or at night. The camera sets a slower shutter speed than is used in normal shooting. For example, if you take a picture of a street at night in P mode, the lack of brightness will result in a dark picture with only dots of light. In the Night Scene shooting mode, the true appearance of the street is captured. The camera automatically selects the optimal settings for this type of shooting condition. Since the shutter speed is slow, make sure you stabilize the camera by using a tripod.

Landscape shooting

Suitable for taking pictures of landscapes and other outdoor scenes. Both the foreground and the background are in focus. Since blues and greens are vividly reproduced in this mode, it is excellent for shooting natural scenery. The camera automatically sets the optimal shooting conditions.

Sports shooting

Suitable for capturing fast-moving action (such as sports) without blur. Even a fast-moving subject will be clear and sharp as if it were not moving. It enables you to capture facial expressions and detailed activity. The camera automatically sets the optimal shooting conditions.

Portrait shooting

Suitable for taking a portrait-style shot of a person. This mode features an in-focus subject against a blurred background. The camera automatically sets the optimal shooting conditions.

Note

- The available settings vary depending on the mode. "List of items by shooting mode" (P.217)
You can take still pictures using either the viewfinder or the monitor.

1. Set the mode dial to P A S M or and turn the camera on.

2. Compose the picture.

3. Press the shutter button gently (halfway) to adjust the focus.
   - The AF target mark moves to the focus position.
   - The shutter speed and aperture value automatically selected by the camera are displayed on the monitor (except in M mode).
   - Monitor indications when the shutter button is pressed halfway are shown in the following table.

<table>
<thead>
<tr>
<th>Indication</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>mark</td>
<td>Lights Flash stand-by. The flash fires when the shutter-release button is pressed all the way.</td>
</tr>
<tr>
<td>mark</td>
<td>Blinks If the flash has popped up: flash is charging. Remove your finger from the shutter button and wait until the lamp goes off. If the flash is closed: camera movement warning. Press the flash pop-up button to open the flash.</td>
</tr>
<tr>
<td>Green lamp</td>
<td>Lights The picture is in focus or the exposure is locked.</td>
</tr>
<tr>
<td></td>
<td>Blinks The picture is out of focus or the exposure is not locked. Also see TIPS on P.51.</td>
</tr>
</tbody>
</table>

4. Press the shutter button all the way (fully).
   - The camera takes the picture.
   - The card access lamp blinks while the picture is stored on the card.
   - You can check the picture you have taken by pressing the QUICK VIEW button. “QUICK VIEW” (P.122)
Canceling recording to the card

You can cancel recording to the card while the picture you have taken is being stored. Once recording to the card has been terminated, the picture will not be stored. You can cancel recording to the card when the picture was taken in RAW or TIFF record mode. [Record mode] (P.102)

1 Press [REC] while the picture you have taken is being recorded to the card (while the card access lamp is blinking).
   • The picture just taken is displayed on the monitor.

2 Press [REC] to select REC. START or REC. CANCEL (CANCEL ONE or CANCEL ALL), then press [OK].
   REC. START Recording to the card is resumed. The picture displayed on the monitor is stored on the card.
   REC. CANCEL The picture displayed on the monitor is not stored on the card.

   • REC. CANCEL is not displayed in sequential shooting mode or when several pictures are taken in succession. In this case, select CANCEL ONE or CANCEL ALL.
   CANCEL ONE The picture displayed on the monitor is erased without being stored on the card. All other pictures are stored on the card.
   CANCEL ALL None of the pictures taken is stored on the card.

TIPS

The subject cannot be focused on.
[If correct focus cannot be obtained] (P.53)

The green lamp blinks.
   → You are too close to the subject. Take the picture at least 20 cm (7.9") away from the subject. If you use the super macro mode, you can take pictures as close as 5cm/1.2") from the subject. [Super macro shooting] (P.88)
   → Depending on the subject, the focus and exposure may not be locked.
[Subjects that are difficult to auto focus on] (P.54)
Taking still pictures

To check the picture you have just taken immediately.
→ Set REC VIEW to ON. “REC VIEW – Checking the picture immediately after shooting” (P.147)

To record sound when taking pictures.
→ You can record sound when taking still pictures. Set R to ON.
   “Recording sound with still pictures” (P.100) You can also add sound to a picture that has already been taken. “Recording sound” (P.137)

The viewfinder or monitor turned off.
→ The camera automatically enters the sleep mode and the viewfinder and monitor turn off after about 3 minutes of non-operation. Touch the shutter button or zoom lever to turn the viewfinder or monitor on again. You can select the length of time until the camera enters the sleep mode.
   “SLEEP – Setting the time until the camera enters sleep mode” (P.169)

To adjust the brightness of the viewfinder or monitor.
→ Select in the mode menu and adjust the brightness. “Adjusting the brightness of the monitor and viewfinder” (P.173)

The viewfinder or monitor is hard to see.
→ When you point the camera lens toward a bright subject, smears (lines like beams of light) may appear on the image in the viewfinder or on the monitor. This does not affect recorded pictures.

To check the area the camera is focusing on.
→ If you press while pressing the shutter button halfway, the area you are focusing on is enlarged. Pressing once more returns the size to normal. This function is not available in the digital zoom range.
   “Using the digital zoom” (P.58)

• Press the shutter button gently using the ball of your finger. If it is pressed hard, the camera may move and pictures may come out blurred.
• Recorded pictures will be saved on the card regardless of whether the camera is turned off or the battery is replaced or removed.
• Do not open the card cover, remove the battery or connect/disconnect the AC adapter while the card access lamp is blinking. Doing so could destroy stored pictures and prevent storage of pictures you have just taken.
• When taking pictures against strong backlight, the area of the picture in shadow may appear colored.
If correct focus cannot be obtained

When the subject you want to focus on is not in the center of the frame and you cannot position the AF target mark on it, you can focus the camera on another point at roughly the same distance (focus lock) and take the picture as explained below.

Determine the position of the subject after focusing (Focus Lock)

1. Position the AF target mark on the subject you want to focus on.
   - When shooting a hard-to-focus subject or a fast-moving subject, point the camera at an object about the same distance away as the subject.

2. Press the shutter button halfway and check that the green lamp lights steadily.
   - When the focus and exposure are locked, the green lamp lights steadily.
   - The AF target mark moves to the focus position.
   - When the green lamp blinks, the focus and exposure are not locked. Release your finger from the shutter button, reposition your subject and press the shutter button halfway again.

3. Keeping the shutter button pressed halfway, recompose your shot.

4. Press the shutter button all the way (fully).

TIPS

The frame in which you focus on a subject is different from the frame in which you lock the exposure.

“AE Lock - Locking the exposure” (P.85)

You want to focus on the center of the frame.

“AF MODE - Changing the focus range” (P.74)
Subjects that are difficult to auto focus on

Under certain types of conditions, the auto focus may not work properly. If this happens, focus on an object with high contrast at the same distance as the intended subject (focus lock), recompose your shot and then take the picture. If the subject has no vertical lines, hold the camera vertically and focus the camera using the focus lock function by pressing the shutter button halfway, then return the camera to the horizontal position while keeping the button pressed halfway and take the picture.

If the subject still cannot be focused on, use the manual focus.

“Manual focus” (P.79)

---

Green lamp blinks: the subject cannot be brought into focus.

- Subject with low contrast
- Subject with an extremely bright area in the center of the frame
- Subject without vertical lines

The green lamp lights, but the subject cannot be brought into focus.

- Subjects at different distances
- Fast-moving subject
- The subject to be focused on is not in the center of the frame.
You can also record movies with this camera. Sound is recorded at the same time. The focus and zoom are locked. If the distance to the subject changes, focus may be compromised.

1. **Set the mode dial to □ and turn the camera on.**
   - The remaining recording time on the card that you are using is displayed on the monitor.

2. **Compose the picture.**
   - You can use the zoom lever to enlarge your subject.

3. **Press the shutter button fully to start recording.**
   - The focus and zoom are locked.
   - During movie recording, □ lights red.

4. **Press the shutter button again to stop recording.**
   - When the remaining recording time has been used up, recording stops automatically.
   - When there is space in the card memory, the remaining recording time is displayed, and the camera is ready to shoot the next movie.

   - “Movie Record Modes” (P.104)
**TIPS**

To keep your subject in focus all the time while shooting.
The auto focus does not operate during recording when (movie) is set to ON.
→ Set (movie) to OFF and FULLTIME AF to ON. “FULLTIME AF - A reliable time-saving way to focus” (P.75)

To use the zoom while shooting.
The optical zoom is not available during recording when (movie) is set to ON.
→ Set DIGITAL ZOOM to ON. “Using the digital zoom” (P.58)
→ Set (movie) to OFF, and you can use the optical zoom while shooting. “Recording sound with movies” (P.101)

---

- Depending on the card, the remaining recording time may drop rapidly during recording. Try using the card again after formatting it. “Formatting cards” (P.166)
- When (movie) is set to ON, the movie is recorded with the focus that was set when the shutter button was pressed in Step 3. If the distance to the subject changes, focus may be compromised.
- In (mode), the flash and manual focus (MF) cannot be used.

---

**Notes for recording movies over a long time**

- Recording will continue until the card is full unless stopped by pressing the shutter button.
- A long recorded movie cannot be edited. (P.130)
- If a single movie recording uses up all of the card’s memory, create space on the card by deleting the movie or downloading it to a PC.
Telephoto and wide-angle shooting are possible at 5× magnification (the optical zoom limit, equivalent to 28 mm to 140 mm on a 35 mm camera). By combining the optical zoom with the digital zoom, zoom magnification can be increased to a maximum of approximately 15×.

Camera movement is likely to occur at higher magnifications. Stabilize the camera with a tripod, etc. to avoid camera movement.

Using the optical zoom

1. Turn the zoom lever.

Wide-angle: Turn the zoom lever toward W to zoom out.

Telephoto: Turn the zoom lever toward T to zoom in.
Using the digital zoom

1 In the top menu, select MODE MENU → CAMERA → DIGITAL ZOOM → ON, and press .
   “Menu basics” (P.38)
   • If DIGITAL ZOOM is displayed on the top menu as a shortcut menu, press the arrow pad in the same direction as the arrow shown next to DIGITAL ZOOM. “SHORT CUT” (P.157)
   • Press again to exit the menu.

2 Turn the zoom lever toward T.
   • The white area of the zoom indicator indicates the optical zoom. If the digital zoom is set to ON, a red area appears on the zoom indicator. When you reach the limit of the optical zoom, the digital zoom is enabled.

Note
   • In mode, the maximum digital zoom magnification is 2.5×.
   • Pictures taken with the digital zoom may appear grainy.
Select the flash mode best suited to the light conditions and the effect you want to achieve. You can also adjust the amount of light emitted using the flash intensity control.

1. Press the flash pop-up button (①).
   - The flash pops up (②).

2. Set the flash mode by turning the control dial while holding down ⬇.
   - The flash mode changes in the sequence shown below. (The selectable flash modes may differ depending on the shooting mode.)

3. Press the shutter button halfway.
   - ⬇ lights when the flash is ready to fire.

4. Press the shutter button fully to take the picture.

Flash working range
- W (max.): Approx. 0.8 – 5.8 m (2.6 – 19 ft.)
- T (max.): Approx. 0.2 – 4.0 m (0.7 – 13.1 ft.)
**Flash shooting**

**TIPS**

The (flash charging) indication blinks.
→ The flash is charging. Wait until (flash charging) goes off.

**Shutter speed when using the flash (Auto-flash, red-eye reduction, fill-in flash).**
→ When (flash charging) lights, the flash fires automatically but the shutter speed locks at a level at which camera movement is not likely to occur. The level at which the shutter speed locks changes depending on the zoom position.

<table>
<thead>
<tr>
<th>Zoom position</th>
<th>Shutter speed</th>
</tr>
</thead>
<tbody>
<tr>
<td>W (max.)</td>
<td>1/30 sec.</td>
</tr>
<tr>
<td>T (max.)</td>
<td>1/125 sec.</td>
</tr>
</tbody>
</table>

- AUTO, !, and SLOW are not available in S and M modes.
- The flash does not fire in the following situations:
  - In ! mode, during sequential shooting (HI, !, AF, BKT), during super macro shooting, during panorama shooting.
  - The flash may not give you the optimum result in macro mode, especially with wide-angle shooting. Check the resulting picture on the monitor.
  - When a conversion lens is attached to the camera, vignetting may occur. To take flash pictures, use an external flash.

**Auto-flash (No indication)**
The flash fires automatically in low light or backlight conditions.

**Red-eye reduction flash (!)**
The light from the flash may make the subject’s eyes appear red in the picture. The red-eye reduction flash mode significantly reduces this phenomenon by emitting pre-flashes before firing the regular flash. This helps accustom the subject’s eyes to the bright light and minimizes the red-eye phenomenon.

![The subject’s eyes appear red.](image)

- After the pre-flashes, it takes about 1 second before the shutter is released. Hold the camera firmly to avoid camera movement.
- Effectiveness may be limited if the subject is not looking directly at the pre-flashes, or if the shooting range is too far. Individual physical characteristics may also limit effectiveness.
● Fill-in flash (знак)
The flash fires regardless of the available light. This mode is useful for eliminating shadows on the subject’s face (such as shadows from tree leaves), in a backlight situation, or for correcting the color shift produced by artificial lighting (especially fluorescent light).

Note
• The fill-in flash may not have the desired effect under excessively bright light.

● Flash off (знак)
The flash does not fire even in low light conditions. Use this mode in situations where flash photography is not desired or is prohibited. You can also use this mode when you want to shoot a natural-looking twilight or night scene. Besides setting the mode to знак, flash does not fire when it is closed.

Note
• Since a slow shutter speed is automatically selected in low light situations when in the flash off mode, the use of a tripod is recommended to prevent your pictures from being blurred by camera movement.

● Slow synchronization (знак SLOW1 знак SLOW2 знак SLOW1)
The slow synchronization flash is designed for slow shutter speeds. Normally, when shooting with a flash, shutter speeds cannot go below a certain level to prevent camera movement. But when shooting a night scene background, fast shutter speeds can make the background too dark. Slow synchronization flash allows both a slow shutter speed for the background and a flash for the subject. Since the shutter speed is slow, make sure you stabilize the camera by using a tripod. Otherwise, camera movement may cause the picture to be blurred. In S and M modes, the flash fires at the selected shutter speed.

1st curtain (front curtain) знак SLOW1
Usually, regardless of the shutter speed, the flash fires right after the shutter fully opens. This is called 1st curtain. Unless you change it, this is how the flash always fires. The factory default setting for slow synchronization is знак SLOW1.
2nd curtain (rear curtain) ✂ SLOW2
The 2nd curtain fires just before the shutter closes. Changing the flash timing can create interesting effects in your picture, such as expressing the movement of a car by showing the tail-lights streaming backwards. The slower the shutter speed, the better the effects turn out.
The slowest possible shutter speed depends on the shooting mode:

- **A, S, M mode**: 15 sec. (Bulb shot is available in **M** mode.)
- **P, 📸, ⚪️, 📅, 🕒 mode**: 4 sec.

When the shutter speed is set to 4 sec.

1st curtain with red-eye reduction 🕳️ SLOW1
This mode is for when you want to use slow synchronization, yet also reduce the red-eye phenomenon. For instance, when shooting a person against a brightly lit night background. A normal flash might make the person’s eyes red, but 1st curtain with red-eye reduction lets you capture the background correctly and reduce the red-eye phenomenon at the same time. 2nd curtain with red-eye reduction is not available.
Using the slow synchronization flash

1. Press 
   while holding down 

2. Press 
   to select 
   SLOW, then press 

3. Press 
   to select 
   SLOW1, 
   SLOW or 
   SLOW2, then press 
   
   • Press 
     again to exit the menu.
Flash intensity control

You can adjust the amount of light emitted by the flash. In some situations, you may get better results by adjusting the light emission. Examples include small subjects, distant backgrounds, or situations when increased contrast is desired.

1 Adjust the brightness by turning the control dial while holding down \( \downarrow \) and \( \uparrow \) at the same time.

Turning to the left decreases the light emission. Min. setting is \(-2.0\).

Turning to the right increases the light emission. Max. setting is \(+2.0\).

TIPS

- The flash intensity can be set in \( \frac{1}{3} \)EV steps or \( \frac{1}{2} \)EV steps.
  - “EV STEP – Setting exposure adjustment increments” (P.153)

Note

- The flash adjustment effect may not be sufficient if the shutter speed is faster than \( \frac{1}{300} \).
Using an Olympus external flash

Various types of flash shooting are possible with the Olympus FL series external flashes.
If the external flash is used, flash mode and exposure compensation will be detected automatically by the camera, allowing the built-in flash and external flash to function together.
The external flash is mounted on the camera by attaching it to the hot shoe on the top of the camera. To use the external flash together with the built-in flash, the FL-BK01 flash bracket (optional) and FL-CB02 bracket cable (optional) are required.

This section explains how to use the FL-20 when attached to the hot shoe.

1. Slide the shoe cover off in the direction of the arrow and attach the external flash.
   - For instructions on how to attach the flash, refer to the manual for the external flash.
   - Keep the shoe cover in a safe place to prevent it getting lost, and replace it on the camera when you have finished using the external flash.
External flash (optional)

2 Press $\odi$ while holding down $\ddot{\dagger}$.

3 Press $\odot$ to select $\frown$ FLASH, then press $\odi$.

To use the external flash only
→ Select $\frown$, then press $\odi$.

To use the external flash together with the built-in flash, use Olympus flash bracket and the bracket cable (both optional).
→ Select IN+$\frown$, then press $\odi$.

4 Turn on the external flash.
   • Set the mode dial to TTL-AUTO.
   • Be sure to attach the flash to the camera before turning the flash on.

5 Select the flash mode by turning the control dial while holding down $\ddot{\dagger}$.

Note
   • If close-up pictures are overexposed, try using the built-in flash by itself.
   • When the built-in flash and the external flash are used together, the built-in flash is used as the compensating light source. This means that if the amount of light from the external flash is insufficient (beyond its working range), the resulting pictures may be underexposed.
   • When shooting using a wide angle setting, confirm that the illuminating angle of the flash covers the angle of the 27mm lens (equivalent for 35mm camera).
   • Using the Wide panel decreases the flash working range.
Using a commercially available external flash

Provided that the flash can be connected to the hot shoe, a commercially available external flash may be used. For details on compatible commercially available external flashes, refer to the next page. The amount of light emitted cannot be adjusted on commercially available external flashes except Olympus FL series. If the external flash gets in the way of the built-in flash when the flash pop-up button is pressed, use a flash bracket.

1 Attach the external flash to the hot shoe and connect it to the camera.
   • For instructions on how to attach the flash, refer to the manual for the external flash.

2 Select M mode. Adjust the shutter speed and aperture.
   "Manual shooting" (P.72)
   • Remember that a slow shutter speed can produce blurred images. For the best results, we recommend that you set the shutter speed from 1/200 to 1/300 seconds.

3 Turn on the external flash.
   • Be sure to attach the flash to the camera before turning the flash on.

4 Set the mode that automatically controls the amount of light emitted by the external flash. Also set ISO and aperture on the external flash to match the camera’s settings.
   • Refer to the user’s manual for the external flash to select the mode.

• The camera’s flash mode will have no effect on the external flash. The external flash will fire even when the camera’s flash mode is set to (off).
• Confirm in advance that the external flash you are using is synchronized with the camera.
Compatible external flashes

When selecting an external flash, use products which meet the following basic conditions.

1. Some flashes available on the market operate with a high voltage synchro terminal. If one of these is used, it may damage the camera, and/or the camera may not function normally. Contact the manufacturer of the flash you are using concerning the specifications of the flash’s synchro terminal.

2. Some flashes available on the market have the polarity of the synchro terminal reversed. In this case, even if the flash is connected, it will not fire. Contact the manufacturer of the flash for more information.

3. Exposures when using an external flash require that adjustments be made on the external flash unit. If an external flash is used in the auto mode, match it with the F value and ISO settings on the camera.

4. Even if the auto F value and ISO of the external flash are set to the same conditions as those on the camera, depending on the photographic conditions, it is possible that the correct exposure may not be obtained anyway. In such a case, adjust the auto F value or ISO value on the external flash unit or calculate the distance in the manual mode and use it that way.

5. Use a flash whose illuminating angle covers the angle of view of the lens. However, in close-up photography with the lens on the wide setting, the bottom of the image may not expose correctly. The ideal is to have a wide angle adapter to fit on the flash and spread the illumination angle so it is wider.

6. Use a flash unit with a flash time of 1/200 sec. or less when using the flash at full strength. For devices with a long flash time, a portion of the light emitted will not contribute to the exposure.

7. If a flash unit or other accessory TTL flash that has additional communications functions other than an Olympus FL series flash is used, it may not only fail to function normally, but may also cause damage to the camera’s circuitry. Do not use such a device.
Using the slave flash mode

This setting is for when using a commercially available slave flash that is synchronized with the camera flash. The amount of light emitted by the flash can be adjusted in 10 levels. The flash can fire in sequential shooting mode, but the interval between shots will be longer if a high emission level is set.

AUTO, 
: The setting is automatically changed to (Fill-in flash).
SLOW : The setting is automatically changed to SLOW1.

1 Press while holding down .

2 Select FLASH → SLAVE, and press .

3 Press to select an emission level from 1 to 10, then press .

4 Press repeatedly until the menu disappears.
5 Advanced shooting
Aperture priority shooting

1 Turn the control dial to set the aperture value.

Turn to the left to decrease the aperture value (F number).
Turn to the right to increase the aperture value (F number).

- You can change the adjustment range for the aperture. “EV STEP – Setting exposure adjustment increments” (P.153)
- If the aperture value is displayed in red, the setting is unsuitable for the conditions. Take the following steps. (If the shutter speed is displayed in green, the setting is suitable for the conditions.)

Appears: The image is overexposed.
Turn the control dial to the right to increase the aperture value.

Appears: The image is underexposed.
Turn the control dial to the left to reduce the aperture value.

Aperture range: Toward W: f2.4 to f8.0, Toward T: f3.5 to f8.0

Note
- When the flash is set to the auto-flash mode or the fill-in flash mode, the shutter speed is fixed at 1/30 sec. in the maximum wide angle, or 1/125 sec. in the maximum telephoto angle, and will not go slower.
**Shutter priority shooting**

**Mode dial**

1. **Turn the control dial to set the shutter speed.**

   - Turn to the left to set a slower shutter speed.
   - Turn to the right to set a faster shutter speed.

   • You can change the adjustment range for the shutter speed. [“EV STEP – Setting exposure adjustment increments”](P.153)
   • If the shutter speed is displayed in red, the setting is unsuitable for the conditions. Take the following steps. (If the shutter speed is displayed in green, the setting is suitable for the conditions.)

   ![Shutter speed indication](image)

   - ▲ appears: The image is overexposed. Turn the control dial to the right to set the shutter speed faster.
   - ▼ appears: The image is underexposed. Turn the control dial to the left to set the shutter speed slower.

   Shutter speed range: 15” to 1/4000

---

**TIPS**

**Shutter speed indication**

The actual shutter speed differs from the shutter speed displayed on the monitor. The actual shutter speed range of the camera is 16 to 1/4000 sec., but the speed is displayed in the range of 15” to 1/4000 on the monitor.

---

**Note**

- To avoid camera movement, you are recommended to use a tripod when taking pictures requiring a slow shutter speed.
Advanced shooting

Manual shooting

1. Set the aperture by turning the control dial while holding down [F].
   - You can change the adjustment range for the aperture and the shutter speed. “EV STEP – Setting exposure adjustment increments” (P.153)

Turn to the left to decrease the aperture value (F number).

Turn to the right to increase the aperture value (F number).

Turn the control dial to set the shutter speed.

Turn to the left to set a slower shutter speed.

Turn to the right to set a faster shutter speed.

- When the shutter button is halfway pressed, the difference (ranging from –3.0 to +3.0 EV) between the two exposures is displayed. One is the exposure determined by the currently selected aperture and shutter speed, and the other is the exposure level considered optimal by the camera.
- If the exposure differential appears in red in the viewfinder or on the monitor, it indicates that the exposure differential is less than –3.0 EV or more than +3.0 EV.
- When you press the AEL (AE Lock) button, the screen on the right appears with the bar indicating the current exposure differential.

Aperture value : f2.4 to f8.0
Shutter speed : 15” to 1/4000

TIPS

To take long exposure (bulb) shots
1. Turn the control dial to the left to set the shutter speed to BULB.
2. The shutter remains open as long as the shutter button is held down.
   - The maximum bulb length is 8 minutes.
   - Using the remote control prevents camera from shaking due to pressing the shutter by finger.
   - You can connect a remote cable (sold separately) with the power battery holder (also sold separately).

Note

• To avoid camera movement, you are recommended to use a tripod when taking pictures requiring a slow shutter speed.
Using My Mode

When you use \textit{Adv} mode, the settings you selected with the menus in My Mode are activated.

Saving the shooting mode or function settings you want to use in advance lets you shoot with your favorite settings straightaway. By setting the mode dial to \textit{Adv}, you can select whether to use one of the 8 customized My Mode settings that you have saved.

1. In the top menu, select MODE MENU $\Rightarrow$ CAMERA $\Rightarrow$ MY MODE $\Rightarrow$ MY MODE 1 to MY MODE 8, and press $\textcircled{2}$.
   - Press $\textcircled{2}$ again to exit the menu.
   - Only the settings in MY MODE 1 have already been saved. You cannot select MY MODE 2 to MY MODE 8 if no settings have been saved in them.

   “Menu basics” (P.38)
   “MY MODE SETUP – Setting a function in My Mode” (P.160)
Focusing applications

AF MODE - Changing the focus range

This function allows you to select the focus range of your subject.

iESP
Even when the subject is not in the center of the screen, focusing is possible. The AF target mark moves to the focus position.

SPOT
Focus selection is based on the subject within the AF target mark.

1 Press \( \text{AF/Macro/MF} \) button while holding down AF/\( \text{MF} \).
   - In MF or \( \text{MF} \) mode, the menu is not displayed when \( \text{AF/Macro/MF} \) button is pressed.

2 Press \( \text{Mode dial} \) to select AF MODE, then press \( \text{OK button} \).

3 Press \( \text{Arrow pad} \) to select iESP or SPOT, then press \( \text{OK button} \).
   - Press \( \text{Arrow pad} \) again to exit the menu.

- In \( \text{Mode dial} \) mode, the AF MODE is fixed to iESP. The setting cannot be changed.

Note
FULLTIME AF - A reliable time-saving way to focus

Focusing is performed repeatedly without having to press the shutter button halfway. When ON is selected, the focusing time is reduced, letting you take successive snapshots.

1. Press \( \text{on} \) while holding down AF/\( \text{mf} \)/MF.
   - In MF or \( \text{mf} \) mode, the menu is not displayed when \( \text{on} \) is pressed.

2. Press \( \text{on} \) to select FULLTIME AF, then press \( \text{on} \).

3. Press \( \text{on} \) to select ON or OFF, then press \( \text{on} \).
   - Press \( \text{on} \) again to exit the menu.

• In \( \text{on} \) mode, FULLTIME AF does not operate when \( \text{on} \) (movie) is set to ON.
• Battery consumption increases when FULLTIME AF is used.

Note
### P-AF – Changing the auto focus mode

For auto focusing, this camera is equipped with a contrast detection system measured by CCD and a phase difference detection system measured by AF sensor. You can select whether to use only the contrast detection system or to use the contrast detection system in conjunction with the phase difference detection system.

**OFF**  The camera focuses on the subject using only the contrast detection system.

**ON**  The camera focuses on the subject using both the contrast detection system and the phase difference detection system. Focusing is performed faster than when OFF is selected.

1. **Press** while holding down AF/MF.
   - In MF or **MF** mode, the menu is not displayed when < is pressed.

2. **Press** to select P-AF, then press <.

3. **Press** to select ON or OFF, then press <.
   - Press < again to exit the menu.

   ![Mode dial]

   ![AF sensor]

**Note**

- When the subject is within 80 cm (2.6 ft.) of the camera, the camera focuses using only the contrast detection system.
- Focusing may take some time if P-AF is set to ON when a conversion lens or underwater housing is attached to the camera.
- In mode, P-AF is fixed to OFF. The setting cannot be changed.
- When the position of the AF target mark has been moved, P-AF is automatically set to OFF.
- “Changing the position of the AF target mark” (P.77)
Changing the position of the AF target mark

This function lets you select the area you want to focus on by changing the position of the AF target mark.

1. Set the AF mode to SPOT.
   - “AF MODE - Changing the focus range” (P.74)

2. Hold down AF/MF and use the arrow pad to move the AF target mark to the area you want to focus on.
   - In MF or MF mode, the AF target mark does not move when the arrow pad is pressed.

3. Take the picture.
   - To restore the AF target mark to its original position (in the center), press while holding down AF/MF on the right screen.

Note
- Turning the camera off or changing the shooting mode will return the AF target to the center position.
- The AF target mark cannot be moved when the digital zoom is on.
AF illuminator

The AF illuminator allows the auto focus to focus on dark subjects. When the shutter button is pressed halfway, the AF illuminator fires automatically, lighting up the subject. Factory default setting is ON. To turn the AF illuminator off, follow the procedure below.

1. Select SETUP → AF ILLUMINATOR → OFF, and press  

Note

• Even when the AF illuminator is lit, the auto focus may still not be able to focus properly on subjects within 80 cm (2.6 ft.) of the camera.
Manual focus

If auto focus is unable to focus on a subject, use manual focus.

1. **Turn the control dial while holding down **AF//MF** and select MF.**

   • When you release your finger from the **AF//MF** button, the distance indicator is displayed on the monitor.

2. **Press  to set the focus.**
   • During operation, the area in the middle is enlarged. This lets you check whether the focus is correct.
   • The distance indicator on the left of the monitor is for reference only.
   • When the indicator is moved to less than 0.8 m (2.6 ft.), the display automatically switches to the 20 cm (8”) to 80 cm (2.6 ft.) display.

3. **Take the picture.**
   • The focus is locked at the distance you have set.
TIPS

How to shoot while keeping the same focus distance
→ Decide the focus in Step 2, then press 📷. The focus is locked and MF appears in red on the monitor.

To fix the focus at the same distance as the focus lock position
1 Position the AF target mark on a subject at the desired distance and press the shutter button halfway.
2 Keeping the shutter button half-pressed, press AF/MF.
   • The distance indicator is displayed.
   • MF is selected and the focus is locked at the same distance as when you performed focus lock.
   • Set to AF to return to auto focus.

Even if you move the cursor to the top of the distance indicator, focusing is not possible at ∞.
→ Adjust the cursor position by pressing 📷 📷.

How to take pictures very close to the subject
→ In super macro MF mode, pictures as close as 5cm from the subject can be taken with manual focus. Turn the control dial while holding down AF/MF and select % MF. “Super macro shooting” (P.88)

Note
• When the digital zoom is set to ×2.5 or more, the area you are focusing on is not enlarged.
• If the zoom lever is pressed after performing manual focus, the saved focus distance may be changed. Perform setting again.
There are four ways of measuring the brightness of a subject. Select the way best suited to your purpose.

**Digital ESP metering**  Meters the center of the subject and the surrounding area separately.

**Spot metering (ESP)**  Exposure is determined by metering within the metering target area. In this mode, a subject can be shot with optimal exposure regardless of the background light. P.81

**Multi-metering (MULTI)**  Meters the brightness of the subject at up to 8 different points to set the optimal exposure based on the average brightness. This method is useful with a high contrast subject. P.83

**Center-weighted metering (C)**  Meters the brightness over a wide area with emphasis on the center of the screen. This method is used when you do not want to let the brightness of the surrounding area affect the picture. P.81

---

**Spot metering / Center-weighted metering – Selecting the metering area**

1. Turn the control dial while holding down and select or .
Changing the position of the metering target mark

When the metering mode is set to SPOT, you can select the metering area by moving the position of the target mark.

1. Turn the control dial while holding down the metering button to select SPOT.

2. Hold down the metering button and use the arrow pad to move the metering target mark to the area you want to meter.

3. Take the picture.
   - To restore the metering target mark to its original position (in the center), press the metering button while holding down the metering button in Step 2.

Note:
- Turning the camera off or changing the shooting mode will return the metering target to the center position.
Multi-metering
– Metering the exposure at more than one point  MULTI

1 Turn the control dial while holding down and select MULTI.

2 Position the AF target mark on the area you want to meter and press the AEL (AE Lock) button. The brightness is metered at up to 8 different points.
   • The multi-metering bar appears.
   • Additional metering is ignored after the 8th reading.
   • To perform metering again, press the AEL button for more than 1 second to display MEMO. Press the AEL button again to cancel the metering values.
Ex: When metering 2 points (pressing the AEL button twice)  
The aperture and shutter speed as calculated from the average values obtained by  
metering at 2 points. These values are recalculated every time another metering point  
is added.

The average for the 2  
metering points.  
The average is always  
shown at the center of the bar.

The reading when the AEL button was pressed. The number of \( \Diamond \) indicates the  
number of times you have pressed the  
button. The distance \( \Diamond \) is from the center  
of the bar indicates the difference between  
the metered and average readings.

When \( \Diamond \) moves more than ±3 from the center of the bar (the average reading), red \( \langle \rangle \) appear.

**TIPS**  
To save the locked multi-metering exposure after shooting (AE memory)  
→ After metering in Step 2, hold down the AEL button for more than 1 second.  
\( \text{MEMO} \) appears. While \( \text{MEMO} \) is displayed, the exposure is saved. Press the  
AEL button again to cancel the AE memory.

The multi-metering exposure is canceled.  
→ If you operate any of the buttons or the mode dial after metering in Step 2,  
the multi-metering exposure is canceled.
AE Lock - Locking the exposure

This function is suitable for situations when optimal exposure is difficult to achieve, such as when there is excessive contrast between the subject and the surroundings. For example, when the sky takes up much of the frame, shooting with automatic exposure sometimes results in a dark subject. Recompose your shot so that not much sky is in the frame, and then press the AEL button to lock the metered value (exposure) temporarily. Next, compose your shot again with the sky in the frame and take the picture.

1. Compose the picture where you want to lock the metered value (exposure), then press the AEL button.
   - The metered value is saved.
   - If you want to lock a different exposure, press the AEL button again to cancel AE lock. Each time you press the AEL button, AE lock is engaged and canceled repeatedly.

2. Position the AF target mark on the subject you want to focus on and press the shutter button halfway.
   - The green lamp lights.

3. Press the shutter button fully.
   - AE lock is automatically canceled after one shot.
**TIPS**

To save the locked multi-metering exposure after shooting (AE memory)

→ After setting AE lock in Step 1, or after pressing the shutter button halfway in Step 2, hold down the AEL button for more than 1 second. \[\text{MEMO}\] appears. While \[\text{MEMO}\] is displayed, the exposure is saved. Press the AEL button again to cancel the AE memory.

**AE lock was canceled.**

→ Do not operate any of the buttons or the mode dial after performing AE lock. Doing so will cancel AE lock.

→ The camera had emerged from sleep mode or the power was turned off.

---

**Note**

- AE lock is not available when multi-metering is enabled. Set the metering method to ESP, \[\text{ESP}\] or \[\text{ESP}\]. [“Metering” (P.81)]
- AE lock is not available when a menu is displayed on the screen. [“Menu basics” (P.38)]
- AE lock is not available when the control panel is displayed on the screen. [“CONTROL PANEL – Using the monitor as a control panel” (P.163)]
Macro mode shooting

Focusing is usually slow when you get close to a subject (20 cm to 80 cm (0.7 ft. to 2.6 ft.)). However, in the mode focusing is performed quickly.

1. Turn the control dial while holding down AF/MF and select .

Note
- If you use the flash in macro shooting, shadows may be noticeable and the correct exposure may not be achieved.
Super macro shooting

In super macro mode, pictures can be taken as close as 5cm (2.0") from the subject. Subjects measuring up to approximately 4.8 cm × 3.6 cm (1.9" × 1.4") can be captured on the monitor.
In the mode, normal shooting is also possible, but the zoom cannot be used.

1 Turn the control dial while holding down AF/MF and select .

- Super macro MF

When taking pictures close to the subject, shadows may become noticeable, and the auto focus may not be able to maintain correct focus. Set the camera to super macro MF and use manual focus.

1 Turn the control dial while holding down AF/MF and select .

2 When you release your finger from the AF/MF button, the distance indicator is displayed on the monitor.
   - During operation, the area in the middle is enlarged. This lets you check whether the focus is correct.

3 Press to adjust the focus.
   - Pressing locks the focus position and appears in red on the monitor.

Note
- During super macro shooting, the built-in flash is not available. You can use an external flash, but vignetting may occur. Display the recorded image on the monitor to check it.
This function lets you take pictures using the self-timer. Fix the camera securely on a tripod for self-timer shooting. This function is useful for taking pictures where you want to be included in the photograph.

1. Turn the control dial while holding down \( \text{B} \) and select \( \text{Y} \).

2. Press the shutter button fully to start self-timer shooting.
   - Pressing the shutter button halfway locks the focus and exposure.
   - The self-timer/remote control lamp lights for approximately 10 seconds, then starts blinking. After blinking for approximately 2 seconds, the picture is taken.
   - To stop shooting while in \( \text{OFF} \) mode, press the shutter button fully again.
   - To cancel the self-timer, press \( \text{C} \).
   - The self-timer mode is automatically canceled after one shot.

Note
- If self-timer shooting is attempted in sequential shooting mode, the camera shoots 5 frames at most, regardless of the setting.
Remote control shooting

Shooting is possible using the remote control device provided with the camera. This is useful when you want to take a picture of yourself in it, or a night scene, without touching the camera.

1 Mount the camera on a tripod or place it on a stable, flat surface.

2 Turn the control dial while holding down \( B \) and select \( \bullet \).

3 Point the remote control device at the remote control receiver on the camera.

4 Press the shutter button on the remote control device.
   - The focus and exposure are locked and the self-timer/remote control lamp blinks before taking the picture.
   - You can set the time until the picture is taken. \( \text{Changing the time until remote control is activated} \) (P.91)
   - To shoot in bulb mode, press and hold down the shutter button on the remote control device. \( \text{Manual shooting} \) (P.72)
TIPS

The self-timer/remote control lamp does not blink after pressing the shutter button on the remote control device.
→ The remote control device may be too far from the camera. Move closer to the camera and press the shutter button on the remote control device again.
→ The battery in the remote control device is running low. Replace with a new battery. “How to replace the battery (CR2025) of the remote control device” (P.220)

How to cancel the remote control mode.
→ The remote control mode is not canceled automatically after shooting. Perform Step 2 and set the mode to OFF.

![Note icon]

• If the remote control receiver is exposed to strong light, the effective signal distance may be reduced or shooting may not take place.
• To shoot sequential shots using the remote control device, press and hold the shutter button on the remote control device. If the camera does not receive the remote control signal properly, sequential shooting may stop.

Changing the time until remote control is activated

You can select the time from when the shutter button on the remote control device is pressed until the picture is taken.

AUTO  The picture is taken immediately the shutter button on the remote control device is pressed.
3 SEC  The picture is taken approximately 3 seconds after the shutter button on the remote control device is pressed.

1 Press \( \textcircled{\text{S}} \) while holding down \( \textcircled{\text{S}} / \textcircled{\text{R}} \).
   • In \( \textcircled{\text{S}} \) mode, the menu is not displayed when \( \textcircled{\text{S}} \) is pressed.

2 Press \( \textcircled{\text{S}} \) to select AUTO or 3 SEC, then press \( \textcircled{\text{R}} \).
Sequential shooting

There are 4 sequential shooting modes: high speed sequential shooting, sequential shooting, AF sequential shooting and auto bracketing. Except for auto bracketing, the exposure and white balance are locked at the first frame. Sequential shooting cannot be performed when the record mode is set to TIFF.

Sequential shooting mode

- ****: Shoots one frame at a time when the shutter button is pressed. (Normal shooting mode, single-frame shooting)
- **HI**: Pictures can be taken at a faster speed than normal sequential shooting. Approx. 5 frames at 1.6 frames/sec. The focus is locked at the first frame. The sequential shooting speed varies depending on the record mode setting. Approx. 17 frames (in HQ mode) can be taken in sequence.
- **AF**: Adjusts the focus 1 frame at a time. The AF sequential shooting speed is slower than normal sequential shooting.
- **BKT**: “Auto bracketing” (P.93)

High speed, sequential and AF sequential shooting

1. In the top menu, select MODE MENU ➔ CAMERA ➔ HI, or AF, and press OK.
2. Take the picture.
   - The camera will take pictures in sequence until you stop holding down the button.
Auto bracketing

Under some conditions, you may obtain better results shooting with exposure compensation than by using the exposure setting considered optimal by the camera.

When auto bracketing is set, the exposure is changed automatically for each frame while the shutter button is pressed. The exposure differential and number of frames can be selected in the menus. The focus and white balance are locked at the first frame.

Ex : When BKT is set to ±1.0 ×3

1 In the top menu, select MODE MENU → CAMERA → BKT, and press 

"Menu basics" (P.38)

2 Select the exposure. Press to select ±0.3, ±0.7 or ±1.0, then press .

- When the exposure adjustment is set to 1/2 EV steps, select from ±0.5 and ±1.0.

“EV STEP – Setting exposure adjustment increments” (P.153)

3 Select the number of pictures. Press to select ×3 or ×5, then press .

- In some combinations of picture size and record mode, only ×3 is available.

- Press repeatedly until the menu disappears.

4 Take the picture.

- Press the shutter button fully and keep it pressed to shoot the preset number of pictures. You can stop shooting at any time to stop holding down the shutter button.
Sequential shooting

- Sequential shooting (HI, AF, BKT) is not possible in the following situations:
  - When the record mode is set to TIFF
  - When NOISE REDUCTION is set to ON
- and AF are not available when the record mode is set to RAW.
- In sequential shooting mode (HI, AF, BKT), the built-in flash does not fire. The external flash does not fire in BKT mode.
- Auto bracket shooting is not available in M mode.
- Since the shutter speed is set to 1/30 sec. max. except in S and M mode, exposure is decreased when shooting a dark subject to prevent camera movement.
- For auto bracketing in modes other than S mode, shooting is automatically set to 1/30 sec. if the shutter speed was other than 1/30 sec. for an exposure differential of 0.
- If the battery power is low and the battery check blinks during sequential shooting, shooting stops and the camera starts saving the pictures you have taken. Whether or not all of the shots are saved depends on how much battery power remains.
- In Auto bracket shooting, if available space on the card does not exceed the number of set pictures, the next picture may not be taken.
Panorama shooting

You can take advantage of PANORAMA shooting with the Olympus xD-Picture Card. PANORAMA shooting lets you connect pictures with overlapping edges into a single panoramic picture, using the CAMEDIA Master software.

1 In the top menu, select MODE MENU → CAMERA → FUNCTION → PANORAMA, and press .

“Menu basics” (P.38)

• The PANORAMA mode is set.

2 Use the arrow pad to choose the direction in which you want the pictures connected.

: Connects the pictures from left to right.
: Connects the pictures from right to left.
: Connects the pictures from bottom to top.
: Connects the pictures from top to bottom.

3 Take pictures so that the edges overlap.

• Focus, exposure and white balance are set by the first picture. Do not select an extremely bright subject (such as the sun) for the first picture.
• You cannot adjust the zoom after the first picture.
• Panorama shooting is possible for up to 10 pictures.

Keeping the area in the frame at the edge of the screen in mind, position the camera so that the same area appears in the frame for the next picture. Compose the picture so that the section that appeared at the right edge of the previous picture (or the left edge if you are connecting pictures from right to left) appears at the left edge of the next picture (or the right edge if you are connecting pictures from right to left).
Panorama shooting

• When you have taken 10 pictures, a warning mark appears.

4 Press 📸 to exit PANORAMA shooting.
• The frame on the screen disappears and the camera returns to the normal shooting mode.

Note
• The PANORAMA mode is only available with Olympus CAMEDIA-brand cards.
• During PANORAMA shooting, the flash, sequential shooting (Hi, i, j, AF, k, BKT) and program shift modes are not available.
• Images are saved in JPEG format when PANORAMA shooting is performed in the TIFF mode. The size of the image does not change.
• PANORAMA shooting is not available when the record mode is set to RAW.
• If the mode dial is operated during PANORAMA shooting, the camera cancels the PANORAMA mode and returns to normal shooting.
• The camera itself cannot connect panorama pictures. The CAMEDIA Master software is necessary to connect the pictures.
Guideline shooting

This function displays a silhouette of guideline on the monitor to help you compose your pictures. Select the type of guideline best suited to your purpose.

1 In the top menu, select MODE MENU → CAMERA → FUNCTION → , and press .
   “Menu basics” (P.38)

2 Press to select the guidelines, then take the picture.

3 Press to exit guideline shooting.
   • The guidelines on the screen disappear and the camera returns to the normal shooting mode.

TIPS

• You can display the guidelines in the playback mode too.
   “Displaying guidelines” (P.136)

• The guidelines do not appear on the resulting picture.

Note
Shooting in black & white or sepia-tone

This setting lets you add special effects to pictures.

1. In the top menu, select MODE MENU → CAMERA → FUNCTION → BLACK & WHITE or SEPIA, and press .

• Press again to exit the menu.

• White balance, white balance compensation, hue and saturation cannot be used in black & white or sepia shooting.

Note
FRAME ASSIST – Displaying vertical and horizontal lines to aid composition

This setting displays a vertical and horizontal lines on the monitor to help you compose your pictures.

1. In the top menu, select MODE MENU → CAMERA → FRAME ASSIST → ON or OFF, and press ⑥.
   - Press ⑥ again to exit the menu. The vertical and horizontal lines are displayed on the monitor.

Note
- The frame is not displayed in the following cases.
  During panorama or guideline shooting
Recording sound with still pictures

This function lets you record sound when taking a still picture. Recording starts about 0.5 seconds after the shutter is released and lasts about 4 seconds. When this function is enabled, sound is recorded automatically every time you take a picture.

1 In the top menu, select MODE MENU → CAMERA → (for still pictures) → ON, and press .
   • Press again to exit the menu.

2 When recording starts, turn the camera microphone towards the source of the sound you want to record.
   • The BUSY bar is displayed during recording.

**TIPS**

- appears on the monitor during playback of still pictures and movies with sound. During playback, sound is output from the speaker. The volume can be adjusted. “VOLUME – Adjusting the playback volume” (P.165)
- Sound can be added later to still pictures. Recorded sound can also be changed. “Recording sound” (P.137)

! **Note**

- If the camera is more than 1 m (3.3 ft.) away from the source of the sound, sound may not be recorded clearly.
- It is not possible to take another picture during sound recording.
- Sound recording is not possible in the following cases:
  - When the record mode is set to TIFF, during sequential shooting (HI, , AF, BKT) or panorama shooting
  - Sound recording may also pick up camera noises, such as button operations, shutter movement, etc.
  - Sound recording may not be possible if there is insufficient space in the card memory.
Recording sound with movies

Sound can be recorded while shooting a movie.

1. In the top menu, press \( \textcircled{\text{a}} \) to select \( \textcircled{\text{a}} \) (movie).

2. Press \( \textcircled{\text{a}} \) \( \textcircled{\text{a}} \) to select ON, then press \( \textcircled{\text{GO}} \).

3. Recording starts at the same time as shooting.

Note
- When \( \textcircled{\text{a}} \) is set to ON, the focus and optical zoom are locked during movie recording. If \( \textcircled{\text{a}} \) is set to OFF, you can use both the optical zoom and digital zoom during movie recording.
- If the camera is more than 1 m (3.3 ft.) away from the source of the sound, sound may not be recorded clearly.
You can select a record mode in which to take pictures or shoot movies. Choose the best record mode for your purpose (printing, editing on a PC, website editing, etc.). For resolutions and file sizes in the different record modes, refer to the table on P.104.

### Normal image mode

<table>
<thead>
<tr>
<th>Application</th>
<th>Resolution</th>
<th>Compression</th>
<th>Uncompressed</th>
<th>Low compression</th>
<th>High compression</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select for the print size</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3264 × 2448</td>
<td></td>
<td>Uncompressed</td>
<td>SHQ</td>
<td>HQ</td>
<td></td>
</tr>
<tr>
<td>2592 × 1944</td>
<td></td>
<td>Low compression</td>
<td>SQ1 HIGH</td>
<td>SQ1 NORMAL</td>
<td></td>
</tr>
<tr>
<td>2288 × 1712</td>
<td></td>
<td>High compression</td>
<td>HQ</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2048 × 1536</td>
<td></td>
<td>TIFF</td>
<td>SQ2 HIGH</td>
<td>SQ2 NORMAL</td>
<td></td>
</tr>
<tr>
<td>1600 × 1200</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1280 × 960</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1024 × 768</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>For small sized prints and website</td>
<td>640 × 480</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Resolution**

The number of pixels (horizontal × vertical) used when saving an image. If the image will be printed, higher resolutions (larger numbers) are recommended so that the image will be clearer. However, higher resolutions make the file size (amount of data) larger, so the number of pictures that can be saved will be fewer.

**Compression**

In record modes other than TIFF, image data are compressed. The higher the compression, the less clear the image will be.

**Resolution and picture size on a computer screen**

When a picture is transferred to a computer, the size of the picture on the computer screen varies depending on the computer’s monitor setting. For instance, a picture taken in 1024 × 768 resolution is the same size as the screen if you set the picture to 1× when the monitor setting is 1024 × 768. However, if the monitor setting is over 1024 × 768 (such as 1280 × 1024), the picture only takes up part of the screen.
Special image mode

<table>
<thead>
<tr>
<th>Record mode</th>
<th>Features</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAW</td>
<td>As the name suggests, the data is “raw”, not having been subjected to image processing.</td>
<td>3264 × 2448</td>
</tr>
<tr>
<td>3:2 (TIFF, SHQ, HQ)</td>
<td>This mode is useful when having prints made at a photo lab.</td>
<td>3264 × 2176</td>
</tr>
</tbody>
</table>

RAW Data

As its name suggests, RAW data is unprocessed image data in its original state to which white balance, sharpness, contrast, color conversion and other processes have not been applied on your PC. CAMEDIA Master software is required to display RAW data on your PC as images. Plug-in software for playback by Photoshop can also be used. (Available for download from the Olympus home page.) You cannot display RAW data using ordinary software or make print reservations.

Pictures taken in the RAW data format can be edited on this camera.

“RAW editing” (P.140)

3:2 Resolution

The image aspect ratio is normally 4:3. If the aspect ratio is changed to 3:2, the image can be printed at a photo lab without losing the image borders. 3:2 is not available in mode.

Check the shooting range on the monitor before taking the picture.
Record modes and the number of storable still pictures

The number of storable still pictures can be estimated by dividing the capacity of the card by the file size. When a card is inserted in the camera, it is displayed in the viewfinder or on the monitor. The file size and the remaining recording time in the following table are the estimated numerical value.

### Still Picture Record Modes

<table>
<thead>
<tr>
<th>Record mode</th>
<th>Resolution</th>
<th>Compression</th>
<th>File format</th>
<th>File size (MB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAW</td>
<td>3264 × 2448</td>
<td>Uncompressed</td>
<td>ORF</td>
<td>11.5</td>
</tr>
<tr>
<td></td>
<td>3264 × 2448</td>
<td></td>
<td></td>
<td>11.4</td>
</tr>
<tr>
<td>TIFF</td>
<td>3264 × 2176</td>
<td>Uncompressed</td>
<td>TIFF</td>
<td>22.9</td>
</tr>
<tr>
<td></td>
<td>2592 × 1944</td>
<td></td>
<td></td>
<td>20.3</td>
</tr>
<tr>
<td></td>
<td>2288 × 1712</td>
<td></td>
<td></td>
<td>14.4</td>
</tr>
<tr>
<td></td>
<td>2048 × 1536</td>
<td></td>
<td></td>
<td>11.2</td>
</tr>
<tr>
<td></td>
<td>1600 × 1200</td>
<td></td>
<td></td>
<td>9.0</td>
</tr>
<tr>
<td></td>
<td>1280 × 960</td>
<td></td>
<td></td>
<td>5.5</td>
</tr>
<tr>
<td></td>
<td>1024 × 768</td>
<td></td>
<td></td>
<td>3.5</td>
</tr>
<tr>
<td></td>
<td>640 × 480</td>
<td></td>
<td></td>
<td>2.3</td>
</tr>
<tr>
<td>SHQ</td>
<td>3264 × 2448</td>
<td>Low compression</td>
<td>JPEG</td>
<td>3.9</td>
</tr>
<tr>
<td>HQ</td>
<td>3264 × 2448</td>
<td>High compression</td>
<td>JPEG</td>
<td>2.0</td>
</tr>
<tr>
<td>SQ1</td>
<td>2592 × 1944</td>
<td>HIGH</td>
<td>JPEG</td>
<td>3.6</td>
</tr>
<tr>
<td></td>
<td>2288 × 1712</td>
<td>NORMAL</td>
<td></td>
<td>1.2</td>
</tr>
<tr>
<td></td>
<td>2048 × 1536</td>
<td>HIGH</td>
<td>JPEG</td>
<td>2.8</td>
</tr>
<tr>
<td></td>
<td>1600 × 1200</td>
<td>NORMAL</td>
<td></td>
<td>1.0</td>
</tr>
<tr>
<td></td>
<td>1280 × 960</td>
<td>HIGH</td>
<td>JPEG</td>
<td>2.3</td>
</tr>
<tr>
<td></td>
<td>1024 × 768</td>
<td>NORMAL</td>
<td></td>
<td>0.8</td>
</tr>
<tr>
<td>SQ2</td>
<td>640 × 480</td>
<td>HIGH</td>
<td>JPEG</td>
<td>0.1</td>
</tr>
</tbody>
</table>

*HIGH uses low compression/NORMAL uses high compression

### Movie Record Modes

<table>
<thead>
<tr>
<th>Record mode</th>
<th>Resolution</th>
<th>Remaining recording time (sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>32MB</td>
</tr>
<tr>
<td>SHQ</td>
<td>640 × 480 (15 frames/sec.)</td>
<td>34 With sound 35 Without sound</td>
</tr>
<tr>
<td>HQ</td>
<td>320 × 240 (15 frames/sec.)</td>
<td>93 With sound 96 Without sound</td>
</tr>
<tr>
<td>SQ</td>
<td>160 × 120 (15 frames/sec.)</td>
<td>374 With sound 424 Without sound</td>
</tr>
</tbody>
</table>
Selecting a record mode

1. Turn the control dial while holding down the record mode button to select the record mode.
   - The record mode changes in the sequence shown below.

   **Still Picture Record Modes**
   - RAW ➔ TIFF ➔ SHQ
   - SQ2 ➔ SQ1 ➔ HQ

   **Movie Record Modes**
   - SHQ ➔ HQ ➔ SQ

2. If you selected a still picture record mode, press the OK button while holding down the record mode button to display the screen for selecting the resolution.

3. If you selected TIFF, SHQ or HQ, press the arrow pad to select a resolution, then press the OK button. If you selected SQ1 or SQ2, press the arrow pad to select a resolution, then press the OK button. Press the arrow pad to select HIGH or NORMAL, then press the OK button.
● JPEG duplicate setting

Pictures taken in the RAW data format can be stored in JPEG format at the same time as they are recorded in RAW data. To record pictures in JPEG format you can select SHQ, HQ, SQ1 or SQ2 for the record mode, but you cannot select a resolution. Pictures are recorded in the resolution currently set for each record mode.

1. Turn the control dial while holding down ☐- to select RAW.

2. While holding down ☐-, press ☁. 

3. Press ☐ ☐ to select OFF, SHQ, HQ, SQ1 or SQ2, then press ☁.
ISO – Set-up appropriate sensitivity

The higher the ISO settings, the greater the camera’s light sensitivity and the better its ability to shoot in low light conditions. However, higher values also introduce noise into the resulting image, which may give them a grainy appearance.

**AUTO**  Sensitivity is automatically adjusted according to the light conditions and the subject brightness.

**50 to 400**  With a lower ISO setting, you can shoot clear, sharp images in daylight. With a higher ISO setting, you can use faster shutter speeds with the same amount of light. The available ISO settings vary depending on the EV step setting. [“EV STEP – Setting exposure adjustment increments” (P.153)]

1. In the top menu, select **MODE MENU** → **CAMERA** → **ISO** and press the **OK button**.

   - If ISO is displayed on the top menu as a shortcut menu, press the arrow pad in the same direction as the arrow shown next to ISO.

   [“SHORT CUT” (P.157)]

2. Press the **OK button** to choose the most suitable ISO value, then press the **OK button**.

   - AUTO is not available in **A**, **S** or **M** mode.
   - Press the **OK button** again to exit the menu.

---

**Note**

- Higher ISO settings produce more electrical noise.
- When ISO sensitivity is set to AUTO and you are shooting in dark conditions without a flash, the sensitivity automatically increases, otherwise the shutter speed will be reduced, possibly resulting in camera movement and blurred images.
- If the subject is too far away for the flash illumination to reach when ISO sensitivity is set to AUTO, the sensitivity is automatically increased.
- When using slow synchronization in the **P**, **A** or **S** mode, the slowest available shutter speed varies depending on the ISO setting.
Exposure compensation

In some situations, you may get better results when the exposure that the camera sets is compensated (adjusted) manually. You can adjust the exposure by selecting the exposure compensation value. After adjusting the exposure, you can check the picture in the viewfinder or on the monitor.

1. **Turn the control dial while holding down F.**
   - Adjust toward +: Turn to the right to adjust up to +2.0.
   - Adjust toward –: Turn to the left to adjust up to –2.0.
   - The exposure compensation can be set in 1/3EV steps or 1/2EV steps. “EV STEP – Setting exposure adjustment increments” (P.153)

   ![Exposure compensation buttons and dials](image)

   ![Exposure compensation settings](image)

   ![TIPS](image)

   - Often bright subjects (such as snow) will turn out darker than their natural colors. Adjusting toward + makes these subjects closer to their real shades. For the same reason, adjust toward – when shooting dark subjects.
   - Pressing F when histogram is set to F ON displays the histogram in the viewfinder or on the monitor.
   - If you press F while pressing F, the menu for changing the histogram setting is displayed. “Histogram – Displaying the luminance distribution of still pictures” (P.119)
   - You can change the position of the histogram target mark. “Changing the position of the histogram target mark” (P.120)

   ![Note](image)

   - You can set the aperture by turning the control dial while holding down F in M mode. “Manual shooting” (P.72)
   - If the flash is used, the image brightness (exposure) may differ from the intended brightness.
   - Exposure compensation cannot correct the image if the surroundings of the subject are extremely bright or dark.
Color reproduction differs depending on the light conditions. For instance, when daylight, the setting sun or tungsten lighting are reflected on white paper, the shade of white produced will be slightly different for each. By setting the WB (white balance), you can achieve more natural-looking colors.

1. Turn the control dial while holding down WB, then select the best white balance (AUTO, PRESET1, PRESET2, CUSTOM, 𝑉) for the shooting conditions.

2. If you selected PRESET1, PRESET2, CUSTOM or 𝑉, press (2) while holding down WB to display the next selection screen.
   - PRESET1  “Preset1 white balance” (P.110)
   - PRESET2  “Preset2 white balance” (P.110)
   - CUSTOM  “Custom white balance” (P.111)
   - 𝑉  “One-touch white balance” (P.111)

Auto white balance

Automatically adjusts the white balance for any light source.
- Press (2) while holding down WB to display the menu for adjusting and storing the auto white balance.
  - “White balance compensation” (P.112)
  - “Saving a custom white balance” (P.113)
Preset1 white balance

Select a white balance setting according to the type of light when shooting outdoors.

1 Press \( \text{PRESET1} \) to select PRESET1, then press \( \circ \).

2 Press \( \text{PRESET1} \) to select \( \text{\#1, \#2, \#3, \#4} \), then press \( \circ \).
   - Press \( \circ \) again to exit the menu.

- For shooting in the shade
- For shooting on a cloudy day
- For shooting on a sunny day
- For shooting in evening sunlight

Preset2 white balance

Select a white balance setting according to the type of light when shooting indoors.

1 Press \( \text{PRESET2} \) to select PRESET2, then press \( \circ \).

2 Press \( \text{PRESET2} \) to select \( \text{\#1, \#2, \#3, \#4, \#5} \), depending on the type of light, then press \( \circ \).
   - Press \( \circ \) again to exit the menu.

- For shooting under a daylight fluorescent lamp (6,700K)*. This type of lamp is used mainly in homes.
- For shooting under a neutral white fluorescent lamp (5,000K)*. This type of lamp is generally used in desk lamps, etc.
- For shooting under a cool white fluorescent lamp (4,200K)*. This type of lamp is generally used in offices, etc.
- For shooting under a white fluorescent lamp (3,500K)*.
- For shooting under a tungsten light (3,000K)*.

* The color temperature values (K) are approximate. They are not an accurate indication of color.
Custom white balance

Storing the white balance and white balance compensation settings lets you reactivate the settings for use later on. “Saving a custom white balance” (P.113)

1. Press \( \text{CUSTOM WB} \) to select CUSTOM 1, CUSTOM 2, CUSTOM 3 or CUSTOM 4, then press \( \text{GO} \).
   - Press \( \text{CANCEL} \) again to exit the menu.
   - Custom1 is set to sunny day light condition.
   - If no custom white balance has been saved, this item cannot be selected.

One-touch white balance

This function is useful when you need more precise white balance than PRESET WB can provide. To set the optimum white balance for the shooting conditions, point the camera at a white object under the light source you want to use and adjust the white balance.

1. Press \( \text{GO} \) to select GO, then press \( \text{GO} \).

2. Display the \( \text{WB} \) screen and point the camera at a sheet of white paper.
   - Position the paper so that it fills the screen, making sure there are no shadows.

3. Press \( \text{GO} \).
   - The new white balance is set.
White balance

- When setting the white balance by pointing the camera at a sheet of white paper, the correct setting may not be obtained if the light reflected by the paper is too bright or too dark.
- White balance may not be effective under some special light sources.
- After setting a white balance other than AUTO, play back the picture and check the colors on the monitor.
- When the flash is fired with a white balance setting other than AUTO, colors may appear different in the resulting picture from the colors you see on the monitor.

White balance compensation

This function lets you make fine changes to the AUTO, PRESET 1, PRESET 2 and one-touch white balance settings.

1. Follow the procedure on P.109 - P.111 to select the white balance you want to adjust.

2. Press \( \text{WB} \) while holding down WB.

3. Press \( \text{WB} \) to select \( \text{WB}^+ \), then press \( \text{SET} \).

4. The color becomes bluer each time you press \( \text{\textup{\textbullet\textbullet}} \), and redder each time you press \( \text{\textup{\textbullet}} \), depending on the original white balance conditions. Press \( \text{SET} \) to save your adjustment.
   - The white balance can be adjusted 7 increments in both the red and blue directions.
   - After saving the adjustment, press \( \text{SET} \) again to exit the menu.
Saving a custom white balance

You can save the current white balance setting and white balance compensation value in CUSTOM 1 to CUSTOM 4 and select them as custom white balance menus.

1 Follow the procedure on P.109 - P.111 to select the white balance you want to save.

2 Press \( \text{\textregistered} \) while holding down WB.

3 Press \( \text{\textregistered} \) to select SET, then press \( \text{\textregistered} \).

4 Press \( \text{\textregistered} \) to select CUSTOM 1, CUSTOM 2, CUSTOM 3 or CUSTOM 4, then press \( \text{\textregistered} \).
   - The current white balance setting and white balance adjustment value are saved as a custom white balance.
   - If a custom white balance is already saved in the selected number, a confirmation screen appears. To register the new settings, select RESET and press \( \text{\textregistered} \).
   - Press \( \text{\textregistered} \) again to exit the menu.
SHARPNESS

This function adjusts the sharpness of the image.

1. In the top menu, select MODE MENU → PICTURE → SHARPNESS, and press .
   “Menu basics” (P.38)

2. Press to adjust the sharpness between +5 and –5.
   - To increase the sharpness (+) :
     Press . The image contours are emphasized, making the image appear sharper and more vivid. Use this setting when you want to print pictures.
   - To reduce the sharpness (–) :
     Press . The image contours are softened. Use this setting when you want to edit images on a PC.
   - When you have finished setting the sharpness, press . Press again to exit the menu.

Note

• If you adjust the sharpness too far toward +, noise may become noticeable in the picture.
This function adjusts the contrast of the image. For example, you can make images with marked differences in light and shadow softer, and those with less differences more vivid.

1. In the top menu, select MODE MENU → PICTURE → CONTRAST, and press OK.
   
2. Press the arrow pad to adjust the contrast between +5 and –5.
   
   • To increase the contrast (+):
     
     Press the arrow pad. The light and dark areas are defined more clearly, making the image look crisper.
   
   • To reduce the contrast (–):
     
     Press the arrow pad. The light and dark areas become less defined, giving the image a softer impression. Use this setting when you want to edit images on a PC.

   • When you have finished setting the contrast, press OK. Press OK again to exit the menu.
This function adjusts the tint of the whole picture. The hue can be adjusted between +5 and –5.

1 In the top menu, select MODE MENU → PICTURE → HUE, and press .
   “Menu basics” (P.38)

2 Press to adjust the hue between +5 and –5.
   • To increase the hue (+) :
     Press . Based on the blue of the sky, the pictures takes on a purpler hue.
   • To reduce the hue (–) :
     Press . Based on the blue of the sky, the picture takes on a greener hue.
   • When you have finished setting the hue, press . Press again to exit the menu.
This function adjusts the color depth.

**SATURATION**

1. In the top menu, select MODE MENU → PICTURE → SATURATION, and press .
   - “Menu basics” (P.38)

2. Press to adjust the saturation between +5 and –5.
   - To increase the saturation (+) :
     - Press . Colors become darker and more intense.
   - To reduce the saturation (–) :
     - Press . Colors become lighter.
   - When you have finished setting the saturation, press . Press again to exit the menu.

---

**SCENE MODES**

In P, A, S, M, and modes, the image is processed according to your purpose and the effect you want to achieve. The color reproduction, sharpness, contrast and saturation are adjusted automatically.

1. In the top menu, select MODE MENU → PICTURE → SCENE MODES, then choose from →NORMAL, , or , and press .
   - “Menu basics” (P.38)
   - For , and modes, see “Situation-related modes” (P.49).
   - Press again to exit the menu.
NOISE REDUCTION

This function reduces the noise that is generated during long exposures. When shooting night scenes, shutter speeds become slower and noise tends to appear on images. When noise reduction is set to ON, the camera automatically reduces noise to produce clearer images. However, shooting time is approximately twice as long as usual. Noise reduction can only be used when the shutter speed is set slower than 1/2 sec.

The purpose of these pictures is to illustrate the effects of noise reduction. They are not actual pictures.

1. In the top menu, select MODE MENU → CAMERA → NOISE REDUCTION → ON or OFF, and press 

   “Menu basics” (P.38)

   • Press 

   Arrow pad

   OK button

   • Press again to exit the menu.

   • When mode is set, noise reduction is fixed to ON.
   • When noise reduction is set to ON, the camera implements noise-reducing processes after each shot. For this reason, shooting time is approximately twice as long as usual. During this time, you cannot continue shooting.
   • When noise reduction is set to ON, sequential shooting (HI, AF, BKT) is not possible.
   • This function may not work effectively with some shooting conditions or subjects.
   • As the shutter speed is relatively slow, the use of a tripod is recommended.
Histogram – Displaying the luminance distribution of still pictures

During still picture shooting, you can display a histogram showing the brightness and contrast of your subject in the viewfinder or on the monitor. You can also display the black and white areas directly on the image. Checking the histogram during shooting enables precise exposure control.

**OFF**  
The histogram is not displayed.

**ON**  
The histogram is displayed when $\mathcal{F}$ is pressed.

“Exposure compensation” (P.108)

**ON**  
The histogram is always displayed.

**DIRECT**  
The black and white areas are displayed directly on the image.

**Ex.**  
When ON is selected in **P** mode

When the image is bright

When the image is dark

The part indicated in green in the histogram shows the luminance distribution within the histogram target mark.

**Ex.**  
When DIRECT is selected in **P** mode

Red frame: Mostly white area
Blue frame: Mostly black area

If the area contains both black and white parts, it is also displayed in the blue frame.
1 Press \( \text{\textcircled{9}} \) while holding down \( \text{\textcircled{9}} \).

2 Press \( \text{\textcircled{9}} \) to choose the histogram display mode, then press \( \text{\textcircled{9}} \).
   - In \( \text{\textcircled{M}} \) mode, when histogram is not set to OFF, the subject is displayed in the viewfinder or on the monitor at the appropriate brightness for the selected exposure.

   • The histogram or the direct is not displayed in the following situations even if \( \text{\textcircled{9}} \) is set to ON or DIRECT.
     - During panorama shooting or during multi-metering
     - You can turn the histogram display on and off during exposure compensation. “Exposure compensation” (P.108)
     - The histogram displayed during shooting may differ from that displayed during playback.
     - The histogram is not displayed in movie mode.

**Changing the position of the histogram target mark**

While the histogram is displayed in shooting mode, hold down \( \text{\textcircled{9}} \) and use the arrow pad to move the histogram target mark. The area inside the target is displayed in green on the histogram.

To restore the histogram target mark to its original position, press \( \text{\textcircled{9}} \) while holding down \( \text{\textcircled{9}} \).
7 Playback

0 Viewing still pictures

1 Set the mode dial to (playback mode) and turn the camera on.

- The last picture taken is displayed. (Single-frame playback)
- Shooting information is displayed for about 3 seconds. You can change how much information is displayed on the screen.
  “INFO – Displaying shooting information” (P.135)
- For details of the information displayed, see “Viewfinder and monitor indications” (P.11).

2 Use the arrow pad or control dial to play back other pictures.
   • Arrow pad
      Jumps to the picture 10 frames back.
      Displays the previous picture. Displays the next picture.
      Jumps to the picture 10 frames ahead.
   • Control dial
      Displays the previous picture. Displays the next picture.

! Note
   • If no operation is performed for about 3 minutes, the camera automatically enters the sleep mode and the monitor or viewfinder turns off. Press (Power) or any button to turn the monitor or viewfinder on.
QUICK VIEW

This function lets you play back pictures while the camera is in the shooting mode. This is useful when you want to check shooting results and resume shooting quickly. Functions available in normal playback mode are also available in Quick View.

1. Press the QUICK VIEW button in the shooting mode.
   - The camera immediately enters the playback mode and displays the last picture taken. (Single-frame playback)

2. Press the QUICK VIEW button again to return to the shooting mode.
   - A light press of the shutter button will also return the camera to shooting mode.
Picture rotation

Pictures taken with the camera held vertically are displayed horizontally. This function lets you turn such pictures 90 degrees clockwise or counterclockwise so that they are displayed vertically.

1 In the single-frame playback mode, press $\text{_rotation button}$.
   - Each pressing of $\text{rotation button}$ rotates the image in the following sequence: 90 degrees counterclockwise, 90 degrees clockwise, and back to the original.

- The following pictures cannot be rotated.
  - Movies, protected pictures, pictures that have been edited on a PC and pictures taken with another camera
  - New picture orientations are saved even when the power is turned off.
Pictures displayed on the monitor can be enlarged 2, 3, 4 or 5 times.

1. Select the still picture you want to enlarge.
   - You cannot enlarge pictures with $\mathbb{P}$.

2. Turn the zoom lever toward T (T).
   - The picture is enlarged in steps each time the lever is turned.
   - By using the arrow pad while the enlarged picture is displayed, you can shift the picture in the desired direction, enabling you to view a different portion.
   - Turning the control dial allows you to view the next or previous frame in the same magnification.
   - To return the picture to the original size (1x), turn the zoom lever toward W.

- Pictures cannot be stored in an enlarged state.

Note
Index display

This function lets you show several pictures at the same time on the monitor. The number of pictures shown can be 4, 9 or 16. “Selecting the number of pictures” (P.126)

1 In the single-frame playback mode, turn the zoom lever toward W ( ).

- Use the arrow pad to select the picture.
  - : Moves to the previous frame.
  - : Moves to the next frame.
  - : Moves to the upper frame.
  - : Moves to the lower frame.

- Turning the control dial during an index display allows you to change the pages displayed.

- To return to the single-frame playback, turn the zoom lever toward T.
Selecting the number of pictures

This function lets you select the number of pictures in an index display from 4, 9 and 16.

1. In the top menu, select MODE MENU \(\Rightarrow\) \(\Rightarrow\) 4, 9 or 16, and press \(\Rightarrow\).
   
   “Menu basics” (P.38)

   • Press \(\Rightarrow\) again to exit the menu.

TIPS

• Pictures can also be displayed in index format using the \(\Rightarrow\) tab in SET UP mode.
This function displays still pictures stored in the card one after another. Only the first frame of a movie is played back.

1. Select a still picture, then press \( \text{\textbullet} \) to display the top menu.

2. Press \( \text{\textbullet} \) to start the slideshow.

3. Press \( \text{\textbullet} \) to stop the slideshow.
   - The slideshow will not stop until you cancel it by pressing \( \text{\textbullet} \).

---

**Note**

- You are recommended to use the optional AC adapter when running a slideshow for a long period of time. If a battery is used, the camera will stop the slideshow after about 30 minutes and enter sleep mode.
Viewing movies

This function lets you play back movies. You can fast forward the movie, play it back one frame at a time or save selected frames as still pictures (capture, SHQ only).

1 Use the arrow pad or control dial to display the picture with you want to play back.
   “Viewing still pictures” (P.121)

2 Press .
   • The top menu is displayed.

3 Press to select MOVIE PLAY.

4 Press to select MOVIE PLAYBACK, then press .
   • The movie is played back. When playback ends, the display automatically returns to the beginning of the movie.

The following operations can be performed during movie playback.

appears on movies that have sound recorded. Pressing lets you adjust the sound volume during playback.

: Increases the volume.

: Reduces the volume.

: Plays the movie at double the normal speed. Holding the button down increases the speed to 20 times the normal speed.

: Plays the movie in reverse at double the normal speed. Holding the button down increases the speed to 20 times the normal speed.

: Pauses playback and displays the MOVIE PLAYBACK menu.
5 Press ( ).

- The MOVIE PLAYBACK menu is displayed.

**PLAYBACK**
- Plays back the entire movie again.

**FRAME BY FRAME**
- Plays back the movie manually one frame at a time.

**CAPTURE**
- Cuts one frame from the movie and saves it as a still picture.
  - If the movie is recorded in the record mode other than SHQ, this cannot be selected.

**EXIT**
- Leaves the movie playback mode.

6 Press ( ) to select PLAYBACK, FRAME BY FRAME, CAPTURE or EXIT, then press ( ).

○ If you selected FRAME BY FRAME

- ( ) : Displays the first frame of the movie.
- ( ) : Displays the last frame of the movie.
- ( ) : Displays the next frame. The movie can be played continuously by holding the button down.
- ( ) : Displays the previous frame. The movie can be played continuously in reverse by holding the button down.
- ( ) : Displays the MOVIE PLAYBACK menu.

○ If you selected CAPTURE

① Play back the movie one frame at a time until the frame you want to save as a still picture is displayed.

② Press ( ).

③ Press ( ) to select CAPTURE, then press ( ).

④ Press ( ) to select the card, then press ( ).
  - If only one card is inserted, skip this step.
  - When there is insufficient card memory, the display returns to the MOVIE PLAYBACK menu.

⑤ Press ( ) to select OK, then press ( ).
  - A still picture is created from the extracted movie frame and the display returns to the MOVIE PLAYBACK menu.

TIPS

- Movies can also be played back in the shooting mode using QUICK VIEW.
  - “QUICK VIEW” (P.122)
Editing movies

This function lets you create indexes from as well as edit movies. However, you cannot edit movies longer than approximately 56 seconds in SHQ mode, 150 seconds in HQ mode and 600 seconds in SQ mode.

INDEX 9 frames extracted from a movie are displayed as an index to show the movie at a glance. Indexes can be stored on the card as still pictures.

EDIT This function lets you cut the parts of the movie that you want and edit.

1 Use the arrow pad to select a picture with .

2 In the top menu, select MOVIE PLAY, then choose each item.
   “Menu basics” (P.38)
   Select “INDEX” P.131
   Select “EDIT” P.132

Note
• The still picture created in CAPTURE is SQ2 (640 × 480 pixels). This picture may be grainier than still pictures of the same size.
• While the card access lamp is blinking, the camera is reading the movie from the card. Reading of movies may take considerable time. Do not open the card cover while the card access lamp is blinking as this may cause not only the data on the card to be damaged, but may also render the card unusable.
Creating an index

3 Press \(\text{GOSELECT}\) to select INDEX, then press \(\text{OK}\).

4 Select the first frame of the index with the arrow pad and press \(\text{OK}\).
\(\downarrow\) : Jumps to the first frame of the movie.
\(\uparrow\) : Jumps to the last frame of the movie.
\(\rightarrow\) : Displays the next frame. The movie can be played continuously by holding the button down.
\(\leftarrow\) : Displays the previous frame. The movie can be played continuously in reverse by holding the button down.

5 As in Step 4, select the last frame of the index with the arrow pad and press \(\text{OK}\).

6 Press \(\text{GOSELECT}\) to select the card, then press \(\text{OK}\).
• If only one card is inserted, skip this step.
• When there is insufficient card memory, the display returns to the setting screen.

7 Press \(\text{GOSELECT}\) to select OK, then press \(\text{OK}\).
• The camera returns to the playback mode, then the 9 frames extracted from the movie appear as an index display. The index is stored as a new picture.
• If you want to select different frames, select RESET and press \(\text{OK}\) and repeat the procedure from Step 4.
• To quit the index function, select CANCEL and press \(\text{OK}\).

TIPS
• The index is stored as a still picture in a different record mode from the original movie.

<table>
<thead>
<tr>
<th>Record mode when the movie was shot</th>
<th>Record mode when stored as an index</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHQ</td>
<td>SQ1 (2048 × 1536 pixels: HIGH)</td>
</tr>
<tr>
<td>HQ</td>
<td>SQ2 (1024 × 768 pixels: HIGH)</td>
</tr>
<tr>
<td>SQ</td>
<td>SQ2 (640 × 480 pixels: HIGH)</td>
</tr>
</tbody>
</table>
• The interval between the frames that are automatically picked out varies depending on the length of the movie.
• An index consists of 9 frames.
• You cannot create an index if there is insufficient memory space on the card.

Editing a movie

3 Press \( \Box \) \( \Box \) to select EDIT, then press \( \circ \).

4 Select the first frame of the part you want to keep with the arrow pad and press \( \circ \).

\( \Box \) : Jumps to the first frame of the movie.
\( \Box \) : Jumps to the last frame of the movie.
\( \Box \) : Displays the next frame. The movie can be played continuously by holding the button down.
\( \Box \) : Displays the previous frame. The movie can be played continuously in reverse by holding the button down.

5 As in Step 4, select the last frame of the part you want to keep and press \( \circ \).

6 Press \( \Box \) \( \Box \) to select the card, then press \( \circ \).

• If only one card is inserted, skip this step.
• When there is insufficient card memory, the display returns to the setting screen.

7 Press \( \Box \) \( \Box \) to select NEW FILE or OVERWRITE, then press \( \circ \).

NEW FILE Stores the edited movie as a new movie.
OVERWRITE Stores the edited movie with the same name as the original. The original movie is erased.

• If the card selected in Step 6 is different from the card on which the original movie is stored, skip this step.
8 Press  and  to select OK, then press .
   • If you want to select different frames, select RESET and press  and repeat the procedure from Step 4.
   • To quit the editing function, select CANCEL and press .
   • The edited movie is stored and the screen returns to the playback mode.

Note
   • You cannot edit movies with sound which were taken with another digital camera.
   • You cannot select NEW FILE if there is insufficient memory space on the card.
Use the AV cable provided with the camera to play back recorded images on your TV. Both still pictures and movies can be played back.

1 Make sure that the TV and camera are turned off. Connect the A/V OUT jack on the camera to the video input terminal on the TV using the AV cable.

2 Turn the TV on and set it to the video input mode.
   • For details of switching to video input, refer to your TV’s instruction manual.

3 Set the mode dial to ➤ and turn the camera on.
   • The last picture taken is displayed on the TV. Use the arrow pad to select the picture you want to display.
   • The close-up playback, index display, slideshow and other playback functions can also be used on a TV screen.

TIPS
   • You are recommended to use the optional AC adapter when using the camera with a TV.

Note
   • Make sure that the camera’s video output signal type is the same as the TV’s video signal type.
   “VIDEO OUT – Setting the video signal type” (P.174)
   • The camera’s monitor and viewfinder turn off automatically when the AV cable is connected to the camera.
   • Be sure to use the AV cable provided to connect the camera to the TV.
   • The picture may appear off-center on the TV screen.
   • When pictures are compressed in order to fit the entire picture on the TV screen, a black frame may appear around the picture. If the picture is output to a video printer via the TV, the black frame may be printed.
INFO – Displaying shooting information

This function lets you display shooting information or a histogram in the single-frame playback mode.

**OFF** Displays the only basic informations, such as the record mode, date and time, and number of frames.

**ON** Displays detailed shooting information on the monitor for 3 seconds. For details of the information displayed, see “Viewfinder and monitor indications” (P.11).

**Histogram** Displays a histogram showing the brightness and contrast of still pictures. For more details, see “Histogram – Displaying the luminance distribution of still pictures” (P.119).

1. Press INFO repeatedly.
   - Each time you press INFO, the information displayed changes as follows.

   ![Mode dial](image)

   - When INFO is OFF
   - When INFO is ON
   - Histogram display

   ![INFO Information display button](image)
   ![Arrow pad](image)
   ![OK button](image)

**Note**
- If the picture has been taken with a different camera, not all the information may be displayed when INFO is set to ON.
- The file number used to specify an image when making non-DPOF print at a print shop is displayed when INFO is set to ON.
- The histogram displayed during shooting may differ from that displayed during playback.
- The histogram is not displayed in movie.
- It may not be possible to display a histogram for pictures taken with another camera.
Displaying guidelines

This function lets you display guidelines on the monitor during single-frame playback.

1 **In the top menu, press 
  • The guidelines are displayed.

2 **Press 
  • When the guidelines are displayed, use or the control dial to display the picture you want to see.

3 **Press 
  • The guidelines on the screen disappear and the camera returns to normal single-frame playback.

**Note**
• The guidelines are not displayed during close-up playback or during an index display.
Recording sound

Sound can be added to a still picture that you have already taken. (This is known as “after-recording”.) You can also re-record over the sound that has already been recorded. Total recording time per picture is approximately 4 seconds.

1. Select the still picture to which you want to add sound, then press [REC] to display the top menu.

2. Press [ ] to display START.

3. Turn the camera microphone toward the sound you want to record and press [ ] to start recording.
   - The BUSY bar is displayed during recording.

4. If the microphone is placed farther than 1m (3.3ft) away from the subject, the recorded sound quality may not be satisfying.
5. If you re-record the sound, the original sound is erased.
6. You may not be able to record sound when there is insufficient card memory (the CARD FULL message is displayed).
7. Sound recording may pick up camera noises, such as button operation or shutter movement.
8. Once sound is added to a picture, it is not possible to erase only the sound. In this case, make a re-recording with silence.
Editing still pictures

This function lets you edit still pictures and store them as new pictures. The following editing operations are possible.

Resizing  
Changes the picture size to 640 × 480 or 320 × 240 and stores the picture as a new file.

Trimming  
Crops part of a picture and saves it as a new file.

RAW DATA EDIT  
Adjusts the white balance, sharpness, etc. of the pictures recorded in the RAW data format and stores them as new TIFF or JPEG files. You can edit recorded pictures to your liking while checking the result.

1 In the top menu, select MODE MENU → EDIT, then choose each item.

   "Menu basics" (P.38)

Select  P.138
Select  P.139
Select RAW DATA EDIT  P.140

When selecting RAW DATA EDIT, display the image recorded in RAW mode first.

Resizing

2 Select , then press .

3 Turn the control dial to select the still picture you want to edit, then press .

4 Press to select a resolution, then press .
   • To quit the resizing function, select CANCEL, then press .

5 Press to select the card, then press .
   • If only one card is inserted, skip this step.
   • When there is insufficient card memory, the display returns to the setting screen.

6 Press to select OK, then press .
   • The BUSY bar is displayed during resizing. After the image is saved, the camera returns to Step 3.
Trimming

2 Select 

3 Turn the control dial to select the still picture you want to edit, then press 

4 Press to select 

5 Use the arrow pad, zoom lever and control dial to decide the trimming position and size.

- Press to select the trimming frame, and turn the zoom lever toward W or T to decide the trimming size.
- Use the control dial to select the height and width of the trimming frame.
- 3:2 trimming size can be selected when the size of the selected picture is 3264 × 2448 or 3264 × 2176.

6 Press .

- The trimmed picture is displayed for one second.

7 Press to select the card, then press .

- If only one card is inserted, skip this step.
- When there is insufficient card memory, the display returns to the setting screen.

8 Press to select OK, then press .

- The BUSY bar is displayed during trimming. After the image is saved, the camera returns to Step 3.
- The trimmed picture is stored as a separate picture from the original.
- If you want to trim the picture again, select RESET and press . Then repeat the procedure from Step 5.
- To quit the trimming function, select CANCEL and press .
• Trimming is not possible in the following cases.
  Movies, pictures recorded in RAW data format, or when there is
  insufficient memory space on the card.
• It may not be possible to trim pictures taken with another camera.
• If a trimmed picture is printed out, it may appear grainy.

RAW editing

2 Select RAW DATA EDIT, then press .

3 Turn the control dial to select the still picture you want to edit, then press .
  • You can only select an image recorded in RAW mode.

4 Press to select the item you want to set, then press .

5 Press to select the desired setting, then press .

6 When all the necessary items have been set, press .

7 Press to select the card, then press .
  • If only one card is inserted, skip this step.
  • When there is insufficient card memory, the display returns to the setting screen.

8 Press to select OK, then press .
  • The BUSY bar is displayed during RAW editing. After the image is saved, the camera returns to Step 3.

Items that can be set by RAW editing

<table>
<thead>
<tr>
<th>Item</th>
<th>Settings</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIFF, SHQ, HQ, SQ1, SQ2</td>
<td>±5 levels</td>
<td>P.102</td>
</tr>
<tr>
<td>WB AUTO, PRESET1, PRESET2, CUSTOM*, *</td>
<td>P.109</td>
<td></td>
</tr>
<tr>
<td>RED 7 to BLUE 7</td>
<td></td>
<td>P.112</td>
</tr>
<tr>
<td>NORMAL, m, m, m</td>
<td></td>
<td>P.117</td>
</tr>
<tr>
<td>±5</td>
<td></td>
<td>P.114</td>
</tr>
<tr>
<td>±5</td>
<td></td>
<td>P.115</td>
</tr>
<tr>
<td>±5</td>
<td></td>
<td>P.116</td>
</tr>
<tr>
<td>BLACK &amp; WHITE, SEPIA</td>
<td></td>
<td>P.139</td>
</tr>
</tbody>
</table>

* Can only be selected if WB was set to CUSTOM or during shooting.
Copying pictures

This function lets you copy pictures to and from the xD-Picture Card and CompactFlash or Microdrive. This menu can be selected if both cards are inserted. The selected card is the copying source. You can change the copying source by pressing the card button. See “Switching cards” (P.23)

ALL
Copies all the pictures on the card.

SELECT
Copies only the selected picture.

1 If you selected a still picture, in the top menu, select MODE MENU → EDIT → COPY, and press .
If you selected a movie, in the top menu, press to select COPY.
See “Menu basics” (P.38)

• The screen is displayed for you to select ALL or SELECT.

2 Press  to select ALL or SELECT, then press .

● If you choose ALL
A confirmation screen appears asking if you want to copy the pictures. Select YES and press .
• The pictures are copied and the menu is exited.

● If you choose SELECT
The playback screen is displayed. Turn the control dial to select the frame you want to copy and press .
• The picture is copied.
• If you want to copy more pictures, repeat the procedure.
• To finish copying, press . Press repeatedly until the menu disappears.
• Pictures cannot be copied to the same card.
• Files with a volume of 57 MB or over (movies of over approximately 64 seconds in SHQ mode, 70 seconds in HQ mode or 685 seconds in SQ mode) cannot be copied. If you try to copy such files, the message “FILE SIZE SELECTED TOO LARGE” will be displayed.

You are recommended to protect important pictures to avoid accidentally erasing them. Protected pictures cannot be erased by the single-frame/all-frame erase function.

1 Use the arrow pad or control dial to display the picture you want to protect.

2 Press the Protection button.
   • To cancel protection, press the Protection button again.

Note

Protected pictures cannot be erased by the single-frame/all-frame erase function, but they are all erased by formatting.
Erasing pictures

This function lets you erase recorded pictures. Single-frame erase erases only
the picture displayed on the monitor and all-frame erase erases all the pictures
on the card.

- You cannot erase pictures that are protected. Cancel protection before
  erasing such pictures.
- Once erased, pictures cannot be restored. Check each picture before
  erasing to avoid accidentally erasing pictures you want to keep.
  “Protecting pictures” (P.142)

Single-frame erase

1. Use the arrow pad or control dial to display
   the picture you want to erase.
   “Viewing still pictures” (P.121)

2. Press Erase button.
   The ERASE screen is displayed.

3. Press to select YES, then press OK button.
   The picture is erased and the menu is closed.
All-frame erase

This function erases all the pictures on the card.

1. In the top menu, select MODE MENU → CARD → CARD SETUP, and press .
   “Menu basics” (P.38)

2. Press to select ALL ERASE, then press .

3. Press to select YES, then press .
   • All the pictures are erased.
8 Customizing the camera

ALL RESET – Saving the camera’s settings

This function lets you keep the current camera settings when you turn off the power. The same settings are then reactivated next time you turn the camera on. The settings affected by All Reset are listed on the next page.

The All Reset setting (ON/OFF) applies to all the modes. If All Reset is set in one mode, this setting applies to all the other modes, both shooting and playback.

ON  All settings are returned to the factory default settings after the power is turned off.
   Ex. If the record mode is changed to SQ1 and All Reset is set to ON, the record mode will return to HQ (factory default setting) next time the camera is turned on.

OFF  The settings made before the power is turned off are saved and are activated again next time the camera is turned on.

1  In the top menu, select MODE MENU  Æ  Æ  ALL RESET  Æ  ON or OFF, and press .
Or in SET UP mode, select  Æ  ALL RESET  Æ  ON or OFF, and press .

• Press  again to exit the menu.
• In SET UP mode, set the mode dial to a different mode to exit the menu.

Note
• My Mode settings and functions on the SETUP tab (ALL RESET, , , etc.) are not returned to the factory default settings even when All Reset is set to ON.
• When ALL RESET is set to OFF, it may take time to start up when the power is turned on.
### Functions that All Reset affects

<table>
<thead>
<tr>
<th>Function</th>
<th>Factory default setting</th>
<th>Ref. page</th>
<th>Function</th>
<th>Factory default setting</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNo</td>
<td>F2.4</td>
<td>P.70</td>
<td>AF MODE</td>
<td>iESP</td>
<td>P.74</td>
</tr>
<tr>
<td>SHUTTER</td>
<td>1/1000</td>
<td>P.71</td>
<td>P-AF</td>
<td>ON</td>
<td>P.76</td>
</tr>
<tr>
<td>Program Shift</td>
<td>Reset</td>
<td>P.46</td>
<td>(still pictures)</td>
<td>OFF</td>
<td>P.100</td>
</tr>
<tr>
<td></td>
<td>0.0</td>
<td>P.108</td>
<td>(movies)</td>
<td>ON</td>
<td>P.101</td>
</tr>
<tr>
<td>FLASH</td>
<td>AUTO</td>
<td>P.59</td>
<td>FUNCTION</td>
<td>OFF</td>
<td>P.95, 97, 98</td>
</tr>
<tr>
<td></td>
<td>0.0</td>
<td>P.64</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AF/AF/MF</td>
<td>AF</td>
<td>P.79, 87, 88</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LCD/EVF</td>
<td>LCD (ON)</td>
<td>P.50</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CARD</td>
<td>xD</td>
<td>P.23</td>
<td>SCENE MODES</td>
<td>NORMAL</td>
<td>P.117</td>
</tr>
<tr>
<td>Optical zoom</td>
<td>wide</td>
<td>P.57</td>
<td>SHARPNESS</td>
<td>±0</td>
<td>P.114</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CONTRAST</td>
<td>±0</td>
<td>P.115</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>HUE</td>
<td>±0</td>
<td>P.116</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SATURATION</td>
<td>±0</td>
<td>P.117</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>JPEG DUPLICATE SETTING</td>
<td>OFF</td>
<td>P.106</td>
</tr>
<tr>
<td>BKT</td>
<td>±1.0, 3 pictures</td>
<td>P.93</td>
<td>TIFF, SHQ, HQ</td>
<td>3264 × 2448</td>
<td>P.105</td>
</tr>
<tr>
<td>ISO</td>
<td>AUTO</td>
<td>P.107</td>
<td>SQ1</td>
<td>2048 × 1536 NORMAL</td>
<td>P.105</td>
</tr>
<tr>
<td>MY MODE</td>
<td>MY MODE 1</td>
<td>P.73</td>
<td>SQ2</td>
<td>640 × 480 NORMAL</td>
<td>P.105</td>
</tr>
<tr>
<td>FLASH</td>
<td>IN+IN</td>
<td>P.66</td>
<td>INFO</td>
<td>OFF</td>
<td>P.135</td>
</tr>
<tr>
<td>SLAVE</td>
<td>1</td>
<td>P.69</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SLOW</td>
<td>SLOW1</td>
<td>P.63</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NOISE REDUCTION</td>
<td>OFF</td>
<td>P.118</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DIGITAL ZOOM</td>
<td>OFF</td>
<td>P.58</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FULLTIME AF</td>
<td>OFF</td>
<td>P.75</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
REC VIEW – Checking the picture immediately after shooting

You can display the picture you have just taken on the monitor while it is being recorded to the card. This is useful for making a brief check of the picture you have just taken.

**OFF**  The picture being recorded to the card is not displayed. This is useful when you want to prepare for your next shot while the previous picture is being recorded.

**AUTO**  The picture you have just taken is displayed while it is recorded to the card.

**3 SEC, 5 SEC, 10 SEC**  You can select the length of time the picture is displayed. If recording is not completed in the set time, the picture is displayed until recording is finished.

1. In the top menu, select **MODE MENU** → **REC VIEW** → **OFF, AUTO, 3 SEC, 5 SEC or 10 SEC**, and press 
   - Or in **SET UP** mode, select **REC VIEW** → **OFF, AUTO, 3 SEC, 5 SEC or 10 SEC**, and press 
   - **“Menu basics”** (P.38)
   - Press again to exit the menu.
   - In **SET UP** mode, set the mode dial to a different mode to exit the menu.

Mode dial: **P A S M**  **SET UP**
You can choose from 2 different sounds for button operations. You can also set the volume of each sound to LOW or HIGH. The factory default settings are 1 (short beep) for the sound and LOW for the volume. You can turn the sound off completely by setting OFF.

1. In the top menu, select MODE MENU → BEEP, and press OK. Or in SET UP mode, select BEEP, and press OK.

2. Select 1 or 2 and press OK. Then select LOW or HIGH and press OK.
   - To turn the sound off completely, select OFF and press OK.
   - Press OK again to exit the menu.
   - In SET UP mode, set the mode dial to a different mode to exit the menu.
Customizing the camera

SHUTTER SOUND – Setting the shutter sound

You can select from 2 kinds of sounds for the shutter button. You can also set the volume of each sound to LOW or HIGH. The factory default settings are 1 for the sound and LOW for the volume. You can turn the sound off completely by setting OFF.

1 In the top menu, select MODE MENU →  → SHUTTER SOUND, and press . Or in SET UP mode, select  → SHUTTER SOUND, and press .

   “Menu basics” (P.38)

2 Select 1 or 2 and press . Then select LOW or HIGH and press .
   • To turn the sound off completely, select OFF and press .
   • Press  again to exit the menu.
   • In SET UP mode, set the mode dial to a different mode to exit the menu.
You can change the function of the control dial and arrow pad in the shooting mode. Normally, to adjust the exposure compensation, you turn the control dial while holding down \[F\], but this feature lets you set the exposure compensation using only the control dial.

In addition, it is also possible to set the functions by using both direct buttons and the control dial with only the direct buttons.

The function of the control dial and arrow pad varies depending on the shooting mode. You can also assign functions chosen from CUSTOM 1, CUSTOM 2 and CUSTOM 3. For more details, see the table on the next page.

1. In the top menu, select MODE MENU \(\rightarrow\) \(\hat{\text{H}}\) \(\rightarrow\) DIAL \(\rightarrow\) NORMAL, CUSTOM 1, CUSTOM 2 or CUSTOM 3, and press \(\text{cancel}\).
   
   Or in SET UP mode, select \(\hat{\text{H}}\) \(\rightarrow\) DIAL \(\rightarrow\) NORMAL, CUSTOM 1, CUSTOM 2 or CUSTOM 3, and press \(\text{cancel}\).
   
   "Menu basics" (P.38)

   - Press \(\text{cancel}\) again to exit the menu.
   - In SET UP mode, set the mode dial to a different mode to exit the menu.
## Control dial and arrow pad functions by shooting mode

<table>
<thead>
<tr>
<th>Shooting mode</th>
<th>Function</th>
<th>Function</th>
<th>Function</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>P</td>
<td>—</td>
<td>Exposure compensation</td>
<td>Exposure compensation</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Program Shift</td>
<td>Program Shift</td>
<td>Program Shift</td>
<td>Program Shift</td>
</tr>
<tr>
<td></td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>Exposure compensation</td>
</tr>
<tr>
<td>A</td>
<td>—</td>
<td>Aperture value</td>
<td>—</td>
<td>Aperture value</td>
</tr>
<tr>
<td></td>
<td>—</td>
<td>Exposure compensation</td>
<td>Aperture value</td>
<td>Exposure compensation</td>
</tr>
<tr>
<td>S</td>
<td>Shutter speed</td>
<td>Exposure compensation</td>
<td>Exposure compensation</td>
<td>—</td>
</tr>
<tr>
<td>M</td>
<td>—</td>
<td>Shutter speed</td>
<td>Shutter speed</td>
<td>Shutter speed</td>
</tr>
<tr>
<td></td>
<td>—</td>
<td>Aperture value</td>
<td>Aperture value</td>
<td>Aperture value</td>
</tr>
<tr>
<td>iB</td>
<td>—</td>
<td>Exposure compensation</td>
<td>Exposure compensation</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>Exposure compensation</td>
</tr>
</tbody>
</table>

*: Turn the control dial to set.
°: Press on the arrow pad to set.
#: Press on the arrow pad to set.
Another CUSTOM 3 function

When CUSTOM 3 is selected, functions that were set by turning the control dial while holding down the direct button can be set using only the direct button. The setting can be changed by repeatedly pressing the direct button.

Ex. Changing the flash mode
Press $\downarrow$ repeatedly.

- The flash mode changes each time $\downarrow$ is pressed.

Precautions when using CUSTOM 3

- The exposure compensation cannot be adjusted by pressing $\pm$. Flash intensity control cannot be adjusted by pressing $\pm$ and $\downarrow$ at the same time.

- When sharpness, contrast, hue or saturation are assigned to the $\circ$ button, the setting cannot be changed by repeatedly pressing $\circ$. PANORAMA and $\circ$ cannot be selected when FUNCTION is assigned to the $\circ$ button.
Customizing the camera

EV STEP – Setting exposure adjustment increments

You can set adjustment of the exposure compensation and flash intensity in 1/3EV or 1/2EV steps. The exposure compensation, flash intensity, shutter speed, aperture and ISO sensitivity will differ depending on the adjustment range you choose.

1. In the top menu, select MODE MENU → 📸 → EV STEP → 1/3EV or 1/2EV, and press 📷. Or in SET UP mode, select 📸 → EV STEP → 1/3EV or 1/2EV, and press 📷.

Press 📷 again to exit the menu.
In SET UP mode, set the mode dial to a different mode to exit the menu.
Customizing the camera

You can set frequently used functions on the custom button. This makes it easy to jump to the SETUP screen without selecting MODE MENU or a shortcut menu in the top menu. Selecting a setting with the control dial and pressing 

displays a dedicated screen for that setting. You can make fine settings using the arrow pad and .

<table>
<thead>
<tr>
<th>Functions that can be set on the custom button</th>
<th>Settings made by the control dial</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISO (default setting)</td>
<td>AUTO, 50 to 400</td>
<td>P.107</td>
</tr>
<tr>
<td>[ ]</td>
<td>[ ], HI [ ], AF [ ], BKT*</td>
<td>P.92</td>
</tr>
<tr>
<td>DIGITAL ZOOM</td>
<td>OFF, ON</td>
<td>P.58</td>
</tr>
<tr>
<td>NOISE REDUCTION</td>
<td>OFF, ON</td>
<td>P.118</td>
</tr>
<tr>
<td>FUNCTION</td>
<td>OFF, PANORAMA, [ ], BLACK &amp; WHITE, SEPIA</td>
<td>P.95, 97, 98</td>
</tr>
<tr>
<td>FRAME ASSIST</td>
<td>OFF, ON</td>
<td>P.99</td>
</tr>
<tr>
<td>(still pictures)</td>
<td>OFF, ON</td>
<td>P.100</td>
</tr>
<tr>
<td>(movies)</td>
<td>OFF, ON</td>
<td>P.101</td>
</tr>
<tr>
<td>MY MODE*</td>
<td>[ ] to [ ]</td>
<td>P.73</td>
</tr>
<tr>
<td>SCENE MODES</td>
<td>NORMAL, [ ], [ ]</td>
<td>P.117</td>
</tr>
<tr>
<td>SHARPNESS</td>
<td>–5 to ±0 to +5</td>
<td>P.114</td>
</tr>
<tr>
<td>CONTRAST</td>
<td>–5 to ±0 to +5</td>
<td>P.115</td>
</tr>
<tr>
<td>HUE</td>
<td>–5 to ±0 to +5</td>
<td>P.116</td>
</tr>
<tr>
<td>SATURATION</td>
<td>–5 to ±0 to +5</td>
<td>P.117</td>
</tr>
<tr>
<td>[ ]</td>
<td>–2.0 to ±0 to +2.0</td>
<td>P.108</td>
</tr>
<tr>
<td>FLASH MODE*</td>
<td>AUTO, [ ], [ ], [ ] SLOW, [ ]</td>
<td>P.59</td>
</tr>
<tr>
<td>AF/MF</td>
<td>AF*, [ ], [ ], MF, [ ], [ ]MF</td>
<td>P.79, 87, 88</td>
</tr>
<tr>
<td>ESP</td>
<td>ESP, [ ], [ ] MULTI, [ ]</td>
<td>P.81</td>
</tr>
<tr>
<td>OFF</td>
<td>OFF, [ ]</td>
<td>P.89, 90</td>
</tr>
<tr>
<td>WB*</td>
<td>AUTO, PRESET1, PRESET2, CUSTOM, [ ]</td>
<td>P.109</td>
</tr>
<tr>
<td>RAW, TIFF, SHQ, HQ, SQ1, SQ2</td>
<td></td>
<td>P.102</td>
</tr>
</tbody>
</table>

* The sub-menu lets you select further options.
Setting the custom button

1. In the top menu, select MODE MENU → CUSTOM BUTTON, and press .
   Or in SET UP mode, select CUSTOM BUTTON, and press .
   “Menu basics” (P.38)

2. Press to select the function you want to set, then press .
   • Press again to exit the menu.
   • In SET UP mode, set the mode dial to a different mode to exit the menu.

Note
• If the mode dial is set to a mode other than and is pressed when MY MODE is set on the custom button, the customized settings are not activated. Set the mode dial to and press to display the MY MODE screen.
Using the custom button

1 Press  
   • The function currently set to the custom button is displayed.

2 Turn the control dial while holding down  
   to set.
   •  is used in the same way as the direct button. “Direct button basics” (P.31)
   • When an operation guide is displayed at the bottom of the screen, more specific settings can be made.

Ex.1: When is set to  

Ex.2: When SHARPNESS is set to  

You can set three shortcut menus (A, B, C) in the top menu in a still picture shooting mode (P/A/S/M/ML/ML/ML/ML/ML).
This is useful when you want to go quickly to frequently-used functions. Direct button function is also possible to be set to shortcut.

**Functions that can be set in the shortcut menu**

<table>
<thead>
<tr>
<th>Function</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>FLASH MODE</td>
<td>P.59</td>
</tr>
<tr>
<td>AF/ISO/MF</td>
<td>P.79, 87, 88</td>
</tr>
<tr>
<td>ESP/ISO</td>
<td>P.81</td>
</tr>
<tr>
<td>ISO</td>
<td>P.92</td>
</tr>
<tr>
<td>DIGITAL ZOOM</td>
<td>P.89, 90</td>
</tr>
<tr>
<td>NOISE REDUCTION</td>
<td>P.107</td>
</tr>
<tr>
<td>FUNCTION</td>
<td>P.58</td>
</tr>
<tr>
<td>SATURATION</td>
<td>P.114</td>
</tr>
<tr>
<td>FUNCTION</td>
<td>P.115</td>
</tr>
<tr>
<td>SATURATION</td>
<td>P.116</td>
</tr>
</tbody>
</table>

**Functions that can be set in the shortcut menu**

<table>
<thead>
<tr>
<th>Function</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>FLASH MODE</td>
<td>P.59</td>
</tr>
<tr>
<td>AF/ISO/MF</td>
<td>P.79, 87, 88</td>
</tr>
<tr>
<td>ESP/ISO</td>
<td>P.81</td>
</tr>
<tr>
<td>ISO</td>
<td>P.92</td>
</tr>
<tr>
<td>DIGITAL ZOOM</td>
<td>P.89, 90</td>
</tr>
<tr>
<td>NOISE REDUCTION</td>
<td>P.107</td>
</tr>
<tr>
<td>FUNCTION</td>
<td>P.95, 97, 98</td>
</tr>
<tr>
<td>SATURATION</td>
<td>P.109</td>
</tr>
<tr>
<td>FUNCTION</td>
<td>P.102</td>
</tr>
<tr>
<td>SATURATION</td>
<td>P.117</td>
</tr>
<tr>
<td>FUNCTION</td>
<td>P.118</td>
</tr>
<tr>
<td>SATURATION</td>
<td>P.119</td>
</tr>
<tr>
<td>FUNCTION</td>
<td>P.120</td>
</tr>
<tr>
<td>SATURATION</td>
<td>P.121</td>
</tr>
</tbody>
</table>
Setting the shortcut menu

You can set the three shortcut menus designated by A, B and C on the diagram shown right.

1. In the top menu, select MODE MENU \(\rightarrow\) SHORT CUT, and press \(\text{GO}\).
   Or in SET UP mode, select \(\text{MODE} \rightarrow\) SHORT CUT, and press \(\text{GO}\).
   “Menu basics” (P.38)

2. Press \(\text{SELECT}\) to select A, B or C, then press \(\text{GO}\).

3. Press \(\text{SELECT}\) to select the function you want to set, then press \(\text{GO}\).
   - The shortcut menu is set.
   - Press \(\text{GO}\) again to exit the menu.
   - In SET UP mode, set the mode dial to a different mode to exit the menu.
Using the shortcut menu

When you have set a shortcut menu, you can use it to jump to the setting screen for that function.

1. Press \( \text{\textcircled{1}} \) to display the top menu.
   - The shortcut menu you have set appears on the top menu.

2. Press \( \text{\textcircled{2}} \), \( \text{\textcircled{3}} \) or \( \text{\textcircled{4}} \) to select the shortcut menu.
   - The monitor jumps directly to the setting screen for that function.

Ex. When SHARPNESS is set in shortcut menu A

Press \( \text{\textcircled{5}} \).

Pressing \( \text{\textcircled{5}} \) takes you directly to the SHARPNESS screen.
MY MODE SETUP – Setting a function in My Mode

You can set shooting-related functions in MY MODE. You can also save the current settings in MY MODE. When the mode dial is set to \( \text{My} \), your customized settings are activated. You can save up to 8 different settings in MY MODE 1 to 8. Only MY MODE 1 has a factory default setting.

### Functions affected by MY MODE SETUP

<table>
<thead>
<tr>
<th>Functions that can be set in MY MODE</th>
<th>Default setting</th>
<th>Ref. page</th>
<th>Functions that can be set in MY MODE</th>
<th>Default setting</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>P/A/S/M/S-Prg</td>
<td>P</td>
<td>P.46</td>
<td>WB</td>
<td>AUTO</td>
<td>P.109</td>
</tr>
<tr>
<td>FNo</td>
<td>F2.4</td>
<td>P.70</td>
<td>ISO</td>
<td>AUTO</td>
<td>P.107</td>
</tr>
<tr>
<td>SHUTTER</td>
<td>1/1000</td>
<td>P.71</td>
<td>DIGITAL ZOOM</td>
<td>OFF</td>
<td>P.58</td>
</tr>
<tr>
<td>Zoom</td>
<td>28 mm</td>
<td>–</td>
<td>NOISE REDUCTION</td>
<td>OFF</td>
<td>P.118</td>
</tr>
<tr>
<td>LCD/EVF*1</td>
<td>LCD</td>
<td>P.50</td>
<td>FUNCTION</td>
<td>OFF</td>
<td>P.95, 97, 98</td>
</tr>
<tr>
<td>ZOOM*2</td>
<td>AUTO</td>
<td>P.59</td>
<td>FRAME ASSIST</td>
<td>OFF</td>
<td>P.99</td>
</tr>
<tr>
<td>FLASH MODE</td>
<td>AUTO</td>
<td>P.59</td>
<td>FR (still pictures)</td>
<td>OFF</td>
<td>P.100</td>
</tr>
<tr>
<td>ZOOM</td>
<td>28 mm</td>
<td>–</td>
<td>SCENE MODES</td>
<td>NORMAL</td>
<td>P.117</td>
</tr>
<tr>
<td>AF/MF</td>
<td>AF</td>
<td>P.79, 87, 88</td>
<td>SHARPNESS</td>
<td>±0</td>
<td>P.114</td>
</tr>
<tr>
<td>AF MODE</td>
<td>iESP</td>
<td>P.74</td>
<td>CONTRAST</td>
<td>±0</td>
<td>P.115</td>
</tr>
<tr>
<td>FULLTIME AF</td>
<td>OFF</td>
<td>P.75</td>
<td>HUE</td>
<td>±0</td>
<td>P.116</td>
</tr>
<tr>
<td>P-AF</td>
<td>ON</td>
<td>P.76</td>
<td>SATURATION</td>
<td>±0</td>
<td>P.117</td>
</tr>
<tr>
<td>ESP/ESP1</td>
<td>ESP</td>
<td>P.81</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>S/1</td>
<td>OFF</td>
<td>P.89, 90</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1 Sets whether the monitor (LCD) or viewfinder (EVF) turns on when the camera is turned on.

*2 In \( \text{My} \) mode, available zoom positions are 28 mm, 50 mm, 85 mm, 105 mm and 140 mm. (These numbers are based on the focal length of a 35 mm camera.)
1 In the top menu, select MODE MENU →  
→ MY MODE SETUP, and press .  
Or in SET UP mode, select → MY MODE SETUP, and press .

“Menu basics” (P.38)

2 Press  to select an item, then press .

CURRENT* Saves the current camera settings.
RESET Restores the factory default settings.
CUSTOM Saves settings one by one.

*Cannot be selected in SET UP mode.

- The MY MODE SETUP screen appears.

3 Select a MY MODE number.

- Press  to select a MY MODE number from 1 to 8, then press .

When selecting CURRENT in Step 2

4 Press  to select SET, then press .

- The current camera settings are saved in the selected MY MODE.
When selecting RESET in Step 2

4 Press \( \text{\textit{G}} \) to select ALL RESET, then press \( \text{\textit{E}} \).
   • The settings in the selected MY MODE are reset. If no settings are saved, the relevant MY MODE number cannot be selected.

When selecting CUSTOM in Step 2

4 Press \( \text{\textit{G}} \) to select the item you want to save in MY MODE, then press \( \text{\textit{E}} \).
   • For the available items, see "Functions affected by MY MODE SETUP" (P.160).

Press \( \text{\textit{G}} \) to change the setting, then press \( \text{\textit{E}} \).
   • The setting is saved.
   • You can also change the other custom settings.

5 When you have made all the settings you want, press \( \text{\textit{E}} \).
   • The screen displayed in Step 2 appears.
   • Press \( \text{\textit{E}} \) again to exit the menu.
   • In SET UP mode, set the mode dial to a different mode to exit the menu.

Note

• The zoom position is set to one of the five zoom positions available in MY MODE SETUP. The value closest to the current zoom position will be selected.
CONTROL PANEL – Using the monitor as a control panel

This option lets you display the each setting on the monitor in the shooting mode. The subject is displayed on the viewfinder.

1 In the top menu, select MODE MENU \(\Rightarrow\) \(\Rightarrow\) CONTROL PANEL \(\Rightarrow\) ON, and press \(\circ\). Or in SET UP mode, select \(\circ\) \(\Rightarrow\) CONTROL PANEL \(\Rightarrow\) ON, and press \(\circ\).

• Press \(\circ\) again to exit the menu.
• In SET UP mode, set the mode dial to a different mode to exit the menu.
• The control panel is displayed on the monitor.
• Even when the control panel is displayed on the monitor, you can display the subject by pressing \(\circ\).
• Pressing the direct button displays the setting in green on the control panel. Each setting can be made on the control panel by turning the control dial.
• For more details \(\Rightarrow\) “Control panel screen” (P.164)

Note

• The subject is displayed on the monitor when using functions that use the monitor, such as guideline shooting or panorama mode.
## Control panel screen

<table>
<thead>
<tr>
<th>1</th>
<th>Battery check</th>
<th>14</th>
<th>Sound record</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Shooting mode</td>
<td>15</td>
<td>Record mode/Resolution</td>
</tr>
<tr>
<td>3</td>
<td>Shutter speed</td>
<td>16</td>
<td>Number of storable still pictures/Recording time</td>
</tr>
<tr>
<td>4</td>
<td>Aperture value</td>
<td>17</td>
<td>Memory gauge</td>
</tr>
<tr>
<td>5</td>
<td>Exposure compensation</td>
<td>18</td>
<td>Exposure compensation</td>
</tr>
<tr>
<td>6</td>
<td>Noise reduction</td>
<td>19</td>
<td>ISO</td>
</tr>
<tr>
<td>7</td>
<td>AE lock/AE memory</td>
<td>20</td>
<td>White balance compensation</td>
</tr>
<tr>
<td>8</td>
<td>Spot metering/Multi-metering</td>
<td>21</td>
<td>White balance</td>
</tr>
<tr>
<td></td>
<td>Center-weighted metering</td>
<td>22</td>
<td>Saturation/Sharpness/Hue/Contrast</td>
</tr>
<tr>
<td>9</td>
<td>Focus mode, P-AF</td>
<td>23</td>
<td>Scene modes</td>
</tr>
<tr>
<td>10</td>
<td>Flash mode</td>
<td>24</td>
<td>Folder number</td>
</tr>
<tr>
<td>11</td>
<td>Flash intensity control</td>
<td>25</td>
<td>Selected card</td>
</tr>
<tr>
<td>12</td>
<td>Sequential shooting</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Self-timer/Remote control</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**VOLUME – Adjusting the playback volume**

You can adjust the volume of the sound when playing back a still picture or movie. There are 5 levels to choose from.

1. **In the top menu, select MODE MENU → ⚫ → VOLUME, and press ‹.**
   - Or in SET UP mode, select → ⚫ → VOLUME, and press ‹.
   - “Menu basics” (P.38)

2. **Press ⏯ to select the volume level, then press ‹.**
   - Press ‹ again to exit the menu.
   - In SET UP mode, set the mode dial to a different mode to exit the menu.

Selecting this level will mute the sound completely.
This function lets you format a card. Formatting prepares cards to receive data. Before using non-Olympus cards or cards which have been formatted on a PC, you must format them with this camera.

All data stored on the card, including protected pictures, is erased when the card is formatted. When formatting a used card, confirm there are no pictures that you still want to keep on the card.

1 In the top menu, select MODE MENU → CARD → CARD SETUP, and press .
In SET UP mode, select CARD → CARD SETUP, and press .
“Menu basics” (P.38)

- PASM SET UP: The FORMAT screen is displayed.
- : The CARD SETUP screen is displayed.

2 If the mode dial is set to P A S M SET UP, press to select YES.
If the mode dial is set to , press to select FORMAT, then press . The FORMAT screen is displayed. Press to select YES.

3 Press .
- The BUSY bar is displayed and the card is formatted.

Note
- Do not perform any of the following actions during formatting as they may render the card unusable.
  Open the card cover, remove the battery, connect or disconnect the AC adapter (regardless of whether or not the battery is loaded in the camera).
Selecting a language for on-screen display

This function lets you select a language for on-screen display. This reference manual shows the English on-screen display in illustrations and explanations. Available languages vary depending on the area where you purchased this camera.

1. Select SETUP ➔  SET UP, then press .
   ➔ “Menu basics” (P.38)

2. Press  to select a language, then press .
Setting the date and time

The date/time is saved with recorded pictures and file names are assigned based on the date/time settings.

1. Select SETUP → , then press .
   - Press repeatedly until is displayed on the monitor.

2. Press to select one of the following date formats:
   - Y-M-D (Year/Month/Day),
   - M-D-Y (Month/Day/Year),
   - D-M-Y (Day/Month/Year).
   Then press .
   - Move to the year setting.
   - The following steps show the procedure used when the date and time settings are set to Y-M-D.

3. Press to set the year, then press to move to the month setting.
   - To move back to the previous setting, press .
   - The first two digits of the year are fixed.

4. Repeat this procedure until the date and time are completely set.
   - The time is displayed in the 24-hour format. For example, 2pm will be displayed as 14:00.

5. Press .
   - For a more accurate setting, press when the time signal hits 00 seconds.

• The date and time settings will be returned to the factory default setting if the camera is left without the battery for a few days. The settings will be canceled more quickly if the battery was only loaded in the camera for a short time before being removed. Check that the correct date and time have been set before shooting.
Setting the warning tone

You can select the volume of the beep sound used for warnings from OFF, LOW, or HIGH. You can turn the sound off completely by setting OFF.

1. Select SETUP \(\rightarrow\) OFF, LOW or HIGH, and press \(\circlearrowleft\).

   - Menu basics" (P.38)

SLEEP – Setting the time until the camera enters sleep mode

The camera automatically enters the sleep mode after being left unoperated for a preset length of time. Press the shutter button or arrow pad to cancel the sleep mode and reactivate the camera.

1. Select SETUP \(\rightarrow\) SLEEP \(\rightarrow\) 30 SEC, 1 MIN, 3 MIN, 5 MIN or 10 MIN, and press \(\circlearrowleft\).

   - Menu basics” (P.38)

Note

- The camera will not enter sleep mode when powered by the AC adapter.
- In \(\rightarrow\) mode, the camera will enter sleep mode and the monitor will turn off after 3 minutes of non-operation, regardless of the time set in the sleep timer.
- In slideshow mode, the camera will enter sleep mode and the monitor will turn off after 30 minutes.
- In shooting mode, when the powersaving mode is set to ON, the camera will enter sleep mode and the viewfinder will turn off after 10 seconds, regardless of the time set in the sleep timer.
FILE NAME – Assigning a file name

The camera automatically creates file names and folder names for images to be stored in. Files can be numbered from 0001 to 9999 and folders can be numbered from 100 to 999. Examples are shown below.

<table>
<thead>
<tr>
<th>Folder name</th>
<th>File name</th>
</tr>
</thead>
<tbody>
<tr>
<td>\DCIM*<strong>OLYMP\Pmdd</strong>**.jpg</td>
<td></td>
</tr>
</tbody>
</table>

Folder No. (100 - 999)  Month (1 - C)  File No. (0001 - 9999)  Day (01 - 31)


There are two settings from which you can choose: RESET or AUTO. Choose the one that is best for you when transferring images to a PC.

**File name settings**

**RESET**
The file number and folder number are reset every time a new card is inserted in the camera. The folder number returns to No. 100 and the file number returns to No. 0001. This method is useful when grouping files on separate cards.

**AUTO**
Even if a new card is inserted, the folder number and file number are retained from the previous card, so the same file number is not used on different cards. This helps you to manage multiple cards. This method is useful when you want to manage all your files with sequential numbers.

1. In the top menu, select SETUP → FILE NAME → RESET or AUTO, and press \(\text{\textcircled{\text{OK}}}\).

**Note**
- When the File No. reaches 9999, the file number returns to 0001 and the folder number changes.
- When both the Folder and File No. reach their respective maximum number (999/9999), the number of storable pictures becomes 0 even if the card is not full. No more pictures can be taken. Replace the card with a new one.
BATTERY SAVE
– Reducing battery consumption

This function reduces battery consumption by restricting the following camera operations in the shooting mode.

• The monitor does not turn on when ( ) is pressed.
• The camera automatically enters sleep mode and the viewfinder turns off after 10 seconds of non-operation.
• In P [ ] mode, the fastest shutter speed automatically selected by the camera is 1/2000 sec.

1 Select SETUP Æ BATTERY SAVE Æ ON or OFF, and press ( ).

“Menu basics” (P.38)
• To enable the powersaving mode, select ON.
PIXEL MAPPING – Checking the image processing functions

The Pixel Mapping feature allows the camera to check and adjust the CCD and image processing functions. It is not necessary to operate this function frequently. Approximately once a year is recommended. Wait over a minute after the monitor is used or continuous shots are taken to allow for proper performance of the Pixel Mapping function.

1. Select SETUP → PIXEL MAPPING, and press 
   • START appears.

2. Press 
   • The BUSY bar is displayed during Pixel Mapping. When Pixel Mapping is finished, the screen returns to the SET UP mode menu.

Note
• If you accidentally turn the camera off during Pixel Mapping, start again from Step 1.
Adjusting the brightness of the monitor and viewfinder

This function lets you adjust the brightness of the monitor and viewfinder. The brightness of the monitor and viewfinder can be adjusted separately.

1. Select SETUP \(\rightarrow\) \[\bigcirc\], and press \[\bigcirc\].
   - “Menu basics” (P.38)

2. Press \[\bigcirc\] to adjust the brightness of the monitor or viewfinder, and when you have set the desired level, press \[\bigcirc\].
   - Pressing \[\bigcirc\] brightens the monitor or viewfinder, and pressing \[\bigcirc\] darkens it.

Measurement units

The measurement unit can be selected from either meters or feet in the manual focus mode.

- **m**: At long ranges, the camera measures in meters, and at short ranges in centimeters.
- **ft**: At long ranges, the camera measures in feet, and at short ranges in inches.

1. Select SETUP \(\rightarrow\) m/ft \(\rightarrow\) m or ft, and press \[\bigcirc\].
   - “Menu basics” (P.38)
You can select NTSC or PAL according to your TV’s video signal type. Select the video signal type before connecting the AV cable. If you use the wrong video signal type, you will not be able to play back the recorded pictures properly on your TV.

1. Select SETUP → VIDEO OUT → NTSC or PAL, and press ( ).

   “Menu basics” (P.38)

---

**TIPS**

- **TV video signal types & main regions**
  - Check the video signal type before connecting the camera to your TV.
  - **NTSC**  North America, Japan, Taiwan, Korea
  - **PAL**  European countries, China
USB setup – Setting the connection destination

Before connecting the USB cable, set the camera to either PC or printer, whichever you intend to connect the camera to.

**PC**  Select when connecting the camera to a PC with the USB cable and transferring pictures to the PC. For instructions on how to connect the camera to your PC, refer to the “OPERATION MANUAL” (DIGITAL CAMERA - PC CONNECTION).

**PRINT**  Select when connecting the camera to a PictBridge-compatible printer with the USB cable. Pictures can be printed directly without using a PC. “Connecting the camera to a printer” (P.187)

1. Select SETUP ➔ USB ➔ PC or PRINT, and press .
   “Menu basics” (P.38)
How to print pictures

Print reservation allows you to save printing data (the number of prints and date/time information) with the pictures stored on the card. With print reservation, you can print out pictures easily either at home using a personal DPOF-compatible printer or at a photo lab or a print shop that supports DPOF.

DPOF is a standard format used to record automatic print information from digital cameras. You can print out pictures automatically, at home or in a print shop, by storing such data as which pictures you wish to print and the number of prints on the card.

Pictures with print reservation data can be printed using the following procedures.

**Printing using a DPOF-compatible photo lab or print shop.**
You can print the pictures using the print reservation data.

**Printing using a DPOF-compatible printer.**
Printing is possible directly from a card containing print reservation data without using a PC. For more details, refer to the printer's instruction manual. A PC card adapter may also be necessary.
TIPS

Picture size and printing
The resolution of a computer/printer is generally based on the number of dots (pixels) per square inch. This is called dpi (dots per inch). The higher the dpi value, the better the printed results. Keep in mind, however, that the dpi of the picture does not change. This means that when you print an image with a higher resolution, the size of the printed picture will be smaller. Although you can print magnified images, picture quality will decrease.

If you want to print large, high-quality pictures, set the record mode as high as possible when taking the pictures. “Record mode” (P.102)

• DPOF reservations set by another device cannot be changed by this camera. Make changes using the original device.
• If a card contains DPOF reservations set by another device, entering reservations using this camera may overwrite the previous reservations.
• If there is not enough space in the card memory, you may not be able to enter the reservation data. CARD FULL will be displayed.
• You can make DPOF print reservations for up to 999 images per card.
• Even if an image appears with the message “PICTURE ERROR”, it may be possible to make print reservations. In this case, the print reservation icon ( ) does not appear when the image is displayed for full view. ( ) appears when multiple images are displayed (index display), allowing you to confirm the print reservation.
• Not all functions may be available on all printers, at all print shops, or at all photo labs.
• Some TIFF images cannot be printed.
• Print reservation may take considerable time when saving printing data to a card.
• Print reservations cannot be made for images recorded in RAW data.
Use this feature to print all the pictures stored on the card. Select the desired number of prints and whether you want the date and time included.

1 **Play back a still picture.**
   - You cannot make print reservations for pictures with 📷.

2 **Press ``. The `PRINT ORDER` screen appears.**
   - If print reservation data is already stored on the card, the PRINT ORDER SETTING screen appears, giving you the choice of resetting the data or keeping it.

3 **Press 📷 to select `ALL`, then press 📷.**

4 **Press 📷 to select `×` (number of prints) or 📷 (date/time), then press 📷.**

5 **Perform each setting as illustrated.**
● Set the number of prints
Press \(\text{增大} \) \(\text{减少} \) to set the desired number of prints, then press \(\text{确定} \).
\(\text{增大} \): Increases the number.
\(\text{减少} \): Decreases the number.

● Set the date/time printing data
Press \(\text{增大} \) \(\text{减少} \) to select NO, DATE or TIME, then press \(\text{确定} \).
NO The pictures are printed without the date and time.
DATE All the pictures are printed with the shooting date.
TIME All the pictures are printed with the shooting time.
• After completing the number of prints or the date/time printing data setting, press \(\text{确定} \) to return to the playback screen.
Use this feature to print only selected pictures. Display the picture to be printed and select the desired number of prints.

1 Play back a still picture.
   • You cannot make print reservations for pictures with 📣.

2 Press 📷. The PRINT ORDER screen appears.
   • If there is a print reserved data on the card, the PRINT ORDER SETTING screen appears, giving you the choice of resetting the data or keeping it.

3 Press 📷 to select 📷, then press 📷.

4 Select the frame you want to print using the arrow pad or the control dial and press 📷.

5 Select the appropriate item using the arrow pad.

   MORE
   Sets the number of prints, date/time and trim size. The print reservation data is set and the screen proceeds to Step 6.
   SINGLE PRINT
   Sets single-frame print. The date/time and trimming settings are not available. → Step 9
   CANCEL
   Cancels the print reservation for the displayed picture. “To reset the print reservation data for a selected picture” (P.185)
   END
   Completes the print reservation. → Step 11
6 Press \( \triangleright \triangleright \) to select \( \square \times \) (number of prints), \( \triangleright \) (date/time) or \( \triangleright \triangleright \) (trimming), then press \( \triangleright \).

7 Perform each setting.

**Set the number of prints**
Press \( \triangleright \triangleright \) to set the desired number of prints, then press \( \triangleright \).
\( \triangleright \) : Increases the number.
\( \triangleright \triangleright \) : Decreases the number.

**Set the date/time printing data**
Press \( \triangleright \triangleright \) to select NO, DATE or TIME, then press \( \triangleright \).
NO The pictures are printed without the date and time.
DATE All the selected pictures are printed with the shooting date.
TIME All the selected pictures are printed with the shooting time.

**Trim the picture**
[“Trimming” (P.182)]

8 After completing all the print reservations, press \( \triangleright \) to complete the print reservations and return to the screen in Step 4.
- The \( \square \) icon appears on the displayed picture.
- Repeat steps 4 to 8 to make print reservations for other images.

9 Press \( \triangleright \) to display the single-frame reservation menu.

10 Press \( \triangleright \) to select END.
- The \( \square \) PRINT ORDER screen appears.

11 Press \( \triangleright \) again to display the \( \square \) PRINT ORDER SETTING screen, then press \( \triangleright \) once more to complete the print reservations.
This function enables you to crop part of a recorded picture and print out the enlarged section only.

1 Press \( \text{\text{trimming}} \) on the single-frame reservation screen to select \( \text{\text{trimming}} \) and press \( \text{\text{\text{trimming}}} \).

   • If trimming has already been set, the \( \text{\text{trimming}} \) screen appears. Press \( \text{\text{\text{trimming}}} \) to select RESET, then press \( \text{\text{\text{trimming}}} \).

2 Use the arrow pad, zoom lever, and control dial to decide the trimming position and size.
   • Press \( \text{\text{\text{trimming}}} \) to select the trimming frame, and press the zoom lever toward W or T to decide the trimming size.
   • Use the control dial to select the height and width of the trimming frame.
   • 3:2 trimming size can be selected when the size of the selected picture is 3264 × 2448 or 3264 × 2176.

3 Press \( \text{\text{\text{trimming}}} \).

4 Press \( \text{\text{\text{trimming}}} \) to select OK, then press \( \text{\text{\text{trimming}}} \).
   • OK Saves the current trimming size and returns to the single-frame reservation screen.
   • RESET Sets a new trimming size. → Step 2
   • CANCEL Cancels the current trimming setting and returns to the single-frame reservation screen.

5 Press \( \text{\text{\text{trimming}}} \) to complete the print reservations and return to the picture selection screen. Press \( \text{\text{\text{trimming}}} \) again.
6 Press  to select END.

- The PRINT ORDER screen appears.
- Press again to display the PRINT ORDER SETTING screen, then press once more to complete the print reservations.

Note

- The size of the printed picture varies depending on the printer settings. If the trimmed picture size is small, printing magnification increases accordingly, resulting in a printed picture with lower resolution.
- For best results with close-up prints, you are recommended to use the TIFF, SHQ or HQ mode.
- The original picture is not trimmed. If your printer does not have a trimming feature, the picture will be printed untrimmed.
- Do not rotate pictures that have been trimmed, otherwise the cropped area will change.
This function allows you to reset the print reservation data for pictures stored on the card. You can reset all the print reservation data or just for selected pictures.

**Resetting all print reservation data**

1. **Press **
   - The PRINT ORDER SETTING screen appears.

2. Press  to select RESET, then press .

3. Press  to exit the menu.
To reset the print reservation data for a selected picture

1 Press ．

2 Press  to select KEEP and press ．
   • If there is no print reservation data stored on the card, the PRINT ORDER SETTING screen does not appear.

3 Press  to select ，then press ．

4 Select the frame for which you want to reset the print reservation data using the arrow pad or the control dial and press ．
   • The single-frame reservation menu is displayed.

5 Press  to select CANCEL．
   • The print reservation data is canceled and the screen returns to Step 4．

6 If you have finished canceling print reservation data, press ．
   • The single-frame reservation menu is displayed．

7 Press  to select END．
   • Press  repeatedly to return to the playback screen．
Using the direct printing function

By connecting the camera to a PictBridge-compatible printer with the USB cable, you can print out recorded pictures directly. With the camera connected to the printer, select the pictures you want to print and the number of prints on the camera’s monitor. It is also possible to print out pictures using the print reservation data. “Print setting (DPOF)” (P.176)

To find out if your printer is compatible with PictBridge, refer to the printer’s instruction manual.

What is PictBridge? … It is the standard for connecting digital cameras and printers of different makers and printing out pictures directly.

STANDARD … All printers that support PictBridge have standard print settings. Selecting STANDARD on the setting screens (P.189 to 195), images are printed according to these settings. See the instruction manual for your printer for its standard settings or inquire of the printer manufacturers.

Note

• You are recommended to use the optional AC adapter when printing pictures. If you use the battery, make sure that it is fully charged. If the camera stops operating while communicating with the printer, the printer may malfunction or image data may be lost.
• Images recorded in RAW data and movies cannot be printed.
• The camera will not enter sleep mode when connected to the USB cable.
Connecting the camera to a printer

Use the USB cable provided to connect the camera to a PictBridge-compatible printer.

1 **Set the camera’s USB mode to PRINT.**
   - “USB setup – Setting the connection destination” (P.175)
   - Make sure the card containing the pictures you want to print is selected.

2 **Turn the printer on and plug the printer end of the USB cable into the printer’s USB port.**
   - For details of how to turn the printer on and the position of the USB port, refer to the printer’s instruction manual.

3 **Set the camera’s mode dial to `Q` and plug the USB cable into the camera’s USB connector.**

4 **Press the power switch to turn the camera on.**
   - ONE MOMENT is displayed and the camera and printer are connected. The PRINT MODE SELECT screen is displayed on the monitor. Make the print settings on the camera’s monitor. Go to “Printing pictures” (P.188).

- When the USB mode is set to PC, the PRINT MODE SELECT screen is not displayed. Remove the USB cable, and repeat the procedure from Step 1.

   ![Connector cover](image_url)
   ![USB connector](image_url)
   ![Power switch](image_url)

Note
Printing pictures

When the camera is connected correctly to a PictBridge-compatible printer, the PRINT MODE SELECT screen is displayed on the monitor. Use this screen to select the print mode. You can choose from the following print modes.

- **PRINT**
  Prints the selected picture.
  [“PRINT/MULTI PRINT” (P.190)]

- **ALL PRINT**
  Prints all the pictures stored on the card.
  [“ALL PRINT” (P.193)]

- **MULTI PRINT**
  Prints one picture in multiple layout format.
  [“PRINT/MULTI PRINT” (P.190)]

- **ALL INDEX**
  Prints an index of all the pictures stored on the card.
  [“ALL INDEX mode/PRINT ORDER mode” (P.195)]

- **PRINT ORDER**
  Prints the pictures according to the print reservation data on the card. If no print reservations (P.176) have been made, this option is not available.
  [“ALL INDEX mode/PRINT ORDER mode” (P.195)]

---

**PRINT modes and each setting**

Available printing modes, paper sizes etc., vary depending on the printer you use. Please consult with the services of your printer’s manufacture or to the printer manual.
Easy printing

The method described below is the easiest way to print out pictures. The selected picture is printed without the date, time or file name.

1 In the PRINT MODE SELECT screen (P.188), press \( \textcircled{a} \textcircled{b} \) to select PRINT, then press \( \textcircled{c} \).
   - The PRINT PAPER screen is displayed.

2 Press \( \textcircled{a} \textcircled{b} \) to select the paper size, then press \( \textcircled{d} \).
   - When the PRINT PAPER screen is not displayed, SIZE, BORDERLESS and PICS/SHEET are set to \( \textcircled{e} \) STANDARD. → Go to Step 4.

3 Use \( \textcircled{a} \textcircled{b} \) to select framed or unframed, then press \( \textcircled{e} \).
   - OFF ( ) The image is printed inside a blank frame.
   - ON ( ) The image is printed filling the entire page.

4 Press \( \textcircled{a} \textcircled{b} \) or turn the control dial to select the picture you want to print and press \( \textcircled{f} \).
   - The PRINT screen is displayed.

5 Press \( \textcircled{a} \textcircled{b} \) to select OK, then press \( \textcircled{g} \).
   - Printing starts.
   - To cancel printing, select CANCEL and press \( \textcircled{h} \). The PRINT MODE SELECT screen is displayed.
   - When printing is finished, the screen returns to Step 4. Repeat Steps 4 and 5 and print all the pictures you want to print.
PRINT/MULTI PRINT

1 In the PRINT MODE SELECT screen, press \( \rightarrow \rightarrow \) to select PRINT or MULTI PRINT, then press \( \circ \).
   - The PRINT PAPER screen is displayed.

2 Press \( \rightarrow \rightarrow \) to select the paper size, then press \( \circ \).
   - PRINT mode:
     \( \rightarrow \) Go to Step 3.
   - MULTI PRINT mode:
     \( \rightarrow \) Go to Step 4.
   - When the PRINT PAPER screen is not displayed, SIZE, BORDERLESS and PICS/SHEET are set to \( \rightarrow \) STANDARD. \( \rightarrow \) Go to Step 5.

3 Use \( \rightarrow \rightarrow \) to select framed or unframed, then press \( \circ \). \( \rightarrow \) Go to step 5.

   OFF (\( \square \)) The image is printed inside a blank frame.
   ON (\( \square \)) The image is printed filling the entire page.

4 Press \( \rightarrow \rightarrow \) to select PICS/SHEET, then press \( \circ \).
   - PICS/SHEET depends on the paper size set in Step 2 and the capabilities of your printer.

5 Press \( \circ \circ \) or turn the control dial to select the picture you want to print.
   - Turn the zoom lever toward W to display the picture in index format. You can then select the pictures you want to print from the index.
6 Select the print reservation method.
   SINGLE PRINT  Makes a single-frame print reservation for the selected picture according to standard settings.
   MORE          Sets the number of prints of the selected picture in the print reservation data. You can also add the date or file name, and trim the picture.

Set a SINGLE PRINT reservation

Press  
   - Press  when the picture with  is displayed to cancel the reservation.

Set MORE print reservations

1  Press  .
   - The Print information settings screen is displayed.

2  Press  to select the item you want to set, then press  .
   - Press  to select the item, then press  .

   Sets the number of prints. You can select up to 10 prints.
   DATE ( )  If you select WITH, pictures are printed with the date and time.
   FILE NAME ( )  If you select WITH, pictures are printed with the file name.
   Crops part of a recorded picture so that only the enlarged section is printed.

   “Trim the picture” (P.197)

   DATE and FILE NAME are not available in MULTI PRINT mode.
When you have finished all the settings for MORE, press \( \text{\( \rightarrow \)\}} \).
- The screen displayed in Step 5 appears.
- To print more than one picture in PRINT and/or MULTI PRINT mode, repeat Steps 5 and 6 and make single and/or multiple print reservations for all the pictures you want to print.
- \( \text{\( \rightarrow \)\} \) is displayed in MULTI PRINT mode.

7 Press \( \text{\( \rightarrow \)\}} \).
- The PRINT screen is displayed.

8 Print the pictures.
- Press \( \text{\( \rightarrow \)\} \to \text{\( \rightarrow \)\}} \) to select OK or CANCEL, then press \( \text{\( \rightarrow \)\}} \).

**OK** Printing starts.
**CANCEL** The settings are canceled and the monitor returns to the PRINT MODE SELECT screen.

- When printing is finished, the monitor returns to the PRINT MODE SELECT screen.
  “Exiting direct printing” (P.198)

**To cancel printing**
Pressing \( \text{\( \rightarrow \)\}} \) during print data transfer displays the screen for selecting whether to continue or cancel printing. To cancel printing, press \( \text{\( \rightarrow \)\} \to \text{\( \rightarrow \)\}} \) to select CANCEL, then press \( \text{\( \rightarrow \)\}} \).
**ALL PRINT**

1. In the PRINT MODE SELECT screen, press ø ø to select ALL PRINT, then press ő.
   - The PRINT PAPER screen is displayed.

2. Press ø ø to select the paper size, then press ő.
   - When the PRINT PAPER screen is not displayed, SIZE and BORDERLESS are set to ø STANDARD. → Go to Step 4.

3. Use ø ø to select framed or unframed, then press ő.

   - OFF ( ) The image is printed inside a blank frame.
   - ON ( ) The image is printed filling the entire page.
   - The PRINT INFO screen is displayed.

4. Press ø ø to select the item you want to set, then press ő.
   - Press ø ø to select the item, then press ő.
   - If PRINT INFO cannot be set with your printer, go to Step 6.
   - Only one print can be made at a time.

   - DATE ( ) If you select WITH, pictures are printed with the date and time.
   - FILE NAME ( ) If you select WITH, pictures are printed with the file name.
5 Press 🌼.
   • The PRINT screen is displayed.

6 Print the pictures.
   • Press 🌼🌼 to select OK or CANCEL, then press 🌼.

   OK  Printing starts.
   CANCEL  The settings are canceled and the monitor returns to the PRINT MODE SELECT screen.

   • When printing is finished, the monitor returns to the PRINT MODE SELECT screen.

   “Exiting direct printing” (P.198)

To cancel printing
Pressing 🌼 during print data transfer displays the screen for selecting whether to continue or cancel printing. To cancel printing, press 🌼🌼 to select CANCEL, then press 🌼.
ALL INDEX mode/PRINT ORDER mode

1. In the PRINT MODE SELECT screen, press \( \text{All} \) \( \text{Index} \) to select ALL INDEX or PRINT ORDER, then press \( \text{OK} \).
   - The PRINT PAPER screen is displayed.

2. Press \( \text{All} \) \( \text{Index} \) to select the paper size, then press \( \text{OK} \).
   - When the PRINT PAPER screen is not displayed, SIZE and BORDERLESS are set to \( \text{Standard} \).
   - Go to Step 4.

3. Use \( \text{All} \) \( \text{Index} \) to select framed or unframed, then press \( \text{OK} \).
   - OFF \( \text{No Border} \)  The image is printed inside a blank frame.
   - ON \( \text{Border} \)  The image is printed filling the entire page.
   - The PRINT screen is displayed.
   - BORDERLESS is not available in ALL INDEX mode.
   - Press \( \text{Cancel} \) and go to Step 4.

4. Print the pictures.
   - Press \( \text{OK} \) to select OK or CANCEL, then press \( \text{OK} \).
     - OK Printing starts.
     - CANCEL The settings are canceled and the monitor returns to the PRINT MODE SELECT screen.
   - When printing is finished, the monitor returns to the PRINT MODE SELECT screen.
     - “Exiting direct printing” (P.198)
To cancel printing
Pressing 🕒 during print data transfer displays the screen for selecting whether to continue or cancel printing. To cancel printing, press 🕒 🕒 to select CANCEL, then press 🕒.
Trim the picture

To set trimming by MORE in PRINT or MULTI PRINT mode, follow the procedure below.

1 **Use the arrow pad and zoom lever to select the trimming position and size.**
   - Press \( \leftarrow \) \( \rightarrow \) \( \uparrow \) \( \downarrow \) to select the trimming frame, and turn the zoom lever toward W or T to decide the trimming size.
   - Use the control dial to select the height and width of the trimming frame.
   - 3:2 trimming size can be selected when the size of the selected picture is \( 3264 \times 2448 \) or \( 3264 \times 2176 \).
   - If trimming has already been set, the \( \square \) screen appears. Press \( \leftarrow \) \( \rightarrow \) \( \uparrow \) \( \downarrow \) to select RESET, then press \( \square \).

2 **Press \( \square \).**

3 **Press \( \leftarrow \) \( \rightarrow \) to select OK, then press \( \square \).**
   - **OK** Saves the current trimming size.
   - **RESET** Sets a new trimming size.
   - **CANCEL** Cancels the current trimming setting.
   - Press \( \square \) to complete trimming setting and return to the PRINT INFO screen.

**Note**
- The size of the printed picture varies depending on the printer settings. If the trimmed picture size is small, printing magnification increases accordingly, resulting in a printed picture with lower resolution.
- For best results with close-up prints, you are recommended to use the TIFF, SHQ or HQ mode.
Exiting direct printing

When you have finished printing, disconnect the camera from the printer.

1. In the PRINT MODE SELECT screen, press \( \textcircled{A} \).

   • A message is displayed.

2. Press the power switch to turn the camera off.

3. Remove the USB cable from the camera.

4. Remove the USB cable from the printer.
If an error code appears on the camera’s monitor during direct print setting or printing, see the following table.
For more details, refer to the printer’s instruction manual.

<table>
<thead>
<tr>
<th>Monitor indication</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="camera.png" alt="Camera" /></td>
<td>The camera is not connected to the printer correctly.</td>
<td>Disconnect the camera and connect it again correctly.</td>
</tr>
<tr>
<td><img src="paper.png" alt="Paper" /></td>
<td>There is no paper in the printer.</td>
<td>Load some paper in the printer.</td>
</tr>
<tr>
<td><img src="ink.png" alt="Ink" /></td>
<td>The printer has run out of ink.</td>
<td>Replace the ink cartridge in the printer.</td>
</tr>
<tr>
<td><img src="jam.png" alt="Jam" /></td>
<td>The paper is jammed.</td>
<td>Remove the jammed paper.</td>
</tr>
<tr>
<td><img src="settings.png" alt="Settings" /></td>
<td>The printer's paper cassette has been removed or the printer has been manipulated while making settings on the camera.</td>
<td>Do not manipulate the printer while making settings on the camera.</td>
</tr>
<tr>
<td><img src="print.png" alt="Print" /></td>
<td>There is a problem with the printer and/or camera.</td>
<td>Turn off the camera and printer. Check the printer and remedy any problems before turning the power on again.</td>
</tr>
</tbody>
</table>

**TIPS**

- If an error code other than those shown above is displayed, refer to “Error codes” (P.200).
## Error codes

<table>
<thead>
<tr>
<th>Monitor indication</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>![NO CARD]</td>
<td>The card is not inserted, or it cannot be recognized.</td>
<td>Insert a card or insert a different card. If the problem persists, format the card. If the card cannot be formatted, it cannot be used.</td>
</tr>
<tr>
<td>![CARD ERROR]</td>
<td>There is a problem with the card.</td>
<td>This card cannot be used. Insert a new card.</td>
</tr>
<tr>
<td>![WRITE-PROTECT]</td>
<td>Writing to the card is prohibited.</td>
<td>The recorded image has been protected (read-only) on a PC. Download the image to a PC and cancel the read-only setting.</td>
</tr>
<tr>
<td>![CARD FULL]</td>
<td>The card is full. No more pictures, movies or information such as print reservations can be recorded.</td>
<td>Replace the card or erase unwanted pictures. Before erasing, download important images to a PC.</td>
</tr>
<tr>
<td>![NO PICTURE]</td>
<td>There are no pictures on the card.</td>
<td>The card contains no pictures. Record pictures.</td>
</tr>
<tr>
<td>![PICTURE ERROR]</td>
<td>There is a problem with the selected picture and it cannot be played back on this camera.</td>
<td>Use image processing software to view the picture on a PC. If that cannot be done, the image file is damaged.</td>
</tr>
<tr>
<td>![CARD COVER OPEN]</td>
<td>The card cover is open.</td>
<td>Close the card cover.</td>
</tr>
<tr>
<td>![FILE SIZE SELECTED TOO LARGE]</td>
<td>Files with a volume of 57 MB or over (movies of over approx. 64 sec. (SHQ), 70 sec. (HQ) or 685 sec. (SQ)) cannot be copied.</td>
<td>Avoid selecting movies of the type listed left for copying.</td>
</tr>
</tbody>
</table>
## Troubleshooting

### Preparatory operations

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The camera does not turn on or function buttons do not respond.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The power is off.</td>
<td>Press the power switch to turn the camera on.</td>
<td>P.25</td>
</tr>
<tr>
<td>The battery is exhausted.</td>
<td>Charge the battery.</td>
<td>P.17</td>
</tr>
<tr>
<td>The battery is temporarily unable to function because of the cold.</td>
<td>Warm the battery by putting it in your pocket for a while.</td>
<td>—</td>
</tr>
<tr>
<td>The camera is in the sleep mode.</td>
<td>Operate the camera (press the shutter button or the zoom lever).</td>
<td>P.26</td>
</tr>
<tr>
<td>The camera is connected to a PC.</td>
<td>The camera will not operate while it is connected to a PC.</td>
<td>—</td>
</tr>
</tbody>
</table>

### Shooting

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>No picture is taken when the shutter button is pressed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The battery is exhausted.</td>
<td>Charge the battery.</td>
<td>P.17</td>
</tr>
<tr>
<td>The camera is in the playback mode.</td>
<td>Set the mode dial to any position except Q.</td>
<td>P.50</td>
</tr>
<tr>
<td>The flash has not finished charging.</td>
<td>Remove your finger from the shutter button, and wait until # stops blinking. Press the shutter button again.</td>
<td>P.50, 60</td>
</tr>
<tr>
<td>The card is full.</td>
<td>Erase unwanted pictures or insert a new card. Before erasing, download important images to a PC.</td>
<td>P.143</td>
</tr>
<tr>
<td>The battery ran out of power during shooting or while the images were being written to the card. (The battery check indicator only blinks.)</td>
<td>Charge the battery. (Wait until the card access lamp turns off when flashing.)</td>
<td>P.17</td>
</tr>
<tr>
<td>The memory gauge is full.</td>
<td>Wait until there is room in the memory gauge.</td>
<td>P.14</td>
</tr>
<tr>
<td>There is a problem with the card.</td>
<td>Refer to “Error codes”.</td>
<td>P.200</td>
</tr>
<tr>
<td>The viewfinder does not turn on.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The monitor is turned on.</td>
<td>Press  to turn the viewfinder on.</td>
<td>P.50</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The monitor does not turn on.</td>
<td>The viewfinder is turned on.</td>
<td>Press ( ) to turn the monitor on.</td>
</tr>
<tr>
<td>The viewfinder or monitor is hard to see.</td>
<td>The diopter is not adjusted properly.</td>
<td>Adjust the diopter so that the AF target mark is clearly visible.</td>
</tr>
<tr>
<td></td>
<td>There is condensation* inside the camera.</td>
<td>Wait until the camera dries before turning it on again.</td>
</tr>
</tbody>
</table>

* Condensation: When it is cold outside, the water vapor in the air is rapidly cooled and turns to droplets of water. Condensation occurs when the camera is suddenly taken from a cold place into a warm room.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The brightness of the viewfinder or monitor is not adjusted properly.</td>
<td>Select ( ) in the SETUP tab and adjust the brightness.</td>
<td>P.173</td>
</tr>
<tr>
<td>The monitor is exposed to direct sunlight.</td>
<td>Position the monitor in the down position or block the sunlight with your hand.</td>
<td>—</td>
</tr>
<tr>
<td>Vertical lines appear in the viewfinder or on the monitor screen during shooting.</td>
<td>Aiming the camera at a bright subject in sunlight may cause vertical lines to appear on the screen. This is not a malfunction.</td>
<td>—</td>
</tr>
<tr>
<td>The date recorded with the image data is wrong.</td>
<td>The date/time is not set.</td>
<td>Set the date/time. The clock adjustment is not factory-preset.</td>
</tr>
<tr>
<td></td>
<td>The camera has been left with the battery removed.</td>
<td>If the camera is left for a few days with the battery removed, the date/time setting is canceled. Set the date/time again.</td>
</tr>
<tr>
<td>The settings are returned to the factory default settings when the camera is turned off.</td>
<td>ALL RESET is set to ON.</td>
<td>Set ALL RESET in the ( ) tab to OFF.</td>
</tr>
<tr>
<td>The picture is out of focus.</td>
<td>The subject is too close.</td>
<td>Position the camera more than 0.2 m/0.7 ft. from the subject and take the picture. To take pictures closer than 0.2 m/0.7 ft., use the super macro mode.</td>
</tr>
<tr>
<td></td>
<td>Auto focus is not possible.</td>
<td>Use manual focus or focus lock to focus on the subject and then shoot.</td>
</tr>
<tr>
<td></td>
<td>The subject is dark.</td>
<td>Turn the AF illuminator on.</td>
</tr>
<tr>
<td></td>
<td>There is condensation on the lens.</td>
<td>Wait until the camera dries before turning it on again.</td>
</tr>
<tr>
<td>Possible cause</td>
<td>Corrective action</td>
<td>Ref. page</td>
</tr>
<tr>
<td>---------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>The monitor goes off.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The camera is in the sleep mode.</td>
<td>Operate the camera (press the shutter button or the zoom lever).</td>
<td>P.26</td>
</tr>
<tr>
<td>The power is turned off with the monitor off.</td>
<td>If ALL RESET in the tab is set to OFF, the camera settings before the power was turned off remain unchanged. Turn on the monitor, and turn off the power.</td>
<td>P.50, 145</td>
</tr>
<tr>
<td>The flash does not fire.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The flash is closed.</td>
<td>Press the flash pop-up button to make the flash pop up.</td>
<td>P.59</td>
</tr>
<tr>
<td>The flash is set to the flash off mode.</td>
<td>Select a flash mode other than .</td>
<td>P.59</td>
</tr>
<tr>
<td>The subject is illuminated.</td>
<td>If you want the flash to fire on a brightly illuminated subject, set the flash to .</td>
<td>P.59</td>
</tr>
<tr>
<td>Sequential shooting (HI, AF, BKT) is set.</td>
<td>The flash does not fire in the sequential shooting mode. Set in the menu.</td>
<td>P.92</td>
</tr>
<tr>
<td>The camera is in the movie mode.</td>
<td>The flash does not fire in the mode. Set a different shooting mode.</td>
<td>P.55</td>
</tr>
<tr>
<td>Super macro mode is set.</td>
<td>The flash does not fire in the super macro mode. Cancel the super macro mode.</td>
<td>P.88</td>
</tr>
<tr>
<td>Panorama mode is set.</td>
<td>The flash does not fire in the panorama mode. Cancel the panorama mode.</td>
<td>P.95</td>
</tr>
<tr>
<td>The battery run time is brief.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>You are using the camera in a cold environment.</td>
<td>Battery performance deteriorates in low temperatures. Keep the camera warm by putting it inside your coat or clothing.</td>
<td>—</td>
</tr>
<tr>
<td>The remaining battery power is not indicated correctly.</td>
<td>When battery consumption fluctuates considerably, the camera may turn off without displaying the battery warning indicator. Charge the battery.</td>
<td>P.14, 17</td>
</tr>
</tbody>
</table>
## Playback

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The picture is out of focus.</td>
<td>A subject unsuited to AF was taken. Use manual focus or focus lock to focus on the subject and then shoot.</td>
<td>P.53, 79</td>
</tr>
<tr>
<td>The camera moved when the shutter button was pressed.</td>
<td>Hold the camera correctly and press the shutter button gently.</td>
<td>P.28</td>
</tr>
<tr>
<td>The flash was closed or was set to the flash off mode in a lighting condition requiring use of the flash.</td>
<td>Press the flash pop-up button to make the flash pop up and select a flash mode other than 3. Camera movement occurs easily with slower shutter speeds. Use a tripod, or set the flash to AUTO.</td>
<td>P.59</td>
</tr>
<tr>
<td>The lens was dirty.</td>
<td>Clean the lens. Use a commercially available blower brush and then wipe with a lens cleaner to remove dust. Mold may form on the lens surface if the lens is left dirty.</td>
<td>P.219</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>The picture is too bright.</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>The flash was set to the 3 mode.</td>
<td>Select a flash mode other than 3.</td>
<td>P.59</td>
</tr>
<tr>
<td>The center of the subject is too dark.</td>
<td>If the center of the subject is too dark, the surrounding area emerges as too bright. Adjust the exposure compensation toward minus (-).</td>
<td>P.108</td>
</tr>
<tr>
<td>The ISO is at a high setting.</td>
<td>Set the ISO to AUTO or to a low sensitivity: 50</td>
<td>P.107</td>
</tr>
<tr>
<td>The aperture value is small in A (M) mode.</td>
<td>Increase the aperture value or set the camera to P mode.</td>
<td>P.70</td>
</tr>
<tr>
<td>The shutter speed setting is too slow in S (M) mode.</td>
<td>Increase the shutter speed or set the camera to P mode.</td>
<td>P.71</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>The picture is too dark.</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The flash was blocked by your finger.</td>
<td>Hold the camera correctly, keeping your fingers away from the flash.</td>
<td>P.28</td>
</tr>
<tr>
<td>The subject was out of the working range of the flash.</td>
<td>Shoot within the flash working range.</td>
<td>P.59</td>
</tr>
<tr>
<td>The flash was closed or was set to the  ( \Box ) mode.</td>
<td>Press the flash pop-up button to make the flash pop up and select a flash mode other than  ( \Box ).</td>
<td>P.59</td>
</tr>
<tr>
<td>The subject was too small and was backlit.</td>
<td>Set the flash mode to  ( $$ ), or use the spot metering mode.</td>
<td>P.59, 81</td>
</tr>
<tr>
<td>The sequential shooting mode was used.</td>
<td>Higher shutter speeds are used when the sequential shooting mode is selected, which may result in pictures that are darker than usual. Set  ( \Box ) in the sequential shooting menu.</td>
<td>P.92</td>
</tr>
<tr>
<td>The center of the subject is too bright.</td>
<td>If the center of the subject is too bright, the image as a whole emerges darker. Adjust the exposure compensation toward plus (+).</td>
<td>P.108</td>
</tr>
<tr>
<td>The aperture value setting is too high in  ( A (M) ) mode.</td>
<td>Decrease the aperture value or set the camera to  ( P ) mode.</td>
<td>P.70</td>
</tr>
<tr>
<td>The shutter speed setting is too fast in  ( S (M) ) mode.</td>
<td>Reduce the shutter speed or set the camera to  ( P ) mode.</td>
<td>P.71</td>
</tr>
<tr>
<td><strong>The colors of pictures look unnatural.</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Indoor lighting can affect the picture's colors.</td>
<td>Set the white balance according to the lighting.</td>
<td>P.109</td>
</tr>
<tr>
<td>No white in the picture.</td>
<td>Include something white in the picture, or set the flash mode to  ( $$ ).</td>
<td>P.59</td>
</tr>
<tr>
<td>The white balance setting is wrong.</td>
<td>Adjust the white balance according to the light source.</td>
<td>P.109</td>
</tr>
<tr>
<td>Filter was used.</td>
<td>The image may be discolored according to the filter used. Use the one-touch white balance function.</td>
<td>P.111</td>
</tr>
<tr>
<td><strong>Part of the picture is too dark</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The lens was partly blocked by your finger or the strap.</td>
<td>Hold the camera correctly, keeping your fingers and the strap away from the lens.</td>
<td>P.28</td>
</tr>
</tbody>
</table>
### Troubleshooting

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. page</th>
</tr>
</thead>
</table>
| **Halation produces unnatural colors in the picture.**                       | • Use a UV filter. As this may upset the overall color balance, it should only be used in the conditions described on the left.  
• Process the picture using a graphics application (Photoshop, Paint Shop Pro, etc.). For example, after picking up unnatural colors with a syringe tool, etc. you can select color areas, and try color conversion or saturation adjustment. For details, refer to the manual for the graphics application you are using. | —         |
| **Pictures you have taken do not appear on the monitor.**                    |                                                                                                                                                                                                                 | —         |
| The power is off.                                                             | Set the mode dial to before pressing the power switch to turn the camera on.                                                                                                                                    | P.121     |
| The camera is in the shooting mode.                                           | Press the QUICK VIEW button or set the mode dial to .                                                                                                                                                           | P.121, 122|
| There are no pictures on the card.                                            | NO PICTURE appears on the monitor. Record pictures.                                                                                                                                                             | —         |
| There is a problem with the card.                                            | Refer to “Error codes”.                                                                                                                                                                                          | P.200     |
| The camera is connected to a TV.                                              | The monitor does not function when the AV cable is connected to the camera.                                                                                                                                      | P.134     |
| **Single-frame erase and all-frame erase cannot be performed.**               |                                                                                                                                                                                                                 | —         |
| The pictures are protected.                                                   | Display pictures with and press button to cancel protection.                                                                                                                                                     | P.142     |
| **No picture is displayed on the TV when connected to the camera.**           |                                                                                                                                                                                                                 | —         |
| The video output signal is incorrect.                                         | Set the video output signal according to the region where used.                                                                                                                                                   | P.174     |
| The TV video signal setting is incorrect.                                     | Set the TV to the video input mode.                                                                                                                                                                              | P.134     |
| **The viewfinder or monitor is hard to see.**                                |                                                                                                                                                                                                                 | —         |
| The brightness of the viewfinder or monitor is not adjusted properly.         | Select in the SETUP tab and adjust the brightness.                                                                                                                                                              | P.173     |
| The monitor is exposed to direct sunlight.                                    | Position the monitor in the down position or block the sunlight with your hand.                                                                                                                                   | —         |
| **Illustrations and explanations are not displayed in English.**              |                                                                                                                                                                                                                 | —         |
| A language other than English has been selected for on-screen display.        | Select English for on-screen display.                                                                                                                                                                             | P.167     |
## Connection to a PC or Printer

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The camera is not recognized by the PC.</td>
<td></td>
<td>—</td>
</tr>
<tr>
<td>The USB driver is not installed.</td>
<td>It is necessary to install the USB driver for Windows 98/98SE. For installation instructions, see “OPERATION MANUAL” (Digital camera – PC connection) on the CD-ROM.</td>
<td>—</td>
</tr>
<tr>
<td>The camera has not been turned on.</td>
<td>Press the power switch to turn the camera on.</td>
<td>P.25</td>
</tr>
<tr>
<td>The printer is selected as the connection destination.</td>
<td>Set the USB option in the SETUP tab to PC.</td>
<td>P.175</td>
</tr>
<tr>
<td>The camera cannot be connected to the printer.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PC is selected as the connection destination.</td>
<td>Set the USB option in the SETUP tab to PRINT.</td>
<td>P.175</td>
</tr>
<tr>
<td>The camera or printer has not been turned on.</td>
<td>Turn the camera or printer on.</td>
<td>P.187</td>
</tr>
<tr>
<td>The printer does not support PictBridge.</td>
<td>Refer to the printer’s instruction manual or contact the manufacturer.</td>
<td>—</td>
</tr>
</tbody>
</table>
The shooting mode menus and playback menus for still pictures and movies are shown below.

### List of menus

<table>
<thead>
<tr>
<th>Top menu</th>
<th>Tab</th>
<th>Function</th>
<th>Sub-menu</th>
<th>Setting</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODE MENU</td>
<td>CAMERA</td>
<td>FLASH MODE</td>
<td>FLASH MODE</td>
<td>AUTO,</td>
<td>P.59</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-2.0 to +2.0</td>
<td>P.64</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>IN+,</td>
<td>P.66, 69</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>SLAVE</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>SLOW</td>
<td>P.63</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>SLOW1,</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>SLOW,</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>SLOW2</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>FOCUS MODE</td>
<td>AF, MF,</td>
<td>P.79, 87, 88</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>MF</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>AF MODE</td>
<td>iESP,</td>
<td>P.74</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>FULLTIME AF</td>
<td>OFF, ON</td>
<td>P.75</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>P-AF</td>
<td>OFF, ON</td>
<td>P.76</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ESP/</td>
<td>ESP,</td>
<td>P.81</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>MULTI,</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### List of menus

<table>
<thead>
<tr>
<th>PICTURE</th>
<th>AUTO</th>
<th>WB2, SET</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRESET 1</td>
<td>PRESET 1, WB2, SET</td>
<td></td>
</tr>
<tr>
<td>PRESET 2</td>
<td>PRESET 2, WB2, SET</td>
<td></td>
</tr>
<tr>
<td>CUSTOM</td>
<td>CUSTOM 1 to CUSTOM 4</td>
<td></td>
</tr>
<tr>
<td>RAW</td>
<td>OFF, SHQ, HQ, SQ1, SQ2</td>
<td></td>
</tr>
</tbody>
</table>

#### TIFF
- 3264 × 2448
- 3264 × 2176 (3:2)
- 2592 × 1944
- 2288 × 1712
- 2048 × 1536
- 1600 × 1200
- 1280 × 960
- 1024 × 768
- 640 × 480

#### SHQ
- 3264 × 2448
- 3264 × 2176 (3:2)

#### HQ
- 3264 × 2448
- 3264 × 2176 (3:2)

#### SQ1
- 2592 × 1944
- 2288 × 1712
- 2048 × 1536

#### SQ2
- 1600 × 1200
- 1280 × 960
- 1024 × 768
- 640 × 480

#### SCENE MODES *2
- NORMAL, 📷, 🎥, 🎥

#### SHARPNESS
- –5 to +5

#### CONTRAST
- –5 to +5

#### HUE
- –5 to +5

#### SATURATION
- –5 to +5

#### CARD
- CARD SETUP
- YES, NO
<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Options</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL RESET *4</td>
<td>OFF, ON</td>
<td>P.145</td>
</tr>
<tr>
<td>REC VIEW</td>
<td>OFF, AUTO, 3 SEC, 5 SEC, 10 SEC</td>
<td>P.147</td>
</tr>
<tr>
<td>BEEP</td>
<td>OFF, 1, 2</td>
<td>P.148</td>
</tr>
<tr>
<td>SHUTTER SOUND</td>
<td>OFF, 1, 2</td>
<td>P.149</td>
</tr>
<tr>
<td>DIAL</td>
<td>NORMAL, CUSTOM 1 to CUSTOM 3</td>
<td>P.150</td>
</tr>
<tr>
<td>EV STEP</td>
<td>1/3EV, 1/2EV</td>
<td>P.153</td>
</tr>
<tr>
<td>CUSTOM BUTTON</td>
<td></td>
<td>P.154</td>
</tr>
<tr>
<td>SHORT CUT</td>
<td></td>
<td>P.157</td>
</tr>
<tr>
<td>MY MODE SETUP</td>
<td>CURRENT MY MODE 1 to MY MODE 8</td>
<td>P.160, 161</td>
</tr>
<tr>
<td></td>
<td>RESET MY MODE 1 to MY MODE 8</td>
<td>P.160, 162</td>
</tr>
<tr>
<td></td>
<td>CUSTOM MY MODE 1 to MY MODE 8</td>
<td>P.160, 162</td>
</tr>
<tr>
<td>CONTROL PANEL</td>
<td>OFF, ON</td>
<td>P.163</td>
</tr>
</tbody>
</table>

*1 Cannot be selected in mode.
*2 Cannot be selected in mode.
*3 Can be selected only in mode.
*4 Cannot be selected in mode.
*5 The function registered in the shortcut menu is displayed.
<table>
<thead>
<tr>
<th>Top menu</th>
<th>Tab</th>
<th>Function</th>
<th>Sub-menu</th>
<th>Setting</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODE MENU</td>
<td>CAMERA</td>
<td>AF/*MF</td>
<td>FOCUS MODE</td>
<td>AF, •, •</td>
<td>P.87, 88</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>FULLTIME AF</td>
<td>OFF, ON</td>
<td>P.75</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ESP/*</td>
<td>ESP, •, •</td>
<td>P.81</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>***</td>
<td>OFF, •, •</td>
<td>P.89, 90</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FUNCTION</td>
<td></td>
<td>OFF, BLACK &amp; WHITE, SEPIA</td>
<td>P.98</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FRAME ASSIST</td>
<td></td>
<td>OFF, ON</td>
<td>P.99</td>
</tr>
<tr>
<td></td>
<td>PICTURE</td>
<td>WB</td>
<td>AUTO</td>
<td>WB*, SET</td>
<td>P.109, 112, 113</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PRESET 1</td>
<td>PRESET 1, WB*, SET</td>
<td>P.110, 112, 113</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PRESET 2</td>
<td>PRESET 2, WB*, SET</td>
<td>P.110, 112, 113</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CUSTOM</td>
<td>CUSTOM 1 to CUSTOM 4</td>
<td>WB*, SET</td>
<td>P.111</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CUSTOM 1</td>
<td>GO, ADJUST, SET</td>
<td>P.111, 112, 113</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SHQ, HQ, SQ</td>
<td>OFF, ON</td>
<td>P.105, 117</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SCENE MODES</td>
<td>NORMAL, *, #</td>
<td>OFF, ON</td>
<td>P.114, 117</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SHARPNESS</td>
<td>–5 to +5</td>
<td>OFF, ON</td>
<td>P.114</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CONTRAST</td>
<td>–5 to +5</td>
<td>OFF, ON</td>
<td>P.115</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HUE</td>
<td>–5 to +5</td>
<td>OFF, ON</td>
<td>P.116</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SATURATION</td>
<td>–5 to +5</td>
<td>OFF, ON</td>
<td>P.117</td>
</tr>
<tr>
<td></td>
<td>CARD</td>
<td>CARD SETUP</td>
<td>YES, NO</td>
<td>OFF, ON</td>
<td>P.166</td>
</tr>
<tr>
<td></td>
<td>ALL RESET</td>
<td>OFF, ON</td>
<td>OFF, AUTO, 3 SEC, 5 SEC, 10 SEC</td>
<td>OFF, ON</td>
<td>P.145</td>
</tr>
<tr>
<td></td>
<td>REC VIEW</td>
<td>OFF, 1, 2</td>
<td>OFF, AUTO, 3 SEC, 5 SEC, 10 SEC</td>
<td>OFF, ON</td>
<td>P.147</td>
</tr>
<tr>
<td></td>
<td>BEEP</td>
<td>OFF, 1, 2</td>
<td>OFF, AUTO, 3 SEC, 5 SEC, 10 SEC</td>
<td>OFF, ON</td>
<td>P.148</td>
</tr>
<tr>
<td></td>
<td>DIAL</td>
<td>NORMAL, CUSTOM 1 to CUSTOM 3</td>
<td>OFF, AUTO, 3 SEC, 5 SEC, 10 SEC</td>
<td>OFF, ON</td>
<td>P.150</td>
</tr>
<tr>
<td></td>
<td>EV STEP</td>
<td>1/3EV, 1/2EV</td>
<td>1/3EV, 1/2EV</td>
<td>OFF, ON</td>
<td>P.153</td>
</tr>
<tr>
<td></td>
<td>CUSTOM BUTTON</td>
<td>1/3EV, 1/2EV</td>
<td>1/3EV, 1/2EV</td>
<td>OFF, ON</td>
<td>P.154</td>
</tr>
<tr>
<td></td>
<td>CONTROL PANEL</td>
<td>1/3EV, 1/2EV</td>
<td>1/3EV, 1/2EV</td>
<td>OFF, ON</td>
<td>P.163</td>
</tr>
<tr>
<td></td>
<td>ISO</td>
<td>AUTO, 50 to 100</td>
<td>AUTO, 50 to 100</td>
<td>OFF, ON</td>
<td>P.101, 107</td>
</tr>
<tr>
<td></td>
<td>DIGITAL ZOOM</td>
<td>OFF, ON</td>
<td>OFF, ON</td>
<td>OFF, ON</td>
<td>P.58</td>
</tr>
</tbody>
</table>
### Playback mode (still pictures)

<table>
<thead>
<tr>
<th>Top menu</th>
<th>Tab</th>
<th>Function</th>
<th>Sub-menu</th>
<th>Setting</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODE MENU</td>
<td>EDIT</td>
<td>RAW DATA EDIT</td>
<td></td>
<td>TIFF, SHQ, HQ, SQ1, SQ2</td>
<td>P.140</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>–5 to +5</td>
<td>P.140</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>WB AUTO, PRESET 1, PRESET 2, CUSTOM,</td>
<td>P.140</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>RED 7 to BLUE 7</td>
<td>P.140</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SCENE MODES</td>
<td>FUNCTION</td>
<td>OFF, BLACK &amp; WHITE, SEPIA</td>
<td>P.140</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>640 × 480, 320 × 240, CANCEL</td>
<td>P.138</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COPY</td>
<td>NEW FILE, CANCEL</td>
<td>P.139</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CARD SETUP</td>
<td>ALL ERASE, FORMAT</td>
<td>P.144, 166</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ALL RESET</td>
<td>OFF, ON</td>
<td>P.145</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BEEP</td>
<td>OFF, 1, 2</td>
<td>P.148</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>VOLUME</td>
<td>0 to 5</td>
<td>P.165</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>GAIN</td>
<td>4, 9, 16</td>
<td>P.126</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BEEP</td>
<td>OFF, ON</td>
<td>P.127</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CARD SETUP</td>
<td>OFF, ON</td>
<td>P.136</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CARD SETUP</td>
<td>OFF, ON</td>
<td>P.137</td>
<td></td>
</tr>
</tbody>
</table>
## Playback mode (movies)

<table>
<thead>
<tr>
<th>Top menu</th>
<th>Tab</th>
<th>Function</th>
<th>Sub-menu</th>
<th>Setting</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODE MENU</td>
<td>CARD</td>
<td>CARD SETUP</td>
<td></td>
<td>ALL ERASE, FORMAT</td>
<td>P.144, 166</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ALL RESET</td>
<td>OFF, ON</td>
<td></td>
<td>P.145</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BEEP</td>
<td>OFF, 1, 2</td>
<td></td>
<td>P.148</td>
</tr>
<tr>
<td></td>
<td></td>
<td>VOLUME</td>
<td>0 to 5</td>
<td></td>
<td>P.165</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▼</td>
<td>4, 9, 16</td>
<td></td>
<td>P.126</td>
</tr>
<tr>
<td>MOVIE PLAY</td>
<td></td>
<td></td>
<td>MOVIE PLAYBACK, INDEX, EDIT</td>
<td></td>
<td>P.128</td>
</tr>
<tr>
<td>COPY</td>
<td></td>
<td></td>
<td>ALL, SELECT</td>
<td></td>
<td>P.141</td>
</tr>
<tr>
<td>Top menu</td>
<td>Tab</td>
<td>Function</td>
<td>Sub-menu</td>
<td>Setting</td>
<td>Ref. page</td>
</tr>
<tr>
<td>----------</td>
<td>-----</td>
<td>----------</td>
<td>----------</td>
<td>---------</td>
<td>-----------</td>
</tr>
<tr>
<td>CARD</td>
<td></td>
<td>CARD SETUP</td>
<td>YES, NO</td>
<td></td>
<td>P.166</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ALL RESET</td>
<td>OFF, ON</td>
<td></td>
<td>P.145</td>
</tr>
<tr>
<td></td>
<td></td>
<td>REC VIEW</td>
<td>OFF, AUTO, 3 SEC, 5 SEC, 10 SEC</td>
<td></td>
<td>P.147</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BEEP</td>
<td>OFF, 1, 2</td>
<td></td>
<td>P.148</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SHUTTER SOUND</td>
<td>OFF, 1, 2</td>
<td></td>
<td>P.149</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DIAL</td>
<td>NORMAL, CUSTOM 1 to CUSTOM 3</td>
<td></td>
<td>P.150</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EV STEP</td>
<td>1/3EV, 1/2EV</td>
<td></td>
<td>P.153</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CUSTOM BUTTON</td>
<td></td>
<td></td>
<td>P.154</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SHORT CUT</td>
<td></td>
<td></td>
<td>P.157</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MY MODE SETUP</td>
<td>RESET</td>
<td></td>
<td>P.160, 162</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>MY MODE 1 to MY MODE 8</td>
<td></td>
<td>P.160, 162</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CUSTOM</td>
<td>MY MODE 1 to MY MODE 8</td>
<td>P.160, 162</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CONTROL PANEL</td>
<td>OFF, ON</td>
<td></td>
<td>P.163</td>
</tr>
<tr>
<td></td>
<td></td>
<td>VOLUME</td>
<td>0 to 5</td>
<td></td>
<td>P.165</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4, 9, 16</td>
<td></td>
<td>P.126</td>
</tr>
<tr>
<td>SETUP</td>
<td></td>
<td></td>
<td>ENGLISH, FRANCAIS, DEUTSCH, ESPAÑOL, ITALIANO, РУССКИЙ, PORTUGUES, 日本語</td>
<td>P.167</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>P.168</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>OFF, LOW, HIGH</td>
<td></td>
<td>P.169</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SLEEP</td>
<td>30 SEC, 1 MIN, 3 MIN, 5 MIN, 10 MIN</td>
<td></td>
<td>P.169</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FILE NAME</td>
<td>RESET, AUTO</td>
<td></td>
<td>P.170</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BATTERY SAVE</td>
<td>OFF, ON</td>
<td></td>
<td>P.171</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PIXEL MAPPING</td>
<td>START</td>
<td></td>
<td>P.172</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>P.173</td>
</tr>
<tr>
<td></td>
<td></td>
<td>m/ft</td>
<td>m, ft</td>
<td></td>
<td>P.173</td>
</tr>
<tr>
<td></td>
<td></td>
<td>VIDEO OUT</td>
<td>NTSC, PAL</td>
<td></td>
<td>P.174</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AF ILLUMINATOR</td>
<td>OFF, ON</td>
<td></td>
<td>P.78</td>
</tr>
<tr>
<td></td>
<td></td>
<td>USB</td>
<td>PC, PRINT</td>
<td></td>
<td>P.175</td>
</tr>
</tbody>
</table>
List of factory default settings

The menu functions are set to the following default settings at the time of purchase.

### Shooting mode

<table>
<thead>
<tr>
<th>Function</th>
<th>Default Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNo.</td>
<td>F2.4</td>
</tr>
<tr>
<td>Program shift</td>
<td>RESET</td>
</tr>
<tr>
<td>SHUTTER</td>
<td>1/1000</td>
</tr>
<tr>
<td>Zoom</td>
<td>28mm</td>
</tr>
<tr>
<td>LCD/EVF</td>
<td>LCD</td>
</tr>
<tr>
<td>CARD</td>
<td>xD</td>
</tr>
<tr>
<td>Exposure</td>
<td>0.0</td>
</tr>
<tr>
<td>FLASH</td>
<td>AUTO (S, M, SLOW, : SLOW1)</td>
</tr>
<tr>
<td>SLAVE</td>
<td>1</td>
</tr>
<tr>
<td>SLOW</td>
<td>SLOW1</td>
</tr>
<tr>
<td>AF/MF</td>
<td>AF</td>
</tr>
<tr>
<td>AF target mark</td>
<td>Center</td>
</tr>
<tr>
<td>AF MODE</td>
<td>iESP</td>
</tr>
<tr>
<td>FULLTIME AF</td>
<td>OFF</td>
</tr>
<tr>
<td>P-AF</td>
<td>ON</td>
</tr>
<tr>
<td>ESP/ESP</td>
<td>ESP</td>
</tr>
<tr>
<td>Metering target</td>
<td>Center</td>
</tr>
<tr>
<td>BKT</td>
<td>±1.0, 3 pictures</td>
</tr>
<tr>
<td>ISO</td>
<td>AUTO (A, S, M: 50)</td>
</tr>
<tr>
<td>DIGITAL ZOOM</td>
<td>OFF</td>
</tr>
<tr>
<td>NOISE REDUCTION</td>
<td>OFF</td>
</tr>
<tr>
<td>FUNCTION</td>
<td>OFF</td>
</tr>
<tr>
<td>FRAME ASSIST</td>
<td>OFF</td>
</tr>
<tr>
<td>(still picture)</td>
<td>OFF</td>
</tr>
<tr>
<td>(movie)</td>
<td>ON</td>
</tr>
<tr>
<td>HISTOGRAM</td>
<td>OFF</td>
</tr>
<tr>
<td>Histogram target mark</td>
<td>Center</td>
</tr>
<tr>
<td>MY MODE</td>
<td>MY MODE 1</td>
</tr>
<tr>
<td>WB</td>
<td>AUTO</td>
</tr>
<tr>
<td>WB</td>
<td>None</td>
</tr>
<tr>
<td>CUSTOM WB</td>
<td>Not Registered</td>
</tr>
<tr>
<td>JPEG</td>
<td>OFF</td>
</tr>
<tr>
<td>TIFF</td>
<td>3264 × 2448</td>
</tr>
<tr>
<td>SHQ</td>
<td>3264 × 2448</td>
</tr>
<tr>
<td>HQ</td>
<td>3264 × 2448</td>
</tr>
<tr>
<td>SQ1</td>
<td>2048 × 1536 NORMAL</td>
</tr>
<tr>
<td>SQ2</td>
<td>640 × 480 NORMAL</td>
</tr>
<tr>
<td>SCENE MODES</td>
<td>NORMAL</td>
</tr>
<tr>
<td>SHARPNESS</td>
<td>±0</td>
</tr>
<tr>
<td>CONTRAST</td>
<td>±0</td>
</tr>
<tr>
<td>HUE</td>
<td>±0</td>
</tr>
<tr>
<td>SATURATION</td>
<td>±0</td>
</tr>
</tbody>
</table>

### Playback mode

<table>
<thead>
<tr>
<th>Function</th>
<th>Default Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFO</td>
<td>OFF</td>
</tr>
<tr>
<td>Copy</td>
<td>OFF</td>
</tr>
<tr>
<td>Rotation</td>
<td>0°</td>
</tr>
<tr>
<td>Angle</td>
<td>OFF</td>
</tr>
<tr>
<td>COPY</td>
<td>ALL</td>
</tr>
<tr>
<td>INFO</td>
<td>OFF</td>
</tr>
<tr>
<td>Copy</td>
<td>OFF</td>
</tr>
</tbody>
</table>
List of factory default settings

<table>
<thead>
<tr>
<th>SET UP</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL RESET</td>
<td>ON</td>
</tr>
<tr>
<td>REC VIEW</td>
<td>ON</td>
</tr>
<tr>
<td>BEEP</td>
<td>1-LOW</td>
</tr>
<tr>
<td>SHUTTER SOUND</td>
<td>1-LOW</td>
</tr>
<tr>
<td>DIAL</td>
<td>NORMAL</td>
</tr>
<tr>
<td>EV STEP</td>
<td>1/3EV</td>
</tr>
<tr>
<td>CUSTOM BUTTON</td>
<td>ISO</td>
</tr>
<tr>
<td>SHORT CUT</td>
<td>A: T, B: ISO C: DIGITAL ZOOM</td>
</tr>
<tr>
<td>CONTROL PANEL</td>
<td>OFF</td>
</tr>
<tr>
<td>VOLUME</td>
<td>3</td>
</tr>
<tr>
<td>BEEP</td>
<td>ENGLISH</td>
</tr>
<tr>
<td>REC VIEW</td>
<td>Y-M-D 2004/01/01 00:00</td>
</tr>
<tr>
<td>BEEP</td>
<td>LOW</td>
</tr>
<tr>
<td>SLEEP</td>
<td>3 MIN</td>
</tr>
<tr>
<td>FILE NAME</td>
<td>AUTO</td>
</tr>
<tr>
<td>BATTERY SAVE</td>
<td>OFF</td>
</tr>
<tr>
<td>BEEP</td>
<td>NORMAL</td>
</tr>
<tr>
<td>VIDEO OUT</td>
<td>NTSC or PAL*</td>
</tr>
<tr>
<td>AF ILLUMINATOR</td>
<td>ON</td>
</tr>
<tr>
<td>USB</td>
<td>PC</td>
</tr>
</tbody>
</table>

* Setting differ according to the region where the camera is sold.
List of items by shooting mode

In ** mode, available functions vary depending on the modes set in the MY MODE SETUP menu.

<table>
<thead>
<tr>
<th>Function</th>
<th>P</th>
<th>A</th>
<th>S</th>
<th>M</th>
<th>📷</th>
<th>🎥</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DIGITAL ZOOM</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AF MODE</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FULLTIME AF</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P-AF</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AF target mark</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manual focus</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flash</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AUTO</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>🎥</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🙁</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SLOW1</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🎥 وسلم</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SLOW2</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🎥</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🎥</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🎥</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MULTI</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Metering target</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AE LOCK</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>🎥</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🎥</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🎥</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🎥</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🎥</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🎥</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HI 🎥 ☺ ☻ AF</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BKT</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>FUNCTION</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PANORAMA</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BLACK &amp; WHITE</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SEPIA</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FRAME ASSIST</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🎥</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Histogram target mark</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🎥 (still picture)</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🎥 (movie)</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>✈️</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1 Only for MOVIE mode.
List of items by shooting mode

<table>
<thead>
<tr>
<th>Function</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>P</td>
</tr>
<tr>
<td>ISO</td>
<td>✓</td>
</tr>
<tr>
<td>[F]</td>
<td>✓</td>
</tr>
<tr>
<td>WB</td>
<td>✓</td>
</tr>
<tr>
<td>[WB?]</td>
<td>✓</td>
</tr>
<tr>
<td>CUSTOM WB</td>
<td>✓</td>
</tr>
<tr>
<td>SHARPNESS</td>
<td>✓</td>
</tr>
<tr>
<td>CONTRAST</td>
<td>✓</td>
</tr>
<tr>
<td>HUE</td>
<td>✓</td>
</tr>
<tr>
<td>SATURATION</td>
<td>✓</td>
</tr>
<tr>
<td>SCENE MODES</td>
<td>✓</td>
</tr>
<tr>
<td>NOISE REDUCTION</td>
<td>✓</td>
</tr>
<tr>
<td>ALL RESET</td>
<td>✓ 2</td>
</tr>
<tr>
<td>REC VIEW</td>
<td>✓</td>
</tr>
<tr>
<td>BEEP</td>
<td>✓</td>
</tr>
<tr>
<td>SHUTTER SOUND</td>
<td>✓</td>
</tr>
<tr>
<td>DIAL</td>
<td>✓</td>
</tr>
<tr>
<td>EV STEP</td>
<td>✓</td>
</tr>
<tr>
<td>CUSTOM BUTTON</td>
<td>✓</td>
</tr>
<tr>
<td>SHORT CUT</td>
<td>✓</td>
</tr>
<tr>
<td>MY MODE</td>
<td>✓</td>
</tr>
<tr>
<td>CONTROL PANEL</td>
<td>✓</td>
</tr>
</tbody>
</table>

✓: Available  —: Not available

*1 Cannot be selected in [h] mode
*2 Cannot be selected in [i] mode
Camera maintenance

● After use
Turn off the camera, detach the lens hood, and then fit the lens cap on the lens. If you do not intend to use the camera for a long period, remove the battery.

● Cleaning the camera
1 Turn off the camera. (P.25)
2 Remove the battery (P.18). (If you are using an AC adapter, unplug the AC adapter from the camera first before removing the plug from the AC outlet.)
3 Exterior:
   → Wipe gently with a soft cloth. If the camera is very dirty, soak the cloth in mild soapy water and wring well. Wipe the camera with the damp cloth and then dry it with a dry cloth. If you have used the camera at the beach, use a cloth soaked in clean water and well wrung.
   Monitor and viewfinder:
   → Wipe gently with a soft cloth.
   Lens
   → Blow dust off the lens with a commercially available blower, then wipe gently with a lens cleaner.
   Card
   → Wipe gently with a soft, dry cloth.

● Storage
• When storing the camera for extended periods, remove the battery and the card, and keep in a cool, dry place that is ventilated well.
• Periodically, replace the battery, and test camera functions.

![Note]
• Do not use strong solvents such as benzene or alcohol, or chemically treated cloth.
• Cleaning should be done only after the battery has been removed or the AC adapter has been disconnected.
• Mold may form on the lens surface if the lens is left dirty.
• Avoid leaving the camera in places where chemical products are handled since this may result in corrosion.
How to replace the battery (CR2025) of the remote control device

1 Turn the screw on the bottom of the remote control device counterclockwise to loosen.

2 Turn the remote control device over, and remove the cover. Remove the old battery and insert a new battery (CR2025) with the battery facing up as shown.

3 Replace the cover, turn the remote control device over, and turn the screw on the bottom clockwise to tighten.

- Do not apply excessive force to the remote control device.
- Never heat the remote control device or dispose of it in fire.
- The working temperature range for the remote control device is –10°C to 40°C (14°F to 104°F).
# Specifications

<table>
<thead>
<tr>
<th>Product type</th>
<th>Digital camera (for shooting and displaying)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recording system</td>
<td></td>
</tr>
<tr>
<td>Still picture</td>
<td>Digital recording, TIFF (non-compression), JPEG (in accordance with Design rule for Camera File system (DCF)), RAW Data</td>
</tr>
<tr>
<td>Applicable standards</td>
<td>Exif 2.2, Digital Print Order Format (DPOF), PRINT Image Matching II, PictBridge</td>
</tr>
<tr>
<td>Sound with still pictures</td>
<td></td>
</tr>
<tr>
<td>Movie</td>
<td>QuickTime Motion JPEG support</td>
</tr>
<tr>
<td>Memory</td>
<td>xD-Picture Card (16-512MB), CompactFlash, Microdrive*</td>
</tr>
<tr>
<td></td>
<td>*340 MB Microdrive cannot be used.</td>
</tr>
<tr>
<td>Recording image</td>
<td>3264 × 2448 pixels (RAW, TIFF, SHQ, HQ)</td>
</tr>
<tr>
<td>resolution</td>
<td>3264 × 2176 pixels (3:2, TIFF, SHQ, HQ)</td>
</tr>
<tr>
<td></td>
<td>2592 × 1944 pixels (TIFF, SQ1)</td>
</tr>
<tr>
<td></td>
<td>2288 × 1712 pixels (TIFF, SQ1)</td>
</tr>
<tr>
<td></td>
<td>2048 × 1536 pixels (TIFF, SQ1)</td>
</tr>
<tr>
<td></td>
<td>1600 × 1200 pixels (TIFF, SQ2)</td>
</tr>
<tr>
<td></td>
<td>1280 × 960 pixels (TIFF, SQ2)</td>
</tr>
<tr>
<td></td>
<td>1024 × 768 pixels (TIFF, SQ2)</td>
</tr>
<tr>
<td></td>
<td>640 × 480 pixels (TIFF, SQ2)</td>
</tr>
<tr>
<td>No. of storable pictures</td>
<td></td>
</tr>
<tr>
<td>When a 32 MB card is used (without sound)</td>
<td>Approx. 2 frames (RAW : 3264 × 2448)</td>
</tr>
<tr>
<td></td>
<td>Approx. 1 frame (TIFF : 3264 × 2448)</td>
</tr>
<tr>
<td></td>
<td>Approx. 8 frames (SHQ : 3264 × 2448)</td>
</tr>
<tr>
<td></td>
<td>Approx. 16 frames (HQ : 3264 × 2448)</td>
</tr>
<tr>
<td></td>
<td>Approx. 40 frames (SQ1 : 2048 × 1536 NORMAL)</td>
</tr>
<tr>
<td></td>
<td>Approx. 331 frames (SQ2 : 640 × 480 NORMAL)</td>
</tr>
<tr>
<td>No. of effective pixels</td>
<td>8,000,000 pixels</td>
</tr>
<tr>
<td>Image pickup device</td>
<td>2/3&quot; CCD solid-state image pickup, 8,310,000 pixels</td>
</tr>
<tr>
<td>Lens</td>
<td>Olympus lens 7.1 mm to 35.6 mm, f2.4 to f3.5, 14 elements in 5 groups (equivalent to 28 mm to 140 mm lens on 35 mm camera)</td>
</tr>
<tr>
<td>Photometric system</td>
<td>Digital ESP metering, spot metering system, center-weighted metering system</td>
</tr>
<tr>
<td>Aperture</td>
<td>f2.4 to f8.0</td>
</tr>
<tr>
<td>Shutter speed</td>
<td>16 to 1/4000 sec. (bulb mode: max. 8 min.)</td>
</tr>
<tr>
<td>Shooting range</td>
<td>0.8 m (2.6 ft.) to ∞ (normal)</td>
</tr>
<tr>
<td></td>
<td>0.2 m to 0.8 m (0.7 ft to 2.6 ft.) (macro mode)</td>
</tr>
<tr>
<td>Viewfinder</td>
<td>0.44&quot; TFT color LCD display, 240,000 pixels</td>
</tr>
<tr>
<td>Monitor</td>
<td>1.8&quot; TFT color LCD display, 134,000 pixels</td>
</tr>
</tbody>
</table>
### Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autofocus</td>
<td>Dual autofocus</td>
</tr>
<tr>
<td></td>
<td>Contrast detection system, Phase-difference detection system</td>
</tr>
<tr>
<td>Outer connector</td>
<td>DC-IN jack, USB connector (mini-B), A/V OUT jack</td>
</tr>
<tr>
<td>Automatic calendar system</td>
<td>2000 up to 2099</td>
</tr>
<tr>
<td>Operating environment</td>
<td></td>
</tr>
<tr>
<td>Temperature</td>
<td>0°C to 40°C (32°F to 104°F) (operation)</td>
</tr>
<tr>
<td></td>
<td>–20°C to 60°C (–4°F to 140°F) (storage)</td>
</tr>
<tr>
<td>Humidity</td>
<td>30% to 90% (operation)/10% to 90% (storage)</td>
</tr>
<tr>
<td>Power supply</td>
<td>Only an Olympus BLM-1 lithium-ion battery</td>
</tr>
<tr>
<td></td>
<td>AC adapter specified by Olympus (optional)</td>
</tr>
<tr>
<td>Dimensions</td>
<td>124 mm (W) × 84.5 mm (H) × 99 mm (D)</td>
</tr>
<tr>
<td></td>
<td>(4.9&quot; × 3.3&quot; × 3.9&quot;) (excluding protrusions)</td>
</tr>
<tr>
<td>Weight</td>
<td>Approx. 510 g (1.1 lb.) (without battery and card)</td>
</tr>
</tbody>
</table>

SPECIFICATIONS ARE SUBJECT TO CHANGE WITHOUT ANY NOTICE OR OBLIGATION ON THE PART OF THE MANUFACTURER.

**Lens filter**

A lens filter can be fitted to the lens. For more information, please refer to our website.
Glossary of terms

A (Aperture Priority) Mode
You set the aperture yourself and the camera automatically varies the shutter speed so that the picture is taken with the best exposure.

AE (Automatic Exposure)
The camera's built-in exposure meter automatically sets the exposure. The 3 AE modes available on this camera are P mode, in which the camera selects both the aperture and shutter speed, A mode, in which the user selects the aperture and the camera sets the shutter speed, and S mode, in which the user selects the shutter speed and the camera sets the aperture. In M mode, the user selects both the aperture and the shutter speed.

Aperture
The adjustable lens opening which controls the amount of light that enters the camera. The larger the aperture, the shorter the depth of field and the fuzzier the background. The smaller the aperture, the greater the depth of field and the sharper the background. Larger aperture values indicate smaller apertures, and smaller aperture values indicate larger apertures.

Backlight
A light source to illuminate the monitor from behind the screen.

CCD (Charge-Coupled Device)
This converts light passing through the lens into electrical signals. On this camera, light is picked up and converted into RGB signals to build a single image.

Contrast Detection System
This is used to measure the distance to the subject. The camera determines if the image is focused by the level of contrast in the subject.

Conventional Photograph
This refers to recording images using silver halide (the method for recording images in conventional, non-digital photography). This system is in contrast to still video and digital photography.

DCF (Design rule for Camera File system)
A standard for image files by the Japan Electronics and Information Technology Industries Association (JEITA).

Depth of field
The subject itself as well as some area to the front and rear of the subject are focused. The entire depth of this focused area, from the front to the rear of the subject, is called “depth of field”.

Digital ESP (Electro-Selective Pattern) Light Metering
This determines the exposure by metering and calculating the light levels in the center and other areas of the image separately.

DPOF (Digital Print Order Format)
This is for saving desired print settings on digital cameras. By entering which images to print and the number of copies of each, the user can easily have the desired images printed by a printer or print lab that supports the DPOF format.

Dual Auto Focus
An auto focus system that uses two different focus detection systems in combination. This camera uses the CCD’s contrast detection system in combination with the specified sensor's phase difference detection system, nullifying the shortcoming of each system.
Eclipsing (Vignetting)
This refers to when an object obscures part of the field of view so that the whole subject is not photographed. Vignetting also refers to when the image seen through the viewfinder does not exactly match the image shot through the objective lens, so the photographed image includes objects not seen through the viewfinder. In addition, vignetting can occur when an incorrect lens hood is used, causing shadowing to appear in the corners of the image.

EV (Exposure Value)
A system for measuring exposure. EV0 is when the aperture is at F1 and the shutter speed is 1 second. The EV then increases by 1 each time the aperture increases by one F stop or the shutter speed increases by one increment. EV can also be indicated by brightness and ISO settings.

Exposure
The amount of light used to capture an image. The exposure is determined by the time the shutter is open (shutter speed) and the amount of light that passes through the lens (aperture).

Flash Bracket
A mount used to attach an external flash to the camera. Shadows on the subject can be changed by detaching the flash. The flash is used in combination with the flash cable.

ISO
A method for indicating film speed by the International Organization for Standardization (ISO) (e.g. "ISO100"). Higher ISO values indicate greater sensitivity to light, so images can be exposed even in low-light conditions.

JPEG (Joint Photographic Experts Group)
A compression format for still images. Photographs (images) shot using this camera are recorded onto the card in JPEG format when the record mode is set to SHQ, HQ, SQ1 or SQ2. By downloading these images to a personal computer, users can edit them using graphics application software or view the images using an Internet web browser.

M (Manual) Mode
The user sets both the aperture and shutter speed.

NTSC (National Television Systems Committee) / PAL (Phase Alternating Line)
Television formats. NTSC is mainly used in Japan, North America and Korea. PAL is mainly used in Europe and China.

P (Program) Mode
Also called Program AE mode. The camera automatically sets the best shutter speed and aperture for the shot.

Phase-difference Detection System
This system measures the distance to the subject. The distance is calculated by the difference in the image of the subject captured by a pair of sensors.

Pixels
A pixel is the smallest unit (dot) used to make up an image. Clear large-sized printed images require millions of pixels.
Resolution
The size of an image expressed by the number of pixels that make up the image. For instance, a picture taken in 640 × 480 resolution is the same size as the screen when the monitor setting is 640 × 480. However, if the monitor setting is 1024 × 768, the picture only takes up part of the screen.

S (Shutter Priority) Mode
Also called Shutter Priority AE mode. The user selects the shutter speed and the camera automatically varies the aperture so that the picture is taken with the best exposure.

Slave Flash
A wireless flash that is not connected to the camera by a synchronization cord. It flashes in phase with the flash on the camera and can be used for lighting techniques, such as changing the way shadows are cast on a subject.

Sleep Mode
A mode designed to save battery life. The camera automatically enters the sleep mode if you do not operate it for a certain time. To get out of the sleep mode, use any button on the camera (shutter button, arrow pad, etc.).

Synchro Terminals
Terminals on an external flash unit for connecting it to the camera.

TIFF (Tagged Image File Format)
A format used for saving highly detailed black and white or color image data. TIFF image files can be handled by software programs for scanners and graphics applications. This camera uses an uncompressed format.

TFT (Thin-Film Transistor) Color Monitor
A transistor color monitor constructed using thin-film technology.

TTL (Through-The-Lens) System
To help adjust exposure, a light receptor built into the camera directly measures the light passing through the lens.

TTL-AUTO
For use with an external flash. Light emitted by the flash is reflected by the subject and measured by the light receptor in the camera as it passes through the lens. This is used to adjust the external flash intensity.
Index

1st curtain SLOW1 ............ 61
1st curtain with red-eye reduction
  SLOW1 .................. 62
2nd curtain SLOW2 ........... 62
3:2 .......................... 103

A
A/V OUT jack .................. 9, 134
AC adapter .................... 19
AE................................ 223
AE lock AEL .................. 85
AE memory MEMO ............... 86
AEL button AEL ........... 9, 72, 83, 85
AF .......................... 74, 75, 76, 77, 78
AF illuminator ................. 9, 78
AF ILLUMINATOR ............ 78
AF MODE ..................... 74
AF sensor ..................... 9, 76
AF sequential shooting AF d 92
AF target mark ................. 50, 77
AF/Macro/MF button AF MF 10, 79, 87, 88
ALL RESET .................... 145
All-frame erase ................ 144
All-frame reservation 148 ....... 178
Aperture priority shooting A 47, 70
Aperture value ................ 70
Arrow pad ...................... 9, 37, 121
Auto bracketing BKT .......... 93
Auto focus AF .................... 34
Auto white balance .......... 109
Auto-flash ...................... 60
AV cable ....................... 134

B
Battery ......................... 18
Battery check .................. 14
Battery compartment cover . 10, 18
Battery compartment lock . 10, 18
BATTERY SAVE ............... 171
Beep sound ........................ 169
BLACK & WHITE ............... 98
Bulb shots ..................... 72

C
Camera movement warning ........ 50
CAPTURE ..................... 129
Card ......................... 21
Card access lamp ............. 9, 50
Card button CF xD .......... 9, 23
Card cover .................... 9, 22
CARD SETUP .................. 166
CCD .......................... 223
Center-weighted metering [ ] ... 81
CF ................................ 21, 23
Charger ....................... 17
Close-up playback Q .......... 124
Cloudy day C .................. 110
Color temperature ............. 110
Compact Flash ................ 21
Compression .................. 102
Connector cover .............. 9, 134, 187
CONTRAST : .................. 115
Contrast Detection System 76, 223
Control dial .................... 9, 31, 33, 121, 150
CONTROL PANEL ............. 163
COPY ......................... 141
Creating an index ............. 131
Custom button ........................ 10, 154
CUSTOM BUTTON ............ 154
Custom white balance .......... 111

D
Date and time % .................. 168
DCF ............................ 223
DC-IN jack ...................... 9, 19
DIAL .......................... 150
Digital ESP Metering .......... 81, 223
DIGITAL ZOOM ............... 58
Diopeter adjustment ring .... 10, 27
DIRECT ......................... 119
Direct buttons .................. 31
Direct printing .................. 186
DPOF .................. 176, 223

E
Editing a movie .................. 132
Erase button .......................... 9, 143
Error codes .................. 200
EV .................................. 224
EV STEP .......................... 153
Evening sunlight .................. 110
Exposure .................. 224
Exposure compensation .................. 108
Exposure compensation button .......................... 10, 108
Exposure differential .................. 72
Exposure Steps .................. 153
External flash .................. 67

F
File name .................. 170
FILE NAME .................. 170
File No. .................. 170
Fill-in flash .......................... 61
Flash .................. 9, 59
FLASH .................................. 66
Flash charging .................. 60
Flash intensity control .................. 64
Flash intensity control button .......................... 34
Flash mode .................. 59
Flash mode button .......................... 10, 59
Flash off .......................... 61
Flash pop-up button .......................... 10, 59
Flash stand-by .................. 50
Fluorescent lamp .......................... 110
Focus .................. 50, 53, 74
Focus Lock .................. 53
FOCUS MODE .................. 79, 87, 88
FORMAT .................................. 166
FRAME ASSIST display .................. 99
FRAME ASSIST shooting .......................... 97, 136

FULLTIME AF .................. 75
Fully .................. 50
FUNCTION .................. 95, 97, 98

G
Green lamp .................. 50

H
Halfway .................. 50
HIGH .................. 102
High speed sequential shooting

HI .................................. 92
Histogram display .......................... 119
Histogram target mark .................. 120
Hot shoe .................. 10, 65
HQ .................. 104, 105
HUE .......................... 116

I
iESP .................. 74
Index display .......................... 125, 126
Information display INFO .................. 135
Information display button INFO .......................... 10, 135
ISO sensitivity .................. 107, 224

J
JPEG .................. 104, 224
JPEG DUPLICATE SETTING .................. 106

L
Landscape shooting .......................... 49
Language .......................... 167
Lens .................. 9
Lens cap .................. 16, 25
Lens cap string .................. 16
Lens hood .................. 27
Lithium ion battery .................. 18

M
Macro mode shooting .......................... 87
Manual focus **MF** .......... 79
Manual shooting **M** .......... 48, 72
Measurement Unit
  m/ft (meters/feet) .......... 173
Memory gauge .......... 14
Metering .......... 81
Metering button **[** .......... 10, 81, 82
Metering mode .......... 81
Metering target mark .......... 82
Microdrive .......... 21
Microphone .......... 9, 100, 137
Mode dial .......... 10, 46
MODE MENU .......... 42
Monitor .......... 9, 11, 50, 121, 173
Monitor brightness
  adjustment .......... 173
Monitor button **[** .......... 9, 50
MOVIE PLAY .......... 128
MOVIE PLAYBACK .......... 128
Movie record **[** .......... 48, 55
Multi-metering **[** **[** .......... 83
My Mode **[** .......... 48, 73
MY MODE .......... 73
MY MODE SETUP **[** .......... 160

**N**
Night Scene shooting **[** .......... 49
NOISE REDUCTION **NR** .......... 118
NTSC .......... 174, 224
Number of storable still pictures .......... 104

**O**
OK/Menu button **[** .......... 9, 37
One-touch white balance **[** .......... 111
Operation sound **BEEP** .......... 148
Optical zoom .......... 57

**P**
P-AF .......... 76
PAL .......... 174, 224
PANORAMA .......... 95
PC .......... 175
Phase difference detection system .......... 76, 224
PictBridge .......... 186
Picture rotation **[** .......... 123
PIXEL MAPPING .......... 172
Pixels .......... 224
Playback mode .......... 13, 41, 44, 121
Playback on a TV .......... 134
Portrait shooting **[** .......... 49
Power battery holder .......... 19
Power on/off .......... 25
Power switch .......... 10, 25
Preset white balance .......... 110
PRINT .......... 175
Print button **[** .......... 10, 178
Print setting .......... 176
Program shift **Ps** .......... 46
Program shooting **P** .......... 46
Protect .......... 142
Protect button **[** .......... 10, 142

**Q**
QUICK VIEW .......... 122
QUICK VIEW button .......... 9, 122

**R**
RAW .......... 103, 105, 106
RAW DATA EDIT .......... 140
REC VIEW .......... 147
REC. CANCEL .......... 51
Record mode **[** .......... 102
Record mode button **[** .......... 10, 105
Recording sound **[** .......... 100, 101, 137
Recording sound with
movies .......... 101
Recording sound with still
pictures .......... 100
Red-eye reduction flash **[** .......... 60
Remaining recording time .......... 55, 104
Remote control **[** .......... 90
Remote control receiver . . . . . . 9, 90
Resizing .......................... 138
Resolution ......................... 102, 225
Rotation button .................... 10, 123

S
SATURATION .......................... 117
SCENE MODES ........................ 117
Self-timer .......................... 89
Self-timer/Remote control button 9, 89, 90
Self-timer/Remote control lamp .... 9, 89, 90
SEPIA ................................. 98
Sequential shooting .................. 92
SET UP mode ......................... 44
Shade .................................. 110
SHARPNESS .......................... 114
Shoe cover .......................... 65
Shooting mode ......................... 11, 40, 42, 46
SHORT CUT .......................... 157
Shortcut Menus ......................... 40
SHQ .................................... 104, 105
Shutter button ......................... 9, 50, 55
Shutter priority shooting S 47, 71
SHUTTER SOUND ....................... 149
Shutter speed ........................ 71
Single-frame erase ..................... 143
Single-frame reservation .......... 180
Single-frame shooting ............. 92
SLAVE ................................. 69
Slave flash .......................... 69, 225
SLEEP ................................. 169
Sleep mode .......................... 169, 225
Slideshow ............................. 127
Slow synchronization SLOW .............. 61, 63
Speaker .............................. 10
Sports shooting ....................... 49
Spot (AF mode) ....................... 74
Spot metering ......................... 81
SQ .................................... 104, 105
Standard STANDARD ............... 186
Strap .................................. 16
Strap eyelet .......................... 10, 16
Sunny day ............................ 110
Super macro MF MF 88
Super macro shooting 88 ............. 88

T
Taking still pictures ................... 50
TIFF .................................. 104, 105, 225
Top menu ............................ 37
Trimming ............................. 139, 182, 197
Tripod socket ......................... 10
Tungsten light ......................... 110

U
USB .................................. 175
USB cable ............................. 187
USB connector ......................... 9, 187

V
VIDEO OUT .......................... 174
Viewfinder .......................... 9, 11, 27, 50, 173
VOLUME .................................. 165

W
White balance WB ...................... 109
White balance adjustment WB 112
White balance button WB 10, 109

X
xD-Picture Card ...................... 21, 23

Z
Zoom lever ............................ 10, 57, 124, 125
http://www.olympus.com/

OLYMPUS CORPORATION
Shinjuku Monolith, 3-1 Nishi-Shinjuku 2-chome, Shinjuku-ku, Tokyo, Japan

OLYMPUS AMERICA INC.
Two Corporate Center Drive, Melville, NY 11747-3157, U.S.A. Tel. 631-844-5000

Technical Support (USA)
24/7 online automated help: http://www.olympusamerica.com/support
Phone customer support: Tel. 1-888-553-4448 (Toll-free)
Our phone customer support is available from 8 am to 10 pm
(Monday to Friday) ET
E-Mail: distec@olympus.com
Olympus software updates can be obtained at: http://www.olympus.com/digital

Olympus Europa GmbH
Premises/Goods delivery: Wendenstrasse 14-18, 20097 Hamburg, Germany
Tel: +49 40-23 77 3-0 / Fax: +49 40-23 07 61
Letters: Postfach 10 49 08, 20034 Hamburg, Germany

European Technical Customer Support:
Please visit our homepage http://www.olympus-europa.com
or call our TOLL FREE NUMBER* : 00800 - 67 10 83 00
for Austria, Belgium, Denmark, Finland, France, Germany, Italy, Luxemburg, Netherlands,
Norway, Portugal, Spain, Sweden, Switzerland, United Kingdom
* Please note some (mobile) phone services/provider do not permit access or request an
additional prefix to +800 numbers.

For all not listed European Countries and in case that you can’t get connected
to the above mentioned number please make use of the following
CHARGED NUMBERS: +49 180 5 - 67 10 83 or +49 40 - 237 73 899
Our Technical Customer Support is available from 9 am to 6 pm MET (Monday to Friday)
Thank you for purchasing an Olympus digital camera.

This manual provides instructions on how to install the USB driver. To ensure correct installation, refer only to these installation procedures.

DIGITAL CAMERA — PC CONNECTION
OPERATION MANUAL

How to use your PC to get the most from images taken with your digital camera.
This manual explains in detail how to connect your Olympus digital camera to a computer. Read it carefully and keep it in a safe place for future reference.

About this manual

- The information contained in this manual may be subject to change without notice. For the latest information on the product, please consult your local Olympus representative.
- The information contained in this manual has been compiled by taking all possible measures to ensure its accuracy. However, if you find any errors or incomplete information, please contact your local Olympus representative.
- It is prohibited by copyright laws to duplicate in part or in whole the information contained in this manual, except for personal use. Reproduction without permission of the copyright owner is prohibited.
- The PC screens shown in this manual may differ slightly from the actual displays on some PC models.

Trademarks

- Microsoft and Windows are registered trademarks of Microsoft Corporation.
- Macintosh is a trademark of Apple Computer Inc.
- All other company and product names are registered trademarks and/or trademarks of their respective owners.
INDEX

Flowchart ........................................... 4

Identifying the OS ................................. 6

Windows (98/Me/2000/XP) ....................... 8

Macintosh (OS 9/X) ............................... 23

Downloading image files using other OS (For other OS users) ....................... 31
By connecting the camera to a computer with the provided USB cable, images on a card can be transferred to the computer. Some OS's (operating systems) may need a special setup before connecting to the camera for the first time. Follow the chart below.

For details, see the Olympus Corporate Site or phone customer support.

* Even if your computer has a USB connector, data transfer may not function correctly if you are using one of the operating systems listed below or if you have an add-on USB connector (extension card, etc.).

- Windows 95/NT 4.0
- Windows 98/98 SE upgrade from Windows 95
- Mac OS 8.6 or lower (except Mac OS 8.6 equipped with USB MASS Storage Support 1.3.5 installed at the factory)
- Data transfer is not guaranteed on a home-built PC system or PCs with no factory installed OS.
When connecting the camera to the computer, make sure that there is sufficient remaining battery power. When connected (transmitting) to the computer, the camera does not enter the sleep mode nor will the camera’s power turn off automatically. Depending on the camera model, when the battery power runs out or the internal temperature rises, the camera may stop operating automatically. This could cause the computer to malfunction, and any image data (file) being transmitted may be lost. Be careful when downloading files for a long period of time. Use the AC adapter (optional) when downloading files.

If you connect or disconnect the AC adapter when the camera is connected to the computer and is running on battery power, it may result in the loss of image data on the card or cause a malfunction in the computer. Before connecting or disconnecting the AC adapter, disconnect the camera from the computer and make sure that the camera is turned off.

To avoid computer malfunctions, do not turn off the camera when the camera is connected to a computer.

If the camera is connected to the computer via a USB hub, operation may not be stable if there are any compatibility problems between the computer and the hub. In such cases, do not use the hub and connect the camera directly to the computer.

You can view images using: graphics applications that support the JPEG file format (Paint Shop Pro, Photoshop, etc.); Internet browsers (Netscape Communicator, Microsoft Internet Explorer, etc.); CAMEDIA Master software; or other software. For details on using commercial graphics applications, refer to their instruction manuals.

QuickTime is needed for playing back movies. QuickTime is included on the provided software CD.

If you want to process images, make sure to download them to your computer first. Depending on the software, image files may be destroyed if the images are processed (rotated, etc.) while they are on the card.
Identifying the OS

Identify the OS on your computer before connecting the camera. How to identify the OS depends on the computer.

Windows

1. Double-click the “My Computer” icon on your desktop.

   When the “My computer” icon is not on your desktop, click “Control Panel” from the “Start” menu.

2. Double-click the “Control Panel” icon.

3. Double-click the “System” icon.

   The way the file icons inside the folder appear may vary depending on your version of Windows. If you don’t see the icon you are looking for, click on “view all Control Panel options” on the left of the window.
4 A System Properties window will appear. Note and record the “System:” information.
Confirm that your system is Windows 98, 98 SE, Me, 2000 Professional or Windows XP, then press “OK” to close the window.

If your OS is Windows 98/98 SE, proceed to “Installing the USB driver for Windows 98” (p.9).
Users running Windows Me/2000/XP p.11
Users running other OS p.31

● Mac OS (Macintosh)

Select “About This Computer” from the Apple menu on the menu bar.
A window appears with the name of the computer's OS.
Confirm that the OS is OS 9.0-9.2 or OS X.

Users running Mac OS 9/X p.23
Users running other OS p.31
Make sure that:

- Your computer is turned on and Windows is running.
- If you are running any applications, quit them all.
- You are recommended to power the camera using the optional AC adapter. If the battery power runs out while the computer is accessing the card in the camera, the camera will turn off in the middle of the operation and this could destroy image files (data). If you are using batteries, make sure that there is sufficient remaining battery power.

Installing the USB driver for Windows 98 (When using Windows 98/98 SE) ................................................................. 9
Connecting the camera to the computer .................................. 11
Confirming the computer recognizes the camera ............... 14
Confirming the USB driver is installed ................................. 15
Downloading images to your computer ............................. 17
Disconnecting the camera from your computer ............... 20
Installing the USB driver for Windows 98
(When using Windows 98/98 SE)

If your OS is Windows 98/98 SE, you must install the USB driver. Follow the instructions below to install the USB driver in your computer. Once it is fully installed, you do not need to repeat the procedure again.

If your OS is Windows Me/2000/XP, you do not need to install the USB driver. Proceed to “Connecting the camera to the computer” (p.11).

1. Insert the provided software CD into your CD-ROM drive.

2. The Olympus Windows Installer should automatically launch. Click “USB Driver”.
   If the USB driver is already installed in your computer, this option will not appear.
   • This option will not appear if you are using Windows Me/2000/XP.

   If the installer is not automatically launched, select “Run..” on the “Start” menu and then execute “(drive letter):/ Information.exe”.

   The drive letter of the CD-ROM varies depending on the computer.
   To identify the drive letter, double-click “My Computer” on the desktop.
3 Click “Continue”. The installation of the USB driver will start.

4 Click “OK” to restart your computer and the installation is complete.

5 When the computer has restarted, installation is complete. If the Olympus Windows Installer screen appears, click “Close” and remove the CD-ROM from the CD-ROM drive.
Connecting the camera to the computer

Users running Windows 98/98SE need to install the USB drive before connecting the camera to your computer for the first time. ([p.9])

1. Some camera models have a “USB” setting in the menu. Make sure that “PC” is selected before connecting. This is not required if your camera does not have this setting. For details on how to operate the menu, refer to your camera’s reference manual.

2. Insert the marked end of the provided USB cable into the USB port on your computer as shown below.

   ![USB cable insertion](image)

   The location of the USB port varies depending on the computer. For details, refer to your computer’s manual.

3. After making sure that the camera is turned off, connect the end of the USB cable to the USB connector on the camera.

   ![USB connection](image)

   The location of the USB connector or multi connector varies depending on the camera model. Refer to the camera manual for details.
4 Turn the camera on in (playback) mode.
   • Most cameras with a lens barrier turn on automatically in Step 3, with the exception of some models which require you to press the (monitor) button or button.

5 When the screen shown right appears on the monitor in Step 4, use the arrow pad to select “PC” and press the OK button.

6 The computer recognizes the camera as a new device.
   • Depending on the camera model, when you connect the camera to the computer, the lamp on the right of the viewfinder or the self-timer lamp may light.

When you connect the camera to the computer for the first time, the computer automatically recognizes the camera. Click “OK” when the message saying that the installation is completed appears. The computer recognizes the camera as a “Removable Disk”.

Windows
● **Windows XP**

You can download image files from the camera easily. Select “Copy pictures to folder on my computer using Microsoft Scanner and Camera Wizard”, then follow the on-screen instructions. You may also select “take no action” to bypass the Microsoft Scanner and Camera Wizard. You may then use a more advanced image viewing/editing program such as Olympus CAMEDIA Master software. For detailed instructions on downloading, refer to the CAMEDIA Master software user’s guide.

---

**Caution**

When the camera is connected to the computer, none of the camera buttons are functional.
Confirming the computer recognizes the camera

1. Double-click the “My Computer” icon on the desktop.
   For users running Windows XP, click “My Computer” from the “Start” menu.

2. Make sure the “Removable Disk” icon appears in the window.
   There may already be other “Removable Disk” icons for other devices, such as a removable media drive or USB SmartMedia Reader/Writer. In this case, the digital camera is recognized as another “Removable Disk”.
   If you cannot find the icon, the camera and computer are not connected properly. Turn the camera off, disconnect the camera from the computer and connect again, or proceed to “Confirming the USB driver is installed” (p.15) to make sure that the USB driver is fully installed.
Confirming the USB driver is installed

If the computer does not recognize the camera as a Removable Disk, follow the procedure below to check whether the USB driver has been fully installed.

1. Open “My Computer” and double-click the “Control Panel” icon. For users running Windows XP, open “Control Panel” from the “Start” menu.

2. Double-click the “System” icon.

3. The System window will appear. Click the “Device Manager” tab.
Confirming the USB driver is installed

4 Confirm that “OLYMPUS Digital Camera” is in the “Universal Serial Bus Controller” category.

If you cannot find the “OLYMPUS Digital Camera”, turn the camera off, disconnect the camera from the computer and start again.

Users running Windows 98/98 SE start again from “Confirming the USB driver is installed”, and Users running Windows Me/2000/XP start from “Connecting the camera to the computer”.

If the USB driver was successfully installed, you can find the following in the “Device Manager”.

– the name of the camera you have connected listed under “Disk drives”
– “OLYMPUS Digital Camera” listed as one of the items in the “Universal Serial Bus Controller” category
1. Double-click the “My Computer” icon on the desktop.
   For users running Windows XP, click “Control Panel” from the “Start” menu.

2. Double-click the “Removable Disk” icon.
   A new “Removable Disk” icon appears when the camera is connected to the computer, as the digital camera is recognized as a “Removable Disk”.

   If an error message appears when you double-click the icon, there may be a problem with one of the following:
   1. the camera’s power source (the AC adapter is not properly connected or the battery power is low)
      Make sure that the AC adapter is correctly connected or that the batteries are not running low.
   2. the card (there is no card in the camera or there is a problem with the card)
      Check that you can play back pictures stored on the card on the monitor of your digital camera.

3. Double-click the “Dcim” folder.
4 Double-click the “100olymp” folder.  
Image files (JPEG files) with file names such as “P1010001.jpg” are displayed.

- The camera automatically assigns folder names and file names according to the following rules.

<table>
<thead>
<tr>
<th>Folder name</th>
<th>File name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Example)</td>
<td>(Example)</td>
</tr>
<tr>
<td>100olymp</td>
<td>P1010001.jpg</td>
</tr>
<tr>
<td>Serial number</td>
<td>Month / Day / Serial number</td>
</tr>
</tbody>
</table>

- Serial numbers of image files run from 0001 to 9999.
- Serial numbers of folders run from 100 to 999.
- When file number 9999 is reached, a new folder is created and assigned the next number.
- Months January through September are expressed by the numbers 1 through 9, October by the letter A, November by B and December by C.

5 Double-click the “My Documents” icon on the desktop.
If you cannot find the icon on the desktop, select “Explorer” on the Start menu and double-click the “My Documents” icon.
The “My Documents” window is displayed.

6 Drag & drop the image you want to save in the computer (in this case, P1010012.jpg) to the “My Documents” window.

The image is saved in the computer (in My Documents folder).

• To select all files, choose Edit > Select all.

When the image file has been downloaded to the computer, you can view images by double-clicking the image files downloaded to your computer. The files will be opened in the default image viewer of the operating system. If you want to view the image a different size or process it, you will need to open the image with software that supports JPEG or TIFF images files, such as Paint Shop Pro, Photoshop or CAMEDIA Master software.

The lamp on the right of the viewfinder or the card access lamp blinks while the image is being copied. Never open the card cover on the camera, load or remove the batteries, or connect or disconnect the AC adapter while the lamp is blinking as the image files may be destroyed.
Disconnecting the camera from your computer

If your OS is Windows Me/2000, proceed to “Windows Me/2000/XP” (p.21).

● Windows 98

1. Make sure that the lamp on the right of the viewfinder or the self-timer lamp (which on some models light while the camera is connected to the computer) or the card access lamp is not blinking. The lamps and their location vary depending on the model. Refer to your camera’s reference manual.

2. Double-click the “My Computer” icon and right-click the “Removable Disk” to display the menu.

3. Click “Eject” on the menu.
4 Make sure that the lamp on the right of the viewfinder or the self-timer lamp (which on some models light while the camera is connected to the computer) or the card access lamp is not blinking.

Depending on the camera model, the green lamp may light or lamps that were lit while the camera was connected to the computer may go off. If the lamp is not flashing, then the cable can be removed.

5 Remove the USB cable from the camera.

6 Remove the USB cable from your computer.

● Windows Me/2000/XP

1 Make sure that the lamp on the right of the viewfinder or the self-timer lamp (which on some models light while the camera is connected to the computer) or the card access lamp is not blinking.

The lamps and their location vary depending on the model. Refer to your camera’s reference manual.
Disconnecting the camera from your computer

2 Click the “Unplug or Eject Hardware” icon on the task bar.
The message saying that the drive has been stopped appears.

3 Click on the message.
The “Unplug or Eject Hardware” window appears.

4 When a message appears, click “OK”.

5 Remove the USB cable from the camera.

6 Remove the USB cable from your computer.

Caution
If the window returns the following message when you click “Unplug or Eject Hardware”, first make sure that no image data is being downloaded from the camera, and then remove the USB cable.
Make sure that:

- Your computer is turned on and Mac OS is running.
- If you are running any applications, quit them all.
- You are recommended to power the camera using the optional AC adapter.

If the battery power runs out while the computer is accessing the card in the camera, the camera will turn off in the middle of the operation and this could destroy image files (data). If you are using batteries, make sure that there is sufficient remaining battery power.

If you are running Mac OS X, the connection to the computer and downloading the image data are verified. Restrictions such as the following may occur due to the OS.

- The image file properties are not displayed correctly.
- Images in the camera cannot be opened without first downloading them. etc.

For more details, visit the Olympus web site.

Connecting the camera to the computer ......................... 24
Downloading images to your computer........................... 26
Disconnecting the camera from your computer ................. 30
Connecting the camera to the computer

1. Some camera models have a “USB” setting in the menu. Make sure that “PC” is selected before connecting. This is not required if your camera does not have this setting. For details on how to operate the menu, refer to your camera’s reference manual.

2. Insert the marked end of the USB cable into the USB port on your computer as shown below.

3. After making sure that the camera is turned off, connect the end of the USB cable to the USB connector on the camera.

The location of the USB port varies depending on the computer. For details, refer to your computer’s manual.
4 Turn the camera on in (playback) mode.
   • Most cameras with a lens barrier turn on automatically in Step 3, with the exception of some models which require you to press the (monitor) button or button.

5 When the screen shown right appears on the monitor in Step 4, use the arrow pad to select “PC” and press the OK button.

6 The computer recognizes the camera as a new device.
   • Depending on the camera model, when you connect the camera to the computer, the lamp on the right of the viewfinder or the self-timer lamp may light.

The computer recognizes the camera automatically and an “Untitled” icon appears on the desktop. If you cannot find this icon, turn off the camera and connect again.

- Mac OS X
  When the computer has recognized the camera, the Apple Image Capture software automatically launches. p.29

Caution
When the camera is connected to the computer, none of the camera buttons are functional.
You can download images from the camera and save them in your computer (in this case, in the Hard Disk).

1. Double-click the “Untitled” icon displayed on the desktop when the camera is connected to the computer.

   If you cannot find this icon, or if an error message appears when you double-click the icon, there may be a problem with one of the following:
   ① the camera’s power source (the AC adapter is not properly connected or the battery power is low)
   ② the card (there is no card in the camera or there is a problem with the card)
      Check that you can play back pictures on the monitor of your camera.
   ③ the USB cable (the camera is not properly connected to the computer by the USB cable).
   ④ Apple “File Exchange” extension is not enabled.
      • Please refer to your Apple operating system manual for instructions on how to enable this extension.

2. Double-click the “Dcim” folder.

3. Double-click the “100OLYMP” folder.
Image files (JPEG files) with files names such as “P1010001.JPG” are displayed.

Note

• The camera automatically assigns folder names and file names according to the following rules.

<table>
<thead>
<tr>
<th>Folder name (Example)</th>
<th>File name (Example)</th>
</tr>
</thead>
<tbody>
<tr>
<td>100OLYMP</td>
<td>P1010001.jpg</td>
</tr>
<tr>
<td>Serial number</td>
<td>Month / Day / Serial number</td>
</tr>
</tbody>
</table>

• Serial numbers of image files run from 0001 to 9999.
• Serial numbers of folders run from 100 to 999.
• When file number 9999 is reached, a new folder is created and assigned the next number.
• Months January through September are expressed by the numbers 1 through 9, October by the letter A, November by B and December by C.

4 Double-click the “Macintosh HD” icon on the desktop.
The “Hard Disk” window is displayed.

5 Drag & drop the image you want to save in the computer (in this case, P1010012.JPG) to the “Hard Disk” window.

The image is saved in the computer (in the Hard disk).
- To select all images, click Edit > Select all.

When the image file has been copied to the computer, you can view images by double-clicking the image files in the “Hard Disk” folder. The files will be opened in the default image viewer of the operating system. If you want to view the image a different size or process it, you will need to open the image with software that supports JPEG or TIFF images files, such as Paint Shop Pro, Photoshop or CAMEDIA Master software.

The lamp on the right of the viewfinder or the card access lamp blinks while the image is being copied. Never open the card cover on the camera, load or remove the batteries, or connect or disconnect the AC adapter while the lamp is blinking as the image files may be destroyed.
Mac OS X

Malfunctions such as the following may occur due to the OS.

• If the camera is not connected correctly, a malfunction occurs in the computer.
• Date and time information of image files is not accurately displayed.
• If the card cover of the camera is opened while connecting to the computer, the “untitled” icon does not disappear from the desktop, etc.

When the computer has recognized the camera, the Apple Image Capture software dialog appears.

1 From the “Download To” menu, select a destination folder.

2 To download all images, click “Download All”.
   To selectively download images, click “Download Some” and highlight the desired images.
   The images are transferred from the camera to your computer.

Note
If you are operating Mac OS X and you want to download images using the same procedure as for Mac OS 9, select “File > Close” and exit the Apple Image Capture software. At this time, the camera is indicated as “unlabeled”.

Caution
If you use the Apple Image Capture software, images downloaded to your computer and transferred back to a card may not play back on the camera or may have other problems.
1 **Disconnecting the camera from your computer**

Make sure that the lamp on the right of the viewfinder or the self-timer lamp (which on some models light while the camera is connected to the computer) or the card access lamp is not blinking. The lamps and their location vary depending on the model. Refer to your camera’s reference manual.

2 Drag the “untitled” icon on the desktop to “Trash”.

3 Make sure that the lamp on the right of the viewfinder or the self-timer lamp (which on some models light while the camera is connected to the computer) or the card access lamp is not blinking.

Depending on the camera model, the green lamp may light or lamps that were lit while the camera was connected to the computer may go off. If the lamp is not flashing, then the cable can be removed.

4 Remove the USB cable from the camera.

5 Remove the USB cable from your computer.
Users running other OS cannot connect the camera directly to a computer.
- Windows 95
- Windows NT
- Mac OS before OS 9
For an OS listed above, you can download images directly to your computer using an optional floppy disk adapter or PC card adapter.
For details, see the Olympus Corporate Site or phone customer support.

Does your computer have a USB interface?
Is there a port marked on your computer?

No

Yes

Yes

Connect the camera directly to your computer using the provided USB cable.

Is your OS one of the following?
- Windows 98
- Windows 2000
- Windows Me
- Windows XP
- Mac OS 9/X

Yes

No

Use the optional USB reader/writer.*
*Certain card readers may not be compatible with Mac OS X. Check the Olympus website for the most up-to-date compatibility information.

Does your computer have a built-in PC card slot?

No

Yes

Use the optional PC card adapter*.  
*Not supported by Windows NT4.0 or lower

Consult your nearest Olympus representative.